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Chapitre

I
Présentation du

module

A. Intérêts/Contexte

Objectifs pédagogiques du module

Ce module explore les fonctionnalités d'un tableur permettant de produire une
présentation de données sous forme tabulée ou graphique en vue de son impression ou
de son intégration dans un document texte.

De par leurs immenses capacités, les tableurs font peur ! Ils sont très souvent délaissés
par les non-spécialistes qui préfèrent réaliser leurs calculs manuellement lorsque le
volume des données à traiter est suffisamment faible de peur d'être perdus dans la
complexité d'un tableur.

Ce module tente de remédier à cette situation en montrant que l'utilisation d'un tableur
est basée sur un petit nombre de notions et de techniques relativement simples et
faciles à maîtriser.



B. Plan

♦ Chapitre « Présentation du module »

♦ Chapitre « Introduction »

♦ Chapitre « Saisir les données d'un tableau : contenu et format »

♦ Chapitre « Ecrire des formules simples »

♦ Chapitre « Utiliser des fonctions dans les formules »

♦ Chapitre « Utiliser la recopie des formules et les références relatives et absolues »

♦ Chapitre « Bien présenter un tableau »

♦ Chapitre « Tri et filtres »

♦ Chapitre « Réaliser un graphique à partir d'un tableau »

♦ Chapitre « Imprimer une feuille de calcul (tableaux et graphiques) »

♦ Chapitre « Incorporer un tableau et un graphique dans un document composite »

♦ Chapitre « Exercice d'application »
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C. Résumé et présentation

Résumé et présentation des séquences

Les notions présentées dans le module ne sont pas traitées de façon exhaustive mais
constituent une base minimale pour produire des documents (classeurs) de qualité.
Toutefois, l'acquisition de ces notions de base devrait se révéler aussi suffisante pour
permettre une poursuite de l'étude des tableurs par la pratique ou en autoformation.
L'aide et les assistants de réalisation étant suffisamment complets et nombreux dans
les tableurs de dernière génération.

Les chapitres du module doivent être traités dans l'ordre, les pré-requis d'un chapitre
étant la plupart du temps ceux des chapitres précédents.

Au début de chaque chapitre, quelques questions de positionnement situent le thème et
le niveau du chapitre. En fonction de vos réponses, vous pourrez passer plus ou moins
de temps sur le chapitre concerné.
A la fin de chaque chapitre, vous pourrez évaluer votre progression à l'aide de
quelques questions et exercices à réaliser. A chaque fois, les réponses et corrigés vous
sont proposés, sous forme d'animations lorsque la difficulté de l'exercice le nécessite.
Les fichiers corrigés sont également disponibles en téléchargement.
De nombreux exemples d'applications sont présentés au cours des différents chapitres.
Ils sont très souvent suivis d'animations qui expliquent leur réalisation.

Pour avoir une vue d'ensemble de ce que vous devriez savoir à l'issue de ce module,
vous pouvez visualiser le dernier chapitre de synthèse.
Modalités d'évaluation du module

Des exercices d'application sont proposés à la fin de chaque chapitre et dans le
chapitre final. Les corrections sont données sous forme d'animations.

D. Temps prévu d'apprentissage

Si vous êtes débutant, prévoyez 30 min au maximum pour la lecture d'un chapitre puis
entre 30 min à 1 heure maximum pour la réalisation des exercices et de l'étude de cas.

Ces durées peuvent évidemment varier en fonction de votre niveau, et de votre
patience.
La durée totale indicative du module est de 10 heures.
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E. Pré-requis

Ce module suppose une bonne maîtrise des manipulations de bases. Le module B1 doit
donc être connu. La réalisation du module B4-Texte est aussi conseillée, voire
nécessaire pour les deux derniers chapitres du module.

Ce module suppose aussi qu'un tableur soit installé sur votre poste de travail. Vous
avez le choix entre Microsoft EXCEL, qui est le tableur le plus répandu, mais payant,
ou OpenOffice.org CALC, qui en est l'alternative gratuite Open Source.

Beaucoup de micro-ordinateurs sont achetés avec Windows XP préinstallé avec le
tableur Microsoft WORKS. Bien que WORKS reprenne un certain nombre de
fonctionnalités d'EXCEL, il est fortement conseillé d'installer la dernière version de la
suite gratuite OpenOffice.org à télécharger sur le portail français
http://fr.openoffice.org/ [http://fr.openoffice.org/ ] et d'utiliser CALC. Vous aurez
ainsi les captures d'écran et animations correspondant à cette suite.
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Chapitre

II
Introduction aux

tableurs

Niveau de difficulté : facile

Dans ce chapitre, nous nous attacherons à présenter globalement l'application « tableur
» : définition, intérêts et domaines d'applications. Vous découvrirez l'écran de travail et
apprendrez les termes généraux relatifs aux tableurs. Enfin, vous réaliserez quelques
opérations de base qui vous familiariseront avec l'environnement des tableurs.

Pré-requis : savoir utiliser et manipuler les fenêtres et les barres d'outils d'une
application

Temps d'apprentissage : 30 minutes

A. Fonctionnalités du tableur

Tableur

Un tableur est un logiciel permettant d'effectuer automatiquement des calculs sur des
données stockées dans un tableau. Selon la définition officielle, il s'agit d'un logiciel de
création et de manipulation interactives de tableaux numériques.

Un tableur est un outil informatique qui permet de mémoriser, agencer, présenter et
traiter les données. Il se compose d'une grille de quelques milliers de cases appelées
cellules. Chaque cellule peut contenir des valeurs constantes - textes ou nombres - ou
des formules. Il est ainsi possible d'automatiser des calculs complexes en créant des



tableaux appelés feuilles de calcul.

IMG. 1 : UNE FEUILLE DE CALCUL DE TABLEUR - SPÉCIFIQUE

Un tableur peut être vu comme une super calculatrice, mais avec des fonctionnalités
bien supérieures :

Contenu dynamique : en changeant le contenu d'une cellule, d'autres cellules liées à
cette cellule sont automatiquement recalculées.

Automatisation : les calculs répétitifs sont obtenus pas des copier/coller de formules.

Support de fonctions : de nombreuses fonctions (mathématiques, statistiques,
financières, ...) permettent l'analyse de données complexes.

Intégration de graphiques : les données peuvent être analysées sous forme de courbes,
de diagrammes, ...

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Exemple : intégration d'un diagramme en bâtons.

Cliquez sur le lien suivant afin de visualiser l'animation.
Animation "Création d'histogramme sous OpenOffice
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap1/animation_creation_histogramme_OO.htm]

Présentation : les tableaux peuvent être formatés pour une présentation
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professionnelle et imprimés ou intégrés dans des documents composites.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Exemple : formatage d'un tableau.

Cliquez sur le lien suivant afin de visualiser l'animation.
Animation "Présentation sous OpenOffice
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap1/presentation_OO.htm]

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Exemple : Intégration tableau OO Calc dans un document composite OO Writer.

Cliquez sur le lien suivant afin de visualiser l'animation.
Animation "Intégration tableau Calc dans un document composite
Writer" [http://projet.c2imes.org/V2/tutorielsB5/Chap1/capture_1-7_OO.swf.html]

Gestion de listes et de bases de données : les tris et filtres de données ainsi que les
fonctions de requêtes reprennent les fonctionnalités simples d'un Système de Gestion
de Base de Données.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Exemple : réalisation d'un filtre pour ne montrer que les articles dont la quantité
dépasse 50.

Cliquez sur le lien suivant afin de visualiser l'animation.
Animation "Réalisation d'un filtre pour ne montrer que les articles dont la quantité
dépasse
50" [http://projet.c2imes.org/V2/tutorielsB5/Chap1/capture_1-8_OO.swf.html]
Niveau 2 : pour aller plus loin

de programmer des fonctions personnalisées dans un environnement de
programmation intégré (Visual Basic, VBScript, JavaScript, ...) ;

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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Exemple : programmation d'une fonction f(x) = x2 en OpenOffice Basic.

Cliquez sur le lien suivant afin de visualiser l'animation.
Animation "Programmation d'une fonction f(x) = x2 en OpenOffice
Basic" [http://projet.c2imes.org/V2/tutorielsB5/Chap1/capture_1-9_OO.swf.html]

d'automatiser des tâches par l'écriture de macros ;

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Exemple : automatiser le remplissage de 10 cellules par des nombres qui se suivent.

Cliquez sur le lien suivant afin de visualiser l'animation.
Animation "Automatiser le remplissage de 10 cellules par des nombres qui se
suivent" [http://projet.c2imes.org/V2/tutorielsB5/Chap1/capture_1-10_OO.swf.html]

de créer des applications personnalisées en ajoutant des menus, des boîtes de
dialogues, des contrôles (boutons de commandes, ...).

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Exemple : lancer une macro par un bouton de commande incorporé à une feuille de
calcul.

Cliquez sur le lien suivant afin de visualiser l'animation.
Animation "Lancer une macro par un bouton de commande incorporé à une feuille de
calcul sous
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap1/capture_1-11_OO.swf.html]

Nous n'aborderons ici que les fonctionnalités de base permettant de réaliser des
documents destinés à être imprimés ou projetés : réaliser un tableau, le mettre en
forme, effectuer quelques calculs simples, réaliser des graphiques, et imprimer une
feuille de calcul ou l'intégrer dans un document composite.

Les tableurs les plus utilisés actuellement sont :
♦ Microsoft Excel, de la suite bureautique Microsoft Office,

♦ OpenCalc, de la suite OpenOffice,

♦ Sun StarOffice Calc, de la suite StarOffice,

♦ IBM/Lotus 1-2-3 de la suite SmartSuite,

♦ Quattro Pro de la suite Corel WordPerfect Office.
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MS Excel est le plus répandu mais le nombre d'utilisateurs du second, logiciel gratuit,
ne cesse d'augmenter. Notons cependant que tous les tableurs présentent les mêmes
fonctionnalités et que le passage de l'un à l'autre est généralement très aisé. De même,
les versions de chacun de ces tableurs évoluent mais les fonctionnalités des différentes
versions restent inchangées. Les exemples illustrant le module ont été élaborés avec
MS Excel 2003 et OO Calc 2.

B. Domaines d’applications

Le premier tableur, Visicalc, a vu le jour à la fin des années 1970. A l'époque, il était
essentiellement prévu pour des applications comptables et commerciales. Il permet en
effet de résoudre n'importe quel problème de gestion dans l'entreprise (prévision de
trésorerie ou de compte de résultat, calcul d'un échéancier d'emprunt, bulletin de
paie,..). Depuis, les applications du tableur se sont étendues à tous les domaines, en
particulier scientifiques. La simplicité, alliée à la puissance de calcul, fait du tableur un
outil bureautique présent sur les bureaux de tous les utilisateurs d'ordinateurs
personnels.

Partie A. Découvrir l'écran de travail

Lancez l'application tableur (MS Excel ou OO Calc). Au démarrage, le logiciel
présente un classeur[Document enregistré par le tableur. Il contient l'ensemble des
feuilles de calcul et graphique.] vierge contenant généralement trois feuilles de calcul.

"Spécifique Excel"

Une image explicative "" vous est proposée en Annexes "Pour aller plus loin ..."
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IMG. 3

1. Les différents objets de l'environnement

Lancez l'application tableur (MS Excel ou OO Calc). Au démarrage, le logiciel
présente un classeur vierge contenant généralement trois feuilles de calcul.

Les principaux éléments liés au classeur (document) sont :
♦ La feuille de calcul : c'est la partie blanche quadrillée qui occupe l'essentiel de

l'écran. Elle correspond à la zone de travail.

♦ Les onglets ou signets : ils sont situés au bas des feuilles. Chaque feuille porte un
nom qui apparaît sur son onglet. On active une feuille en cliquant sur son onglet. A
gauche des onglets, une barre de défilement permet de parcourir les feuilles de
calcul.

♦ Les barres de fractionnement : on a parfois besoin de voir simultanément sur l'écran
des colonnes ou des lignes d'un même tableau, qui sont trop éloignées pour être
visibles simultanément sur l'écran. On peut alors fractionner la fenêtre pour qu'elle
montre, dans les deux zones obtenues, des parties distinctes de la même feuille. C'est
la barre de fractionnement qui permet de dédoubler ainsi le point de vue sur une
feuille.
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♦ Les barres de coordonnées : les barres de coordonnées, situées immédiatement à
gauche et au-dessus des cases du tableau, numérotent les lignes par des nombres et
les colonnes par des lettres.

♦ La barre de formule : La barre de formule, située au-dessus de la barre de
coordonnées des colonnes, affiche à gauche, la référence de la case active, et à
droite, son contenu (donnée ou formule).

♦ Cellules : une feuille de calcul comprend un ensemble de cellules numérotées
comme pour une bataille navale. Pour désigner une cellule, on doit simplement
donner sa référence, c'est-à-dire ses coordonnées en commençant par la lettre de
colonne puis le numéro de ligne, par exemple : A1. La référence de la cellule
s'affiche dans la zone Nom. A tout moment, une des cellules de la feuille est active.
Plusieurs cellules contiguës formant un rectangle constituent une plage de cellules,
que l'on désigne par les coordonnées de deux cellules situées dans des coins opposés
du rectangle, par exemple : A2:B5

Les autres éléments sont analogues à ceux que l'on peut trouver par exemple dans un
traitement de texte :
♦ La barre de titre affichant le nom du fichier (classeur) sur lequel on travaille. A

droite sont aussi présents les boutons permettant la réduction, l'agrandissement ou la
fermeture de la fenêtre.

♦ La barre de menu pour obtenir les différents éléments de menu du tableur.

♦ Les barres d'outils pour accéder rapidement à certaines fonctionnalités du logiciel.

♦ La barre d'état pour afficher des informations utiles.

♦ Les ascenseurs horizontaux et verticaux.

Exercice n°1. Partez à la découverte de l'environnement…

Pointez les zones réactives correspondant aux objets suivants et voyez le nom des
différents objets de l'environnement :
♦ Cellule active

♦ Zone de Nom

♦ Barre de fractionnement verticale

♦ Barre de coordonnées lignes

♦ Barre de formule

♦ Onglet de la feuille 3

♦ Barre d'état

♦ Barre de menu

Réaliser la même image réactive avec l'environnement Calc
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Exercice n°2. Faites des « bulles » …

Pointez avec votre souris quelques unes des icônes des barres d'outils et attendez
qu'une bulle d'information apparaisse. Cherchez l'icône permettant de réaliser un tri
croissant.

Partie B. Manipuler les classeurs

1. Manipuler les classeurs

Le classeur est le document qui regroupe l'ensemble des feuilles.

Remarque

L'enregistrement du classeur permet de conserver l'ensemble de ses feuilles.

Ouvrir un nouveau classeur

Comme pour la plupart des applications, un nouveau document peut être ouvert par le
menu Fichier de l'application.
Présentation des classeurs à l’intérieur de l’application

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Chaque nouveau document s'ouvre dans une nouvelle fenêtre. La fenêtre de document
et la fenêtre de l'application sont confondues. Pour réduire le document, il faut réduire
l'application.
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IMG. 8 : BOUTON « NIVEAU INFÉRIEUR » DE LA FENÊTRE DE L’APPLICATION - SPÉCIFIQUE CALC

"Spécifique Calc"

Remarque

Il est possible de passer d'un document à l'autre en utilisant le menu Fenêtre de
l'application.

Exercice n°3. Exercez-vous !

Ouvrez deux nouveaux classeurs OpenOffice Calc de façon à obtenir 3 fenêtres en
cascade comme ci-dessous.

IMG. 9
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2. Manipuler les barres d'outils

Les barres d'outils de l'application tableur s'utilisent comme toute barre d'outils
d'application à interface graphique. Elles permettent d'avoir, par catégorie, un accès
direct à certaines commandes de l'application. Vous pouvez les ancrer ou les rendre
flottantes comme sur la figure suivante :

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

IMG. 11 : BARRE D’OUTILS FLOTTANTE - SPÉCIFIQUE CALC

Enfin, vous pouvez les personnaliser en y incluant une ou plusieurs commandes.

Les barres d'outils les plus importantes dans le tableur sont la barre d'outils « Standard
» ou « Normal » et la barre d'outils « Format ». Pour une utilisation aisée, vous pouvez
les placer comme sur la figure ci-dessous :

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

IMG. 13 : DISPOSITION PRATIQUE DES BARRES D’OUTILS « NORMAL » ET « FORMATAGE » - SPÉCIFIQUE CALC

24 MODULE B4 - REALISER DES DOCUMENTS DESTINES A ETRE IMPRIMES – TABLEURS



Afficher une barre d’outils

Les barres d'outils actuellement affichées sont celles qui sont cochées dans les
éléments du menu

Pour afficher une nouvelle barre d'outils, cochez l'élément de menu correspondant.
Ancrer et désancrer une barre d’outils

Une barre d'outils flottante peut être ancrée à la fenêtre de l'application. Il suffit de
glisser la barre de titre de la palette flottante jusqu'à ce qu'elle s'arrime quelque part.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

"Spécifique Calc"

Exemple

Voir l'animation pour ancrer la barre d'outils « Dessin » sous la barre de défilement :
cliquez sur le lien suivant afin de visualiser l'animation.

Animation "Ancrer la barre d'outils Dessin sous la barre de défilement dans
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap1/capture_1-12_OO.swf.html]

Exercice n°4. Essayez !

Affichez la barre d'outils « Dessin ».

Notez la position de la barre d'outils qui s'ouvre. Réduisez l'application et observez le
comportement de la barre d'outils.

Exercice n°5. Essayez !

Rendez à nouveau flottante la barre d'outils « Dessin » en la déplaçant par les
pointillés situés à gauche de la barre.

Réessayez maintenant l'opération d'ancrage en gardant appuyé la touche. Observez que
vous ne pouvez pas ancrer une barre d'outils dans ces conditions.
Redimensionnez la barre d'outils flottante.
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Partie C. Se déplacer dans une feuille de calcul

La feuille de calcul regroupe l'ensemble des cellules dont chacune possède une adresse
unique appelée "référence"[Adresse d'une cellule (ex. : C7) ou d'une plage de cellules
(ex. : B6:E10).]. Par défaut, à l'ouverture d'un classeur, la cellule active (sélectionnée)
de la première feuille est la cellule d'adresse (de référence) A1.

1. Se déplacer d’une cellule à l'autre

Le moyen le plus simple pour atteindre une cellule consiste à placer la souris au-dessus
puis à cliquer. La cellule devient alors active. Toutefois, lors de la saisie, il peut se
révéler plus simple de n'utiliser que le clavier. Dans ce cas, plusieurs combinaisons de
touches permettent de valider le contenu des cellules et de se déplacer dans la feuille
de calcul :
♦ Déplacements horizontaux

Les flèches du clavier permettent de valider le contenu de la cellule active et de
déplacer la cellule active d'une colonne dans la direction indiquée, la touche Tab
permet d'aller de la gauche vers la droite (et Maj+Tab pour le sens inverse).

♦ Déplacements verticaux
Les flèches du clavier permettent de valider le contenu de la cellule active et de
déplacer la cellule active d'une ligne dans la direction indiquée, la touche Entrée
permet d'aller du haut vers le bas (et Maj+Entrée pour le sens inverse) .

Remarque

La touche Entrée valide le contenu de la cellule active mais ne déplace la sélection que
si une option est définie dans le menu Outils > Option.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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IMG. 15 : OPTION POUR DÉPLACER LA SÉLECTION APRÈS VALIDATION - SPÉCIFIQUE CALC

2. Se déplacer dans de grands tableaux

Lorsque le tableau contient un nombre important de lignes et de colonnes, il n'est pas
toujours judicieux d'utiliser la souris et les ascenseurs des fenêtres pour se déplacer.
Plusieurs méthodes permettent d'atteindre plus rapidement les zones souhaitées :
♦ Pour vous déplacer d'un écran entier à la fois, vers le bas ou vers le haut, utilisez les

touches Pages suivantes et Pages précédentes.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Pour accéder rapidement à une cellule, vous pouvez ... :
♦ taper sa référence dans la zone de nom,

♦ ou utiliser le menu Edition > Navigateur (F5).

Introduction aux tableurs 27



IMG. 17 : ATTEINDRE UNE ZONE DE LA FEUILLE DE CALCUL - SPÉCIFIQUE CALC

♦ Pour vous déplacer sur la dernière cellule non vide de la ligne ou de la colonne, il est
très commode d'utiliser les touches fléchées en combinaison avec la touche CTRL.

♦ Pour retrouver la position d'origine (A1), quelle que soit la position de la cellule
active, utilisez la combinaison de touches CTRL+ORIGINE (CTRL+HOME).

Exercice n°6. Explorez toute la feuille de calcul !

Explorez toute la feuille de calcul !

Partie D. Sélectionner plusieurs cellules

Il est nécessaire, la plupart du temps, de sélectionner l'objet auquel s'applique une
commande avant d'appeler cette commande. Dans un tableau, l'objet sélectionné peut
être une cellule, des cellules adjacentes (ou ) ou des cellules non adjacentes.

Une sélection de cellules s'opère, comme pour n'importe quel objet de l'environnement
graphique (par exemple, la sélection des fichiers dans l'explorateur de fichiers) à l'aide
de la souris ou du clavier. La touche Echap annule la sélection en cours.
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1. Sélection à la souris / au clavier

Sélection à la souris

♦ Pour sélectionner une (des) colonne(s), cliquez dans l'en-tête (les en-têtes) de
colonne. Même chose pour les lignes :

IMG. 18 : SÉLECTION DE LIGNE - SPÉCIFIQUE

♦ Pour sélectionner toute la feuille de calcul, cliquez sur le bouton situé à l'intersection
des barres de coordonnées de colonne et de ligne ou tapez Ctrl+A.

IMG. 19 : SÉLECTION DE LA FEUILLE COMPLÈTE - SPÉCIFIQUE

Remarque : Sélection de cellules non adjacentes

Pour sélectionner des plages non adjacentes, maintenez appuyée la touche CTRL, puis
sélectionnez à la souris.

Sélection au clavier uniquement

A partir d'une cellule active, l'extension de la sélection aux cellules adjacentes se fait
par les touches fléchées et l'appui de MAJ.

Exercice n°7. Exercez-vous !

Sélectionnez la plage de cellules B2 : E6 avec la souris.
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♦ L'opérateur « : » séparant les deux références est un opérateur d'extension
définissant une plage de plusieurs cellules.

♦ Une plage de cellules est nécessairement rectangulaire.

♦ Les en-têtes de lignes et de colonnes sélectionnées sont grisées.

Exercice n°8. Exercez-vous !

Réalisez la sélection suivante en combinant l'utilisation du clavier et de la souris :

IMG. 20 : SÉLECTION DE CELLULES NON ADJACENTES - SPÉCIFIQUE

Partie E. Manipuler des feuilles

Un classeur peut présenter plusieurs feuilles de calcul. Le nombre de feuilles par
défaut pour un nouveau classeur est généralement de 3 mais cette valeur peut être
modifiée dans les options du tableur (Outils > Options).

Vous pouvez mieux organiser vos tableaux, par exemple, en utilisant une feuille pour
le bilan comptable de janvier, une autre feuille pour celui de février, etc... Ainsi, au
lieu de créer un grand tableau sur la feuille 1 dans lequel il sera difficile de se repérer,
vous scinderez ce tableau sur plusieurs feuilles.

Vous pouvez ... :
♦ sélectionner une ou plusieurs feuilles,

♦ insérer, supprimer, renommer, et déplacer une feuille,

♦ dupliquer une feuille,

♦ naviguer entre les feuilles.
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1. Sélectionner une ou plusieurs feuilles

L'onglet de la feuille active est blanc. Pour sélectionner un groupe de feuilles,
adjacentes ou non, utilisez sur les onglets de feuilles, la même méthode qu'avec la
sélection d'un groupe de cellules par la souris, en combinaison avec ... :
♦ la touche MAJ pour des sélections de feuilles adjacentes,

♦ la touche CTRL pour des sélections de feuilles non adjacentes,

Conseil

Pour annuler la sélection, procédez de la même façon en cliquant sur les onglets déjà
sélectionnés.

Lorsque plusieurs feuilles sont sélectionnées, les données saisies sont
dupliquées sur toutes les feuilles faisant partie de la sélection.

2. Insérer et déplacer une feuille

Insérer et déplacer une feuille

♦ Pour insérer une feuille, sélectionnez l'onglet de la feuille active, puis le menu
Insertion (Insérer) > Feuille.

♦ Pour déplacer une feuille, tirez son onglet avec la souris.

♦ Vous pouvez aussi insérer, supprimer, renommer une feuille par le menu
contextuel qui apparaît par un clic-droit sur l'onglet de feuille.

Exercice n°9. Exercez-vous !

Insérez une feuille intitulée entre la feuille 1 et la feuille 2. Renommez cette feuille :
« Ma feuille ».

3. Renommer une feuille

Renommer une feuille

♦ Pour renommer une feuille, cliquez droit sur l'onglet de la feuille, puis utilisez
le menu contextuel « Renommer ».

Introduction aux tableurs 31



"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

4. Copier une feuille

♦ Pour copier rapidement une feuille, vous pouvez utiliser un copier/coller en glissant
la souris à partir d'un onglet tout en maintenant appuyée la touche CTRL.

Remarque

Remarquez le symbole + à côté du curseur souris.

IMG. 21 : COPIER UNE FEUILLE - SPÉCIFIQUE

♦ Vous pouvez également utiliser le menu contextuel associé à l'onglet de feuille pour
copier une feuille dans le même classeur ou dans un autre classeur :

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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IMG. 23 : INSÉRER UNE FEUILLE AVEC LE MENU CONTEXTUEL ET DIFFÉRENTES OPTIONS - SPÉCIFIQUE CALC

5. Naviguer entre les feuilles

Pour naviguer entre les différentes feuilles, utilisez les onglets. Si le nombre de feuilles
ouvertes est important, utilisez la barre de défilement pour accéder aux onglets cachés
:

IMG. 24 : NAVIGUER ENTRE LES FEUILLES - SPÉCIFIQUE

Partie F. Formats de classeur et compatibilité

1. Format d'enregistrement

Par l'enregistrement du classeur, toutes les feuilles sont enregistrées : feuilles de calcul
et feuilles de graphiques (que nous verrons plus tard). Comme pour tout document, il
faut veiller au type de format d'enregistrement.
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"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Les fichiers ayant l'extension « .ods » sont au format natif (par défaut) de l'application
OpenOffice Calc.

Conseil

Le menu Fichier > Enregistrer sous permet d'enregistrer votre classeur en lui donnant
un nouveau nom. Il n'est pas nécessaire de préciser l'extension du fichier.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

IMG. 26 : ENREGISTRER UN FICHIER - SPÉCIFIQUE CALC

Conseil

Lorsque votre classeur est enregistré, son nom apparaît dans la barre de titre de
l'application.

2. Compatibilité entre les formats

Par sa position largement dominante sur le marché des tableurs, MS Excel a imposé un
standard de fait qui est reconnu par la totalité des autres tableurs (dont OO Calc).
Inversement, MS Excel ne reconnaît pas le format « OpenDocument » d'OpenOffice.

OO Calc permet l'enregistrement des classeurs au format MS Excel, en changeant le
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type de fichier dans la fenêtre « Enregistrer sous » :

IMG. 27 : RENDRE LES DOCUMENTS OO CALC COMPATIBLES AVEC MS EXCEL - SPÉCIFIQUE CALC

Partie G. Evaluation

Exercice n°10. Enoncé 1

♦ Ouvrez 3 nouveaux classeurs,

♦ Redimensionnez Classeur 1 et Classeur 2 pour qu'ils apparaissent côte-à-côte dans la
zone de travail,

♦ Minimisez le classeur 3.
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Exercice n°11. Enoncé 2

♦ Ajoutez un bouton de commande au choix dans la barre d'outils « format »,

♦ Vérifiez son fonctionnement,

♦ Supprimez ce bouton de commande.

Exercice n°12. Enoncé 3

♦ Ouvrez un nouveau classeur,

♦ Sélectionnez le groupe de cellules comme ci-dessous :

IMG. 28

Exercice n°13. Enoncé 4

♦ Dans un classeur ouvert, créez une feuille nommée « C2i » située entre la feuille 1 et
la feuille 2,

♦ Supprimez la feuille 3,

IMG. 29
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♦ Sélectionnez le groupe de 3 feuilles et faites-en une copie dans le même classeur.

Exercice n°14. Enoncé 5

♦ Trouvez la méthode la plus rapide pour atteindre la celluleP123.

Solution : Taper l'adresse P123 dans la zone de nom.

♦ A partir de cette cellule, sélectionnez le plus rapidement toutes les cellules à droite
et au-dessous de cette cellule.

Solution : Utilisez la combinaison des touches CTRL+MAJ+→ et ↓ ).

♦ Utilisez les touches CTRL+ORIGINE (HOME) pour revenir en A1.

C. Synthèse

Ce chapitre introductif vous a présenté les principales fonctionnalités d'un tableur.
Vous commencez peut-être à voir pourquoi, par sa simplicité et sa puissance, cet outil
est tellement utilisé dans tous les domaines, et pourquoi il est important d'apprendre à
bien s'en servir.

Un certain nombre de commandes du tableur sont assez générales, comme, manipuler
les barres d'outils, ouvrir et fermer les documents (classeurs). D'autres opérations plus
spécifiques comme sélectionner des cellules et des plages de cellules, copier, coller et
déplacer des feuilles vous deviendront bientôt très familières.
Vous vous doutez que les cellules n'attendent qu'une chose : que vous y entriez des
données ! Eh bien, c'est ce que nous allons faire dans le chapitre suivant.
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Chapitre

III
Saisir les données

d'un tableau :
contenu et format

Niveau de difficulté : facile

Dans ce chapitre, vous commencerez à saisir des données dans une feuille de calcul.
Vous apprendrez à reconnaître les différents types de données que peut accepter le
tableur. Vous verrez comment formater et présenter les données en général, et les
nombres en particulier. Enfin, vous appliquerez les opérations de « copier », « coller »,
« déplacer » aux cellules et plages de cellules.

Pré-requis : connaître la terminologie associée aux tableurs : feuille de calcul,
cellules...

Temps d'apprentissage : 40 minutes



Partie A. Saisir et modifier des données

1. Le type des données

Dans une feuille de calcul, on peut saisir des données et des formules :
♦ les données peuvent être :

- des nombres,
- des dates et heures,
- du texte.

♦ les formules décrivent un calcul. Elles commencent toutes par le signe « = » suivi :

- d'une expression (exemple : =2*A1+A2 ),
- d'une fonction (exemple : =somme(A1:A6) ).

Attention

♦ Les données du tableau : elles sont constantes et en général entrées avant de
réaliser les calculs. Leur saisie et leur modification sont décrites dans ce
chapitre.

♦ Les formules : elles réalisent un calcul à partir des données entrées. Les
formules sont introduites au chapitre « Ecrire des formules simples ».

2. Saisir des données constantes

Pour saisir une donnée dans une cellule, il suffit de ... :
1. sélectionner la cellule,

2. entrer la donnée,

3. valider :

- avec la touche Entrée,
- ou en sélectionnant une autre cellule (souris ou flèches de déplacement de

curseur).

Remarque

La donnée contenue dans la cellule active est toujours affichée dans la barre de
formule.
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Saisie des nombres

Utilisez le pavé numérique et le point figurant sur le pavé numérique comme
séparateur décimal, pour que le séparateur décimal apparaisse comme une virgule.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

"Spécifique Calc"

Paramètres linguistiques

Vérifiez les paramètres linguistiques d'OpenOffice avec le menu Outils > Options >
Paramètres linguistiques > Langues - Langue afin de sélectionner Français pour
l'interface utilisateur et l'environnement linguistique.

Dès la saisie du premier caractère, le tableur passe en mode saisie :

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

« INS » dans la barre d'état

et deux icônes apparaissent dans la barre de formule :

Conseil

La touche Entrée peut déplacer la sélection vers le bas en validant le contenu de la
cellule active. Utilisez le menu :

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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"Spécifique Calc"

Conseil

Outils > Options - catégorie OpenOffice.org Calc : Général ; paramètres de saisie :
touche Entrée pour déplacer la sélection « En bas »

Exercice n°15. Exercez-vous !

Entrez les données numériques suivantes :

A1 : 1
A2 : 1,2
A3 : 3,4e-3 (notation scientifique correspondant à 3,4x10-3)
A4 : 19,6%
A5 : 32€ (€ : AltGr+E)
A6 : 2/2/7
A7 : 13:30

Exercice n°16. Exercez-vous !

Entrez les données suivantes de type texte :

C1 : coucou
C2 : Ceci est un texte aligné à gauche

Exercice n°17. Exercez-vous !

Entrez les données suivantes représentant la taille d'une personne :

C4 : 1,82 m
C5 : 1,82
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3. Modifier une donnée

Pour modifier une donnée, il faut ... :
♦ sélectionner la cellule,

♦ taper la nouvelle donnée (cela remplace l'ancienne),

♦ valider.

Si vous souhaitez conserver l'ancienne donnée et n'en modifier qu'une partie, il
faut sélectionner la cellule, puis, au choix ... :
♦ cliquer dans la barre de formule, modifier la donnée et valider,

♦ appuyer sur la touche de fonction F2, modifier la donnée et valider (modification
directe à l'intérieur de la cellule).

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Exercice n°18. Exercez-vous !

Exercez-vous en modifiant une ou plusieurs données de votre tableau ... :
♦ en utilisant la barre de formule,

♦ en utilisant la modification directe.

4. Effacer une donnée

Il est possible d'effacer le contenu, le format ou les deux.

♦ Sélectionnez la cellule ou la plage de cellules,

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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♦ Pour effacer le contenu : touche Retour Arrière (Bk Sp) ← .

♦ Pour effacer le format : touche SUPPR puis sélectionner Format.

♦ Pour effacer le contenu et le format : touche SUPPR puis sélectionner Supprimer
tout.

"Spécifique Calc"

Conseil

La touche SUPPR permet également de supprimer uniquement un type de données
dans une plage de cellules, par exemple les cellules contenant des dates.

Exercice n°19. Exercez-vous !

♦ En effaçant uniquement le contenu d'une cellule, vérifiez qu'une nouvelle donnée
entrée conserve le format précédent.

♦ Renouveler l'expérience en effaçant uniquement le format d'une cellule.

♦ Renouveler l'expérience en effaçant le contenu et le format d'une cellule.
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Partie B. Formater et présenter les données

L'application du format permet d'afficher les données en fonction de ce qu'elles
représentent :
♦ Un nombre entier : pas de virgule (par exemple un nombre d'habitants).

♦ Un nombre décimal (ex. : 1,82), un pourcentage (ex. : 19,6%), une monnaie (ex. :
10,50 € ) : le nombre de décimales doit être fixé (par exemple 2 décimales pour une
monnaie en euros).

♦ Une date et/ou une heure avec plusieurs formats possibles :

- Vendredi 14 juillet 2006
- 14/06/06
- 14 juil.-06
- 14-juil-06
- 13:30
- 13:30:00

♦ Un texte.

Lors de l'élaboration d'un tableau, il est préférable de saisir les nombres à l'état brut,
c'est-à-dire sans espace, sans symbole monétaire... Lorsque les données seront entrées,
vous pourrez alors les formater directement par le menu Format.

1. Appliquer un format

Le formatage des données est obtenu par le menu Format > Cellule(s) > Nombre(s)
après sélection de la plage concernée.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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IMG. 31 : FORMATAGE DES DONNÉES - SPÉCIFIQUE CALC

Le résultat du formatage est indiqué dans la zone entourée en noir (ex : 1234,56789).
Vous pouvez ainsi vérifier le format avant de le valider.

Conseil

D'autres onglets sont disponibles dans le menu Format > Cellule(s) : ils permettront de
bien présenter un tableau (chapitre « Bien présenter un tableau »).

Exercice n°20. Exercez-vous !

Saisissez le tableau suivant, sans vous préoccuper des formats :
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IMG. 32 : TABLEAU DE DÉPART, SANS LES FORMATS - SPÉCIFIQUE

Formatage :
♦ A1 : Formatez la cellule pour qu'elle affiche 1,20

♦ A2 : Formatez cette valeur en pourcentage. Que se passe-t-il ?

L'affichage indique 550% : en effet 550 divisé par 100 donne 5,5 !

♦ Quelle valeur donnerait l'affichage 5,50% après formatage en pourcentage ?

0,055 . Vous pouvez également saisir 5,5%, ce qui revient à diviser 5,5 par 100.

Maintenant que la cellule est formatée en %, tout ce que vous y entrerez sera divisé par
100. Pour afficher 5,5%, il suffit donc de saisir 5,5 (remarquez le symbole %) et de
définir le nombre de décimales à 2.

♦ A3 : Formatez cette valeur pour que l'affichage indique 32 € .

♦ A4 : Formatez cette valeur pour que l'affichage indique -32 000 € en rouge si le
nombre est négatif. Remplacez cette valeur par +16000. Observez le résultat.

♦ A5 : Formatez la valeur pour que s'affiche « 2 février 2007 ».

Vous devriez obtenir le tableau final suivant :
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IMG. 33 : RÉSULTAT DE L’EXERCICE - SPÉCIFIQUE

2. Supprimer un format

Pour supprimer un format, sélectionnez les cellules dont vous voulez supprimer le
format, puis utilisez une des méthodes suivantes :

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

♦ Menu Format > Cellules > Nombres - Catégorie : Tout , Format : Standard.

♦ Menu contextuel (clic-droit) puis Formater les cellules.

♦ Menu Edition > Supprimer du contenu et cocher « Formats ».

♦ Touche Suppr et cocher « Formats ».

Exercice n°21. Une petite énigme…

Une petite énigme...

♦ Dans une cellule, entrez 2/2/7. Formatez cette valeur en nombre standard. Le
résultat est 39115.

♦ Dans une cellule, entrez 13:30. Formatez cette valeur en nombre standard. Le
résultat est 0,5625.
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3. Recopier un format

Pour recopier un format existant vers d'autres cellules :

♦ Sélectionnez la cellule dont vous voulez recopier le format,

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

♦ Cliquez sur l'icône de la fonction « Appliquer le format ».

IMG. 35 : ICÔNE « APPLIQUER LE FORMAT » - SPÉCIFIQUE CALC

Remarque

Observez la transformation du curseur de la souris. Toutes les cellules qui seront
sélectionnées avec ce curseur recevront le format souhaité.

♦ Sélectionnez le(s) cellule(s) de destination : le format est recopié.

Cet outil fonctionne de manière analogue dans un traitement de texte pour
recopier un format de texte, de paragraphe, ....

Exercice n°22. Exercez-vous !

A partir du tableau précédent, recopiez la mise en forme d'une cellule sur au moins 2
cellules.
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4. Piège lié aux formats de nombre

Attention

L'application d'un format de nombre ne modifie pas la valeur réelle contenue dans la
cellule mais uniquement la façon dont elle est affichée. Les nombres sont toujours
mémorisés avec la précision avec laquelle ils ont été saisis.

Conseil

La valeur exacte est toujours affichée dans la barre de formule, telle qu'elle a été saisie.

Explication

En choisissant le nombre de décimales à l'affichage d'un nombre, j'indique sa
« précision ». Par exemple, j'affiche ma taille à 1,80 m (avec 2 décimales) et non pas à
1,8 m ni à 1,8042 m parce que la toise est précise au cm.

Ainsi un nombre saisi avec 2 décimales peut n'être affiché qu'avec 1 décimale, mais les
calculs porteront sur la totalité des chiffres, et non sur les chiffres affichés. C'est ainsi
que leur somme peut apparaître fausse si le format d'affichage est mal choisi.

IMG. 36 : FORMAT D’AFFICHAGE MAL CHOISI - SPÉCIFIQUE

Et pourtant, le calcul est correct ! En affichant toutes les décimales, le résultat est
cohérent avec les données :
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IMG. 37 : FORMAT D’AFFICHAGE À 2 DÉCIMALES - SPÉCIFIQUE

Exercice n°23. Une histoire d'arrondis

♦ Dans une cellule, entrez 12,34 : le nombre est affiché avec 2 décimales.

♦ Réduisez le nombre de décimales à 1 avec l'icône de la barre d'outils « Format » : le
nombre affiché dans la cellule est arrondi à 12,3. La barre des formules présente
toujours le contenu réel de la cellule.

♦ Ré-augmentez le nombre de décimales : la valeur réelle réapparaît parce qu'elle a été
saisie avec cette précision.

♦ Entrez 12,35 et formatez cette valeur avec une seule décimale.

Exercice n°24. Exercez-vous !

Dans une autre cellule, saisissez la valeur 1,80 : par défaut, le zéro situé à la fin d'un
nombre décimal n'est pas affiché. Pour afficher ce zéro significatif, formatez le
nombre avec 2 décimales.

Partie C. Copier et déplacer des données

1. Copier-coller des données

Vous pouvez copier une ou plusieurs cellules exactement comme vous copiez du texte
dans un traitement de textes avec :
♦ La commande

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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Editer > Copier, puis Editer > Coller.

♦ Le menu contextuel (clic-droit).

♦ Les raccourcis clavier CTRL+C et CTRL+V.

♦ Les icônes « copier/coller ».

IMG. 38

♦ Le glisser-déposer.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

"Spécifique Calc"

Copier-coller avec la souris dans Calc

Le glisser-déposer + ALT.

♦ Cliquez sur le lien suivant afin de visualiser l'animation.

Animation "Copier-Coller avec la souris dans
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap2/capture_002_OO.htm]

Pour copier une seule cellule, noircissez la cellule à copier en appuyant sur la
touche CTRL tout en cliquant dessus, puis relâchez la touche CTRL. Procédez
ensuite comme une copie de plage de cellules.

Attention

Dans cette démarche, à la fois le contenu (nombre, texte, ...) et le format de la cellule
sont copiés.
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Conseil

Pour désigner la destination du collage, il suffit de sélectionner la cellule cible, ou dans
le cas d'une plage de cellules, de sélectionner la cellule située en haut à gauche de la
plage destination avant de coller.

2. Couper-coller des données

Vous pouvez déplacer une ou plusieurs cellules exactement comme vous déplacez du
texte dans un traitement de textes avec :
♦ La commande

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Editer > Couper, puis Editer > Coller.

♦ Le menu contextuel (clic droit).

♦ Les raccourcis clavier CTRL+X et CTRL+V.

♦ Les icônes « couper/coller ».

IMG. 39

♦ le glisser-déposer :

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

"Spécifique Calc"

Déplacer une plage de cellules avec la souris dans Calc
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Cliquez sur le lien suivant afin de visualiser l'animation.

Animation "Déplacer une plage de cellules avec la souris dans
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap2/capture_003_OO.htm]

Pour déplacer une seule cellule, noircissez la cellule à déplacer en appuyant sur
la touche CTRL tout en cliquant dessus, puis relâchez la touche CTRL. Procédez
ensuite comme pour un déplacement de plage de cellules.

Attention

Dans cette démarche, à la fois le contenu (nombre, texte, ...) et le format de la cellule
sont déplacés.

Exercice n°25. Exercez-vous !

♦ Entrez une valeur (type nombre, date ou texte) dans les 3 cellules A1, A2 et A3.
Copiez ces valeurs en B1:B3 puis copiez la plage A1:B3 en C4:D6. Essayez
plusieurs méthodes (menu, menu contextuel, raccourci clavier, souris).

Quelle méthode préférez-vous ?

♦ Copiez maintenant la plage C4:D6 sur la feuille 2 en B1:C3.

Remarquez qu'il suffit de sélectionner la cellule B1 de la feuille 2 et de coller la
plage copiée.

3. Recopier avec la poignée de recopie

La poignée de recopie est le petit carré noir dans le coin inférieur droit d'une cellule ou
d'une plage de cellules. Le curseur souris se transforme en petite croix lorsque qu'il
pointe cette poignée.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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IMG. 41 : POIGNÉE DE RECOPIE - SPÉCIFIQUE CALC

Cette poignée permet de recopier une valeur sur les cellules adjacentes, de réaliser une
recopie incrémentée pour créer une série numérique (exemple : 1, 2, 3, ..) ou de
générer une liste personnalisée (exemple : Lundi, Mardi, Mercredi, ...).
Recopie simple

♦ Pour recopier une valeur sur les cellules adjacentes, positionnez le curseur de la
souris sur la poignée de recopie jusqu'à ce qu'il prenne la forme d'une petite croix.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

"Spécifique Calc"

Recopie avec la poignée dans Calc

♦ Appuyez sur la touche CTRL, puis tirez vers le bas ou vers la droite pour
recopier la valeur.

- Cliquez sur le lien suivant afin de visualiser l'animation.
Animation "Recopie avec la poignée de recopie dans
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap2/capture_004_OO.htm]

Recopie incrémentée

♦ Pour réaliser une recopie incrémentée, mettez les deux premiers nombres de la série
dans 2 cellules adjacentes, sélectionnez ces 2 cellules puis procédez de la même
façon que pour une recopie simple avec la poignée de recopie.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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"Spécifique Calc"

Recopie incrémentée dans Calc

Cliquez sur le lien suivant afin de visualiser l'animation.

Animation "Recopie incrémentée dans
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap2/capture_005_OO.htm]

Liste personnalisée

♦ Pour générer une liste personnalisée, vérifiez que la liste existe avec le menu.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Outils > Options > OpenOffice.org Calc > Listes de tri.

Il suffit alors de saisir un élément de la liste triée dans une cellule, et de tirer sur la
poignée de recopie de cette cellule.

Cliquez sur le lien suivant afin de visualiser l'animation.

Animation "Générer une liste
personnalisée" [http://projet.c2imes.org/V2/tutorielsB5/Chap2/capture_006.htm]

Exercice n°26. Exercez-vous !

Créez un calendrier sur 28 jours comme ci-dessous avec seulement 4 recopies
incrémentées.

4. Recopier une valeur sans son format

La copie ou le déplacement de cellules conserve le format.

Si vous ne souhaitez copier ou déplacer que la (les) valeur(s) sans les formats, utilisez
le menu ...

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Editer > Collage Spécial et décochez Formats.
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5. Insérer et supprimer des cellules

L'insertion et la suppression d'une cellule ou d'une plage de cellules décale les données
existantes. Un message vous demandera de préciser si les autres cellules doivent se
décaler vers la droite ou le bas. Vous avez aussi la possibilité d'insérer une ligne ou
une colonne entière.

♦ Pour insérer une cellule ou une plage de cellules, sélectionnez l'endroit du tableau où
vous voulez les insérer et utilisez le menu ou le menu contextuel équivalent.
Choisissez ensuite l'option de décalage.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

"Spécifique Calc"

Insertion de cellules dans OO Calc

Menu Insérer > Cellules.

Exercice n°27. Exercez-vous !

A partir du tableau de départ suivant créé avec les recopies incrémentées, insérez 3
cellules en B2:D2 pour obtenir le tableau final ci-dessous :

IMG. 42 : TABLEAU DE DÉPART - SPÉCIFIQUE

IMG. 43 : TABLEAU FINAL - SPÉCIFIQUE
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Partie D. Evaluation

Exercice n°28. Enoncé 1

♦ Saisissez le tableau suivant (utilisez abondamment la poignée de recopie).

IMG. 44

♦ Insérez une ligne avant la ligne 1 pour ajouter des intitulés aux colonnes.

IMG. 45

♦ Déplacez le tableau complet en B2:C8 et rajoutez un titre au tableau.
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IMG. 46

Exercice n°29. Enoncé 2

♦ Saisissez les données suivantes (utilisez abondamment la poignée de recopie).

♦ Formatez les données comme indiqué.

Exercice n°30. Enoncé 3

♦ Copiez le tableau précédent sur une nouvelle feuille.

♦ Modifiez la copie pour obtenir le résultat ci-dessous.

QUESTION N°1

Une cellule affiche 1,23. Comment puis-je savoir qu'il ne s'agit pas d'un arrondi d'affichage ?

A 1) Je déplace cette valeur dans une autre cellule non formatée.

B 2) Je copie cette valeur dans une autre cellule non formatée.

C 3) La valeur exacte est affichée dans la barre de formule.

D 4) J'augmente le nombre de décimales affichées.

E 5) Je n'ai pas moyen de le savoir.
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QUESTION N°2

Une cellule affiche des caractères ###### bizarres. Comment puis-je arranger cela ?

A 1) J'utilise l'aide du tableur.

B 2) Je sélectionne cette cellule : le contenu de la cellule doit apparaître dans la barre de
formule.

C 3) Je change ce format d'affichage en un format numérique.

D 4) Il doit s'agir d'un message d'erreur indiquant que la donnée saisie n'est pas valide : je
retape la donnée.

E 5) J'augmente la largeur de la colonne.

A. Synthèse

Dans ce chapitre, vous avez appris à saisir et manipuler des données de différents
types : nombre, texte, date. Vous avez vu l'importance des différents formats
d'affichage pour représenter ces données et le rôle des chiffres significatifs pour
indiquer la « précision » d'un nombre.

Vous maîtrisez maintenant les méthodes usuelles de copier/coller/déplacer qui sont
analogues à celles d'un traitement de texte, avec des spécificités comme la poignée de
recopie qui améliore votre efficacité.
Ces données sont encore bien statiques ! Nous allons les faire vivre un peu dans le
chapitre suivant en apprenant à les intégrer dans des formules simples.
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Chapitre

IV
Ecrire des formules

simples

Niveau de difficulté : standard

Ce chapitre introduit l'utilisation de données dynamiques dans le tableur. Les données
dynamiques sont basées sur un calcul à partir des données constantes d'un classeur.
Vous apprendrez à écrire dans une cellule une formule simple se référant à d'autres
cellules. Le résultat de la formule est affiché et est automatiquement recalculé si les
données de référence sont modifiées.

Pré-requis : savoir entrer des données constantes et pouvoir identifier leur type

Temps d'apprentissage : 45 minutes

Partie A. Connaître la notation d'une référence de
cellule

L'utilisation de données dynamiques suppose que l'on puisse préciser l'adresse (la
référence) des cellules qui vont servir aux calculs. Il existe plusieurs styles de
notation :

1. La notation de type A1

C'est la notation la plus utilisée. Chaque ligne est numérotée de 1 à 65536 et chaque
colonne de A à IV (256 colonnes), ce qui représente plus de 16 millions de cellules !
Le nombre de lignes et de colonnes peuvent varier selon les tableurs et leur version.



"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Par défaut, une référence de cellule de type A1 est relative : cette notion sera précisée
dans le chapitre « Utiliser la recopie de formules et les références relatives et absolues
».

2. La notation de type L1C1

C'est une notation peu utilisée que l'on retrouve dans certains tableurs comme MS
Excel, mais pas dans OO Calc. Chaque ligne est numérotée L1, L2, ... jusqu’à L65536
et chaque colonne est numérotée C1, C2 … jusqu’à C256. La notation de type L1C1
utilise par défaut les références absolues : par exemple, L2C3 correspond à la cellule
de la 2ème ligne 3ème colonne du tableau. La notion de référence absolue sera
précisée dans le chapitre « Utiliser la recopie de formules et les références relatives et
absolues ».

Dans le reste du module, on utilisera la notation A1 qui est la plus usuelle.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

3. La notation symbolique

Supposons que vous ayez un taux de TVA dans la cellule B2. Faire référence au nom
« TVA » plutôt qu'à l'adresse B2 rendra une formule de calcul du prix TTC plus
lisible.

Cette notation symbolique fait référence à la cellule où se trouve effectivement ce
taux. Ce nom sera visible dans la zone de nom à gauche de la barre de formule.

Pour donner un nom symbolique à une cellule ou à une plage de cellules, sélectionnez
la ou les cellules à nommer, puis :

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Menu Insérer > Noms > Définir.
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Conseil

Le raccourci clavier pour définir un nom : CTRL+F3.

La solution la plus rapide est de taper le nom dans la zone de nom.

Exercice n°31. Exercez-vous !

Nommez « TVA » la cellule B2. Vérifiez ensuite que ce nom apparaît dans la zone de
nom.

♦ Pour Excel
La référence à la cellule est notée : « Feuil1 !$B$2 ». Elle fait apparaître le nom de
la feuille suivi du symbole « ! » et de l'adresse absolue $B$2.

♦ Pour Calc
La référence à la cellule est notée : « Feuil1.$B$2 ». Elle fait apparaître le nom de
la feuille suivi du symbole « . » et de l'adresse absolue $B$2.

La notion d'adresse absolue sera vue dans le chapitre « Utiliser la recopie de formules
et les références relatives et absolues ».

Partie B. Ecrire une formule arithmétique

1. Ecrire une formule arithmétique

Les calculs sont décrits par des formules. Dans une formule arithmétique, vous pouvez
entrer :
♦ des constantes,

♦ des références à d'autres cellules,

♦ des opérateurs arithmétiques (+, -, *, /, élévation à la puissance ^, ...),

♦ et des fonctions (somme, moyenne, ...).

Les fonctions seront vues dans le chapitre suivant.

Attention

Ne confondez pas les données (valeurs constantes) et les formules qui utilisent les
données et fournissent un résultat.
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Pour saisir une formule :
♦ Commencez toujours par le signe « = » : vous différenciez ainsi la formule des

données constantes (nombre ou texte).

Attention

Pour saisir une formule, commencez toujours par le signe « = ».

♦ Saisissez la suite de la formule. Pour saisir la référence d'une cellule, vous
pouvez taper la référence au clavier, ou sélectionner la cellule avec les touches
fléchées ou la souris.

♦ Valider avec la touche « Entrée ».

Le résultat du calcul s'affiche alors automatiquement dans la cellule. Par contre, la
formule est toujours visible dans la barre de formule. Pour la modifier, utilisez une des
méthodes vues au chapitre « Saisir les données d'un tableau ».

Exemple

Un exemple simple : faire la somme des 2 cellules A1+A2 en A3.

IMG. 47 : SOMME DE 2 CELLULES - SPÉCIFIQUE
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♦ Commencez par entrer les constantes en A1 et A2,

♦ En A3, tapez le signe « = » :

- Pour Excel : la barre d'état indique « Entrer » pour vous inviter à valider la
formule par la touche Entrée.

- Pour Calc : la barre d'état affiche « INS » pour indiquer le mode insertion.

Taper les références au clavier :
♦ Continuez la saisie avec les 5 touches « A » « 1 » « + » « A » « 2 ».

Pour Excel : après avoir saisi A1, l'adresse A1 se colore et la cellule A1
s'entoure de la même couleur.

♦ Validez avec Entrée : le résultat apparaît dans la cellule A3. La formule
« =A1+A2 » est toujours visible dans la barre de formule.

Utiliser les touches fléchées :
♦ Reprenez la formule en A3, mais sélectionnez les 2 cellules A1 et A2 avec les

touches fléchées au lieu d'entrer leur adresse : « = » « ↑ - » « ↑ - » « + » « ↑
- »

♦ Validez avec Entrée.

Utiliser la souris :
♦ Reprenez la formule en A3, mais sélectionnez les 2 cellules A1 et A2 avec la

souris : « = » puis sélection A1 par la souris « + » puis sélection A2 par la
souris.

♦ Validez avec Entrée.

Conseil

La sélection des adresses à la souris est généralement la méthode la plus rapide. Vous
pouvez combiner les 3 méthodes.

Exemple
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Une formule... C’est magique !

♦ Modifiez maintenant la valeur de la cellule A1 : observez la modification
automatique du résultat en A3.

Dès que le contenu d'une cellule est modifié, la feuille de calcul est
automatiquement mise à jour.

Attention

Chaque fois qu'une donnée est susceptible d'être modifiée, entrez-la dans une cellule et
faites référence à cette cellule.

♦ N'oubliez pas d'enregistrer votre fichier.

Exercice n°32. Exercez-vous !

♦ Saisissez et formatez les données suivantes comme indiqué :

IMG. 48 : DONNÉES - SPÉCIFIQUE

♦ Entrez en B3 la formule de calcul du prix TTC : « =(1+B2)*B1 ». Résultat Prix
TTC : 358,80 € .

♦ Nommez la cellule B1, « prix_HT » et la cellule B2, « TVA ».

♦ Modifiez la formule en B3 pour faire référence aux noms de cellules plutôt qu'à leur
adresse : « =(1+TVA)*prix_HT ».

En faisant référence à la cellule contenant la TVA plutôt qu'en introduisant 0,196 dans
la formule de calcul du prix TTC, vous pouvez recalculer automatiquement ce prix si
la TVA est changée (par exemple à 5,5%). En mettant la formule « =1,196*B1 », vous
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seriez obligé de rééditer cette formule.

Partie C. Attention à la priorité

1. Attention à la priorité

Comme pour une calculatrice, les opérateurs définissent les priorités et l'ordre de
calcul dans une formule. Si vous voulez changer cet ordre, vous devez rajouter des
parenthèses. Il est important de connaître ces priorités pour ne pas compliquer
inutilement les formules. Pour les opérateurs arithmétiques, la priorité est, par ordre
décroissant :
♦ L'opérateur « ? » qui change le signe du nombre qui suit (ex : -12),

♦ L'opérateur « ^ » d'élévation à la puissance (ex : 4^2 pour 16),

♦ Les opérateurs de multiplication « * » et de division « / »,

♦ Les opérateurs d'addition « + » et de soustraction « ? ».

A priorité identique, le calcul se fait de gauche à droite.

Attention

Les parenthèses permettent de modifier l'ordre de calcul dans une formule. Tout ce qui
est entre parenthèses est calculé en priorité.

Il y a toujours autant de parenthèses à fermer que de parenthèses ouvertes.

Exercice n°33. Exercez-vous !

Respectez la priorité !
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Partie D. Messages d'erreur dans les formules

Lorsqu'une formule est incorrecte, le tableur envoie un message d'avertissement à la
place du résultat. Pour apprendre à reconnaître ces messages, vous allez
volontairement commettre des erreurs de différents types. Mais ne culpabilisez pas !
Vous aurez toujours la possibilité de revenir en arrière avec la combinaison de touches
CTRL+Z.

Fichier de départ : reprenez le fichier précédent de calcul du prix TTC après en avoir
fait une sauvegarde, ou téléchargez-le :

La sauvegarde vous permettra de reprendre l'exercice si vous ne pouvez pas annuler
les erreurs.

IMG. 49 : FICHIER DE DÉPART - SPÉCIFIQUE

1. Erreur de parenthèses

Exemple

Lorsque vous éditez une formule, vous oubliez de fermer une parenthèse ou vous en
rajoutez une supplémentaire. N'oubliez pas que vous devez fermer autant de
parenthèses que vous en ouvrez.

Dans la formule en B3, effacez la parenthèse fermante après TVA, puis validez.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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Le tableur corrige de lui-même l'absence de parenthèse fermante. La correction est
fausse. Rectifiez la formule par vous-même.

2. Erreur « #REF ! »

Exemple

Supprimez la cellule B2. Utilisez la commande Supprimer et non Effacer qui n'efface
que le contenu et le format de la cellule.

La cellule B3 fait référence à B2. En supprimant cette cellule, il manque cette
référence aux formules, d'où le message #REF!. L'association du nom « TVA » à
la référence B2 n'est également plus valable.

3. Erreur de type

En B3, remplacez la formule « =(1+TVA)*Prix_HT » par « =(1+"TVA")*Prix_HT ».
La référence symbolique TVA est remplacée par le texte "TVA" incompatible avec une
formule arithmétique.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Le code d'erreur « Err :502 » apparaît dans la cellule.

Attention

Annulez la suppression de F1 avec CTRL+Z ou rechargez le fichier initial.

4. Erreur « #NOM ? »

Exemple

Toujours en B3, supprimer le « A » de « TVA » dans la formule. La cellule nommée
« TV » n'existe pas et le tableur vous l'indique par le message « #NOM ? ».

Attention
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Annulez la suppression de F1 avec CTRL+Z ou rechargez le fichier initial.

5. Référence circulaire

Enfin, une erreur assez fréquente et généralement involontaire consiste à créer une
référence circulaire : la formule fait référence à son propre résultat. Il n'est pas toujours
facile de détecter les relations (les dépendances) entre les cellules et de repérer la
cellule qui est l'origine de ce problème.

Exemple

En A1, saisissez une formule calculant le prix HT à partir du prix TTC de la cellule
B1 : « =B3/(1+TVA) », puis validez.

B3 est calculée à partir de B1, et B1 est calculée à partir de B3. Vous avez créé
une référence circulaire.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Le code d'erreur « Err :522 » vous indique une référence circulaire.

Attention

Annulez la suppression de F1 avec CTRL+Z ou rechargez le fichier initial.

6. Autres erreurs

Il existe d'autres types d'erreurs. Chaque fois que le tableur affiche un message
commençant par « # » dans Excel ou un code d'erreur « Err : xxx » dans Calc,
essayez d'analyser le problème en fonction de ce message.
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Partie E. Evaluation

Exercice n°34. Enoncé n°1

IMG. 50 : ENONCÉ 1 - SPÉCIFIQUE

Exercice n°35. Enoncé n°2

Dans ce nouveau classeur :
♦ Nommez « TVA » la cellule H1 de la feuille 1.

♦ Créez une copie de la feuille 1.

♦ Dans cette nouvelle feuille, supprimez la plage G1:H1 affichant la TVA.

♦ Modifiez la formule en E2 pour faire référence à « TVA ».

Exercice n°36. Enoncé n°3

Calcul des annuités (versements annuels) pour un remboursement d'emprunt.

A. Synthèse

Dans ce chapitre, vous avez appris les différentes notations des références d'une cellule
et comment utiliser ces références pour écrire des formules simples. Comme avec une
calculatrice, il est important de respecter la priorité des opérateurs arithmétiques et
savoir utiliser les parenthèses.

Une règle importante que vous devriez retenir : chaque fois qu'une donnée est
susceptible d'être modifiée, entrez-la dans une cellule plutôt que comme constante
dans une formule. Le tableau pourra ainsi évoluer plus facilement.

Le chapitre suivant vous apprendra à utiliser des fonctions dans les formules pour
automatiser certaines tâches complexes.
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Chapitre

V
Utiliser des

fonctions dans les
formules

Niveau de difficulté : intermédiaire

Une fonction permet de réaliser automatiquement certaines tâches, ce qui simplifie
considérablement les calculs. Il est par exemple plus rapide d'utiliser la fonction
Moyenne() que d'écrire la formule arithmétique de calcul de la moyenne. Vous
apprendrez à éditer une fonction dans une formule, et verrez quelques unes des très
nombreuses fonctions existantes.

Pré-requis : savoir écrire des formules simples et connaître les styles de notation de
cellule

Temps d'apprentissage : 45 minutes

Partie A. A quoi ça sert ?

Une fonction est un ensemble d'instructions réalisant une certaine tâche et renvoyant
une valeur.

Pour illustrer l'intérêt d'utiliser une fonction à la place d'une formule arithmétique,
vous allez calculer la somme de 5 cellules de deux façons : avec une formule, puis
avec une fonction.



1. Méthode 1 : calcul d'une somme avec une formule
arithmétique

Dans une feuille de calcul, créez une série incrémentée de 1 à 5 dans les cellules A1 à
A5 (voir le chapitre « Saisir les données d'un tableau »), puis calculez en A6 par une
formule arithmétique, la somme des éléments de cette série.

Vous trouvez 15 (=1+2+3+4+5).

IMG. 51 : SÉRIE INCRÉMENTÉE ET CALCUL DE LA SOMME - SPÉCIFIQUE

2. Méthode 2 : calcul d'une somme avec une fonction

Recopiez maintenant la série de 1 à 5 en B1, sélectionnez la cellule B6, puis cliquez
sur le bouton somme automatique :

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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IMG. 53

La fonction SOMME apparaît avec, comme argument, la plage de cellules au-dessus.

Argument

Un argument est un paramètre (valeur, expression, cellule, plage de cellules, ou même
autre fonction) que l'on met entre parenthèses après le nom de la fonction. Quand la
fonction nécessite plusieurs arguments, ceux-ci sont séparés par des points-virgules, et
sont rentrés dans l'ordre prévu par la fonction.

Remarque

Remarquez que l'argument correspond à la plage notée B1:B5, et que la fonction
apparaît également dans la barre de formule.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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IMG. 55 : FONCTION SOMME - SPÉCIFIQUE CALC

Avec la touche Entrée, validez la formule contenant la fonction.

3. Comparaison

Quelle méthode préférez-vous pour calculer la somme (et encore, vous vous êtes limité
à l'addition de 5 cellules) ? Vous venez de comprendre l'intérêt des fonctions.

La fonction SOMME() a réalisé automatiquement une tâche répétitive comme ajouter
des cellules (rappelez-vous avoir dû répéter 5 fois la sélection d'une cellule pour
arriver au résultat par une formule arithmétique).

Partie B. Ecrire une formule avec une fonction

1. Ecrire une formule avec l'assistant de fonction

Comment connaître le nom d'une fonction ? Par exemple la fonction calculant la
moyenne s'appelle-t-elle MOY() ou MOYENNE() ? Et comment savoir le nombre
d'arguments ? En utilisant l'aide générale ou l'Assistant de fonction, vous êtes guidé
pas à pas. Voyons comment sur un exemple de calcul de moyenne.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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♦ Créez une série incrémentée de 1 à 5 à partir de la cellule C1 ou recopiez la série
B1:B5 créée précédemment. Sélectionnez la cellule C6.

♦ Activez l'assistant de fonction :

- Avec le menu Insertion > Fonction.
- Avec l'icône à gauche de la barre de formule (Voir ci-dessous).

IMG. 59

A ce stade, vous pouvez rechercher la fonction moyenne dans la liste des fonctions
proposées. Un petit texte décrit la fonction sélectionnée (« Calcule la moyenne d'un
échantillon »).

Pour trouver plus rapidement une fonction, vous pouvez taper une brève description
de ce que vous voulez faire, ou sélectionner une catégorie (ici « Statistiques ») pour
limiter votre recherche.

♦ Une fois la fonction moyenne() trouvée, cliquez sur >> Suivant pour passer à l'étape
suivante où vous entrerez les arguments de la fonctions dans la zone « Nombre 1 »

- soit en tapant l'adresse « C » + « 1 » + « : » + « C » + « 5 » au clavier,
- soit à la souris après avoir cliqué sur le bouton, sélectionné la plage C1 :C5 puis

validé (Voir image ci-dessous).

"Spécifique Excel"

Une image explicative "" vous est proposée en Annexes "Pour aller plus loin ..."

Nombre1 n'est pas UN nombre, mais le premier argument de la fonction moyenne, soit
la plage C1:C5 dont vous voulez calculer la moyenne.

Le résultat de la fonction est affiché aux deux endroits indiqués sur la figure suivante :
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"Spécifique Excel"

Une image explicative "Assistant de fonction" vous est proposée en Annexes "Pour aller plus loin
..."

♦ Validez.

Vous obtenez le résultat dans la feuille de calcul.

Si vous faites appel à l'assistant de fonction dans une cellule contenant déjà une
fonction, c'est l'onglet « Structure » qui s'affiche : il permet de vérifier la validité des
arguments entrés (correct : point bleu, incorrect : point rouge).

2. Ecrire une formule directement, sans l'assistant de
fonction

Bien sûr, l'assistant n'est pas obligatoire. Lorsque vous connaîtrez le nom de la
fonction, vous pourrez le taper directement dans la zone de saisie. La saisie d'un
argument consistera à sélectionner une cellule ou une plage de cellules au clavier ou à
la souris.

Démarche

Reprenons l'exemple de calcul de la moyenne en C6.
♦ Tapez =moyenne(

♦ Sélectionnez la plage C1:C5 à la souris,

♦ Fermez la parenthèse,

♦ Validez.

Le résultat s'affiche.

Conseil

Vous pouvez saisir le nom de la fonction en minuscules ou en majuscules.

Exercice n°37. Exercez-vous !

Calculez une moyenne à partir de la fonction SOMME() et la fonction NB().
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♦ Créez une série incrémentée de 1 à 5 à partir de la cellule D1 ou recopiez la
série C1:C5 créée précédemment.

♦ En D6, calculez la somme de la plage C1:C5 sans utiliser l'assistant de fonction.

♦ En D7, calculez le nombre de cellules contenant des nombres grâce à la
fonction NB().

♦ En D8, saisissez la formule faisant appel aux fonctions SOMME() et NB() pour le
calcul de la moyenne.

Partie C. Des fonctions par dizaines

Il existe des dizaines de fonctions dans des domaines très variés. N'hésitez pas à les
tester !

♦ Mathématiques et trigonométrie, statistiques, finances : ces fonctions réalisent un
calcul et renvoient une valeur numérique. Exemples :

- Mathématique et trigonométrie
RACINE(B2) pour la racine carrée de B2, PI() : fonction sans argument pour la
valeur de p, COS(B2) pour le cosinus de la cellule B2, ...

- Statistiques
MOYENNE(B1:B5), ECARTYPE(B1:B5) pour la moyenne et l'écart type de
l'échantillon défini dans la plage B1:B5.

- Finances
VPM(B1 ; B2 ; B3) pour calculer les remboursements périodiques d'un emprunt
défini en B3 pour une durée en B2 et un taux en B1.

De nombreuses fonctions, comme VPM() nécessitent plusieurs arguments. Ces
arguments doivent être séparés par des points-virgules, et entrés dans l'ordre
indiqué.

♦ Date et heure : ces fonctions renvoient une valeur de type date et heure.

- Exemple : AUJOURDHUI() est une fonction sans argument qui va lire la date
système dans la mémoire de l'ordinateur et la renvoyer.

♦ Texte : ces fonctions permettent de manipuler des textes.

- Exemples : MAJUSCULE(C1) renvoie le texte en C1 sous la forme de
majuscules, NBCAR(C1) renvoie le nombre de caractères du texte contenu en C1.

♦ Logique : ces fonctions établissent des comparaisons par des tests logiques, et
manipulent des expressions booléennes[Expression dont le résultat peut prendre 2
valeurs et 2 valeurs seulement : VRAI ou FAUX.].

- Exemple : SI(test logique ; valeur si vrai ; valeur si faux).
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Exercice n°38. Entrainez-vous !

Voici des petits exercices illustrant quelques unes des catégories de fonction. Trouvez
et écrivez la fonction dans la colonne D. Les arguments se trouvent dans les colonnes
A, B et C.

IMG. 62 : FONCTIONS MATHÉMATIQUES - SPÉCIFIQUE

IMG. 63 : FONCTIONS DATE ET HEURE - SPÉCIFIQUE

IMG. 64 : FONCTIONS TEXTES - SPÉCIFIQUE

IMG. 65 : FONCTIONS LOGIQUES - SPÉCIFIQUE
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1. Des fonctions un peu spéciales

Les fonctions volatiles

Fonctions renvoyant une valeur différente à chaque fois que la feuille est recalculée.

Ce sont des fonctions qui renvoient une valeur différente à chaque fois que la feuille
est recalculée. La fonction ALEA() sans argument, renvoie un nombre aléatoire
supérieur ou égal à zéro et strictement inférieur à 1. La fonction renvoie un résultat
différent chaque fois que la feuille de calcul est recalculée, soit en modifiant n'importe
quelle cellule, soit en appuyant sur la touche de fonction F9. On dit que la
fonction ALEA() est volatile.

La fonction ALEA() permet de générer des échantillons statistiques de distribution
connue (par exemple une distribution selon une loi normale).

Partie D. Evaluation

QUESTION N°1

Qu'est-ce qu'un argument de fonction ?

A 1) Le nom de la fonction.

B 2) La valeur renvoyée par la fonction.

C 3) Un paramètre de la fonction.

D 4) Une aide pour la fonction.
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QUESTION N°2

Que peut-on mettre comme argument de fonction ?

A 1) Une valeur constante.

B 2) Une cellule.

C 3) Une plage de cellules.

D 4) Une autre fonction.

E 5) Un point-virgule.

F 6) Un format.

G 7) Un opérateur.

QUESTION N°3

Parmi les affirmations suivantes, lesquelles sont vraies ?

A 1) Une fonction renvoie toujours au moins une valeur.

B 2) Les arguments d'une fonction donnée doivent être de même type.

C 3) Les arguments d'une fonction ne sont jamais optionnels.

D 4) Les arguments d'une fonction doivent être entrés dans l'ordre où ils sont définis dans la
fonction.

Exercice n°39. Enoncé 1

Calculez le cosinus d'un angle de 45° (/4), puis le sinus, puis enfin la tangente qui est
le rapport sinus/cosinus.

Exercice n°40. Enoncé 2

Jouez au LOTO.

Exercice n°41. Enoncé 3

Etude de cas.

Certaines banques donnent la possibilité de télécharger ses relevés de comptes à partir
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de leur site sécurisé pour les importer dans un tableur.

Téléchargez le fichier suivant (soit sous format .xls, soit sous format .ods)

et saisissez les fonctions qui vous permettront d'afficher :
♦ le total des débits et des crédits,

♦ le maximum et le minimum de débit,

♦ le nombre de débits supérieurs à 50 € ,

♦ la somme des débités supérieurs à 50 € ,

♦ l'indicateur « Créditeur » si la différence (Crédit-Débit) est supérieure ou égale à
zéro, « Débiteur » sinon.

Formatez enfin les valeurs monétaires en euros à 2 décimales.

IMG. 66 : ETUDE DE CAS - SPÉCIFIQUE
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A. Synthèse

Dans ce chapitre, vous avez vu en quoi les fonctions automatisent les tâches et vous
simplifient l'écriture de formules. De très nombreuses fonctions existent : l'aide et
l'assistant de fonction permettent d'éditer simplement ces fonctions. Des exemples pris
dans différentes catégories de fonctions vous ont montré un éventail de leurs
possibilités.

N'hésitez pas à aller plus loin et à explorer les dizaines d'autres fonctions !
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Chapitre

VI
Utiliser la recopie

des formules et les
différents types de

références

Niveau de difficulté : intermédiaire

Ce chapitre présente une des fonctionnalités les plus importantes des tableurs : la
recopie de formule. En effet, il est courant qu'une même formule soit utilisée un grand
nombre de fois au sein d'un même tableau, mais en portant sur des cellules différentes.
La technique de recopie va permettre de dupliquer une formule le nombre de fois
souhaité, tout en mettant automatiquement à jour les références. Elle utilise pour cela
la notion de référence relative. Vous verrez également comment combiner des
références relatives avec des références absolues ou mixtes pour arriver aux résultats
souhaités.

Pré-requis : savoir écrire des formules simples, connaître les styles de notation de
cellule, maîtriser le copier/coller de cellules

Temps d'apprentissage : 45 minutes



Partie A. Comprendre les notions de référence
relative et absolue

Vous jouez peut être aux échecs... Au départ, vous placez les pièces selon une position
absolue : une tour sur la ligne 1 et dans la colonne 1, une autre tour sur la ligne 1 dans
la colonne 8, un cavalier sur la ligne 1 colonne 2, etc.

Une fois la pièce placée, son déplacement est relatif à sa position : la tour se déplace
sur une ligne ou une colonne, le cavalier avance de 2 cases dans une direction et d'une
case dans la direction perpendiculaire, ...
Les règles de déplacement relatif sont indépendantes de la position de la pièce sur
l'échiquier. Il existe également une règle concernant la position absolue : lorsqu'un
pion atteint LA dernière ligne, il se transforme en reine.

IMG. 67

Par défaut, le tableur manipule les cellules d'une feuille selon des références relatives.
Dans les premiers chapitres, vous avez uniquement utilisé ce type de référence. Par
exemple, quand vous avez saisi la formule « =2*A1 », le tableur a interprété la
référence A1 relativement à la cellule courante. Si cette formule est en B1, vous
indiquez de multiplier par 2, non pas LA cellule A1, mais la cellule qui se trouve sur la
même ligne et dans la colonne juste à gauche.

Pour comprendre l'intérêt d'utiliser les références relatives ou absolues, prenons un
exemple.
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1. Formule avec référence relative

Exemple

Supposons que vous vouliez multiplier par 1,196 toutes les valeurs de la plage
de cellules A1:A5 pour obtenir un prix TTC à partir d'un prix HT. Vous n'avez
pas à saisir 5 formules : comme aux échecs, il suffit d'indiquer la règle (ou
formule « type ») qui sera valable quelle que soit la position de la cellule. Vous
recopierez ensuite cette formule.
♦ Dans une feuille de calcul, créez une série incrémentée de 1 à 5 dans les

cellules A1 à A5 (voir le chapitre « Saisir les données d'un tableau »).

♦ Saisissez en B1 la formule « type » : « =1,196*A1 » puis validez. Vous
pouvez saisir l'adresse « A1 » de la cellule, ou la sélectionner avec la souris
ou le clavier. Remarquez le résultat dans la cellule B1 et la formule dans la
barre de formule.

♦ Copiez le contenu de la cellule B1 et collez-le en B2:B5. Vous pouvez utiliser
la poignée de recopie (petit carré dans le coin inférieur droit de la cellule)
pour réaliser rapidement cette opération.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

"Spécifique Calc"

Recopie dans Calc

Cliquez sur le lien suivant afin de visualiser l'animation : Animation "Recopie dans
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap5/recopie_formule_OO.htm]

Ca y est ! C'est fini ! Le prix TTC est calculé pour les 5 cellules A1:A5.

♦ Sélectionnez la cellule B2. Remarquez la formule dans la barre de formule : la
référence A1 a été transformée en référence A2 lors de la recopie. C'est grâce à cette
astuce que le prix TTC de la 2ème ligne a pu être calculé.

En B1, dans la formule « 1,196*A1 », A1 représente la cellule qui est à gauche de B1.
A1 est une adresse relative à B1. En B2, la cellule à gauche de B2 est A2, et donc la
formule est « =1,196*A2 ».
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Les adresses relatives sont modifiées par la recopie. Ce principe très simple permet
d'automatiser les calculs : par exemple ici, répéter 5 fois la multiplication de la cellule
de gauche par 1,196.

Exercice n°42. Exercez-vous !

Quelques exercices de relativité ...

QUESTION N°1

Dans la cellule C4 se trouve la formule « =A2*B3 ». Que deviendra cette formule lorsqu'elle sera
recopiée en D5 ?

A 1) « =A2*B3 »

B 2) « =B2*C4 »

C 3) « =B3*C4 »

D 4) « =A3*B4 »

2. Formule avec référence absolue

Vous avez appris dans le chapitre « Ecrire des formules simples » qu'il vaut mieux
utiliser une référence à une cellule plutôt qu'une constante.

Par exemple, il est préférable de faire référence à une cellule contenant la TVA plutôt
que d'écrire une formule avec 1,196 comme constante de calcul du prix TTC. Si le
taux change, il suffit alors de modifier la cellule contenant la TVA pour que les prix
TTC soient automatiquement recalculés. Autrement, il faudrait rééditer toutes les
formules de calcul.
Nous allons modifier les formules de l'exemple précédent du calcul de prix TTC pour
éviter le recours à la constante 1,196.

Exemple

♦ Dans une feuille de calcul, créez ou reprenez la série incrémentée de 1 à 5
dans les cellules A1 à A5,

♦ En E1, saisissez le libellé : « TVA = »,

♦ En F1, entrez 19,6% (remarquez le format % pour diviser 19,6 par 100),

♦ Saisissez en B1 la formule « type » : « =(1+F1)*A1 » puis validez.

Le résultat est correct.

♦ Copiez cette formule en B2:B5.
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Attention

Le résultat est faux !

Exemple

Que s'est-il passé ?

Allez sur la cellule B2 et vérifiez la formule. Comme prévu, F1 étant une
référence relative, celle-ci s'est transformée en F2 sur la ligne du dessous.
Or, nous voulons que F1 reste F1 : nous voulons bloquer cette référence. Il faut
donc pouvoir indiquer au tableur que le taux de TVA ne se trouve qu'en F1, de
façon absolue.

Pour cela, il faut mettre le symbole $ devant le numéro de colonne et $ devant le
numéro de ligne, soit $F$1. Voici comment vous allez procéder :

♦ Sélectionnez B1 à nouveau et saisissez la formule : « =(1+$F$1)*A1 ».

Vous pouvez entrer cette formule selon une des méthodes vues au chapitre « Entrer
des formules simples». La méthode la plus rapide ... :
♦ Tapez « =(1+

♦ Sélectionnez la cellule F1, puis transformez la référence relative en référence
absolue en appuyant sur la touche de fonction F4 (dans Excel) ou sur les deux
touches MAJ+F4 (dans Calc) .

♦ Continuez l'édition de la formule : « )*A1 ».

♦ Validez.

Exemple
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♦ Recopiez cette formule en B2:B5.

C'est fini ! Et le résultat est correct. Vérifiez que la référence absolue $F$1 n'a
pas changé dans les formules recopiées, contrairement à la référence relative A1.

♦ Changez maintenant le taux de TVA à 5,5% : les prix sont recalculés sans
avoir à rééditer les formules.

♦ Saisissez à nouveau un taux de 19,6%.

3. Formule avec référence symbolique

Une alternative à la référence absolue est la référence symbolique, c'est-à-dire la
référence à une cellule nommée.

En nommant « TVA » la cellule F1, vous associez globalement ce nom au contenu de
F1. La formule de calcul du prix TTC sera alors : « =(1+TVA)*A1 » et la recopie ne
modifiera pas le nom « TVA », ce qui est le but recherché.

Explication

L'avantage de cette méthode est de rendre plus lisible les formules de calcul,
l'inconvénient est de devoir nommer la (les) cellule(s), ce qui prend un peu de temps.

Reportez-vous au chapitre « Ecrire des formules simples » pour revoir comment
définir un nom de cellule.

A vous de trouver la méthode qui vous convient pour définir une référence absolue :
avec des « $ » ou avec un nom.

Attention

Lorsque vous donnez un nom à une cellule ou une plage de cellules, ce nom est unique
pour tout le classeur.

Exercice n°43. Exercez-vous !

♦ Nommez « TVA » la cellule contenant le taux de TVA.

♦ En C1, saisissez la formule « =(1+TVA)*A1 » et recopiez-la en C2:C5.

Vérifiez le résultat.
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Au lieu de taper « TVA », vous pouvez insérer le nom prédéfini :

♦ Pour Excel
Par la touche de fonction F3.

♦ Pour Calc
Par le menu Insertion > Noms > Insérer.

4. Formule avec références mixtes

En partant des exemples précédents, vous obtenez la feuille suivante :

IMG. 68 : RÉSULTATS INTERMÉDIAIRES - SPÉCIFIQUE

Supposons que vous vouliez réaliser une copie de la plage C1:C5 en D1:D5 pour
obtenir les mêmes résultats. Vous devinez le problème : la référence A1 sera
transformée en B1, A2 en B2, etc.

Pour que le résultat du calcul soit identique, il faut bloquer la référence à la colonne A.
Par contre, le numéro de ligne doit pouvoir changer. Vous savez que le symbole « $ »
bloque le numéro de colonne ou de ligne qui suit : il suffit donc de saisir en C1, la
formule « =(1+TVA)*$A1 ».

Voila ! Avec une seule formule en C1 et deux recopies, le résultat est maintenant
correct.

Explication

Les références mixtes permettent de bloquer uniquement la ligne ou la colonne.

On les utilise moins souvent que les références relatives ou absolues, mais elles
peuvent s'avérer très utiles dans certaines circonstances (voir les exercices en fin
de chapitre).

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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"Spécifique Calc"

Conseil

La combinaison de touches MAJ+F4 est très utilisée : elle transforme successivement
une référence relative en référence absolue puis mixte puis de nouveau relative.

Exercice n°44. Exercez-vous !

♦ Sélectionnez la cellule C1.

♦ Modifiez la formule de la façon suivante : cliquez dans la barre de formule, juste
après la référence A1.

Pour Excel :
♦ Appuyez une fois sur F4 : la référence relative se transforme en référence absolue

$A$1.

♦ Appuyez une nouvelle fois sur F4 : la référence absolue se transforme en référence
mixte A$1 bloquant la ligne 1.

♦ Appuyez une nouvelle fois sur F4 : la référence mixte A$1 se transforme en
référence mixte $A1 bloquant la colonne A.

♦ Recopiez la formule de C1 en C2:C5.

♦ Recopiez la plage C1:C5 en D1:D5 en utilisant la poignée de recopie.

Pour Calc :
♦ Appuyez une fois sur MAJ+F4 : la référence relative se transforme en référence

absolue $A$1.

♦ Appuyez une nouvelle fois sur MAJ+F4 : la référence absolue se transforme en
référence mixte A$1 bloquant la ligne 1.

♦ Appuyez une nouvelle fois sur MAJ+F4 : la référence mixte A$1 se transforme en
référence mixte $A1 bloquant la colonne A.

♦ Recopiez la formule de C1 en C2:C5.

♦ Recopiez la plage C1:C5 en D1:D5 en utilisant la poignée de recopie.

5. Formule avec références externes

Une référence relative, absolue ou mixte peut être préfixée par le nom de la feuille si la
cellule se trouve dans une autre feuille (voire dans un autre classeur). Il s'agit alors
d'une référence externe.

92 MODULE B4 - REALISER DES DOCUMENTS DESTINES A ETRE IMPRIMES – TABLEURS



"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

"Spécifique Calc"

Exemple de référence externe dans Calc

« Feuil2.B2 »

Elle fait apparaître le nom de la feuille suivi du symbole « . » et de la référence
relative B2.

Pour entrer une référence externe dans une formule, sélectionnez la feuille puis la
cellule au moment de saisir sa référence. Puis, éventuellement, convertissez celle-ci en
référence absolue ou mixte.

A. Copier avec collage spécial

Des cellules à copier peuvent contenir des valeurs, des formats, des formules. Vous
pouvez donc vouloir copier certains éléments et en laisser d'autres.

Vous avez vu, dans le chapitre « Saisir les données d'un tableau », comment recopier
les formats et les données constantes avec le menu Edition.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

"Spécifique Calc"

Collage spécial dans Calc

Editer > Collage Spécial

Ce menu est également utilisé pour transformer les résultats de formules en valeurs
constantes.
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La copie des formules en valeurs constantes permet de sauvegarder des résultats de
calcul : à utiliser le moins possible puisque l'intérêt d'une feuille de calcul est
justement de calculer à partir de formules !

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Editer > Collage spécial, puis décochez « Insérer tout », « Formules » et « Formats »
et cochez le reste (voir figure ci-dessous).

IMG. 70 : COLLAGE SPÉCIAL DES VALEURS - SPÉCIFIQUE CALC
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B. Références après déplacement de cellules

Lorsque vous déplacez des cellules contenant des données ou des formules, vous vous
attendez à ce que les résultats affichés restent identiques. Deux cas peuvent se
présenter :
♦ Une formule fait référence à une cellule qui est déplacée : le tableur doit changer la

formule en fonction de la nouvelle référence.

- Déplacez le libellé et le taux de TVA de E1:F1 en A7:B7.
- Remarquez la modification de toutes les formules qui font référence au taux de

TVA en $F$1 : cette référence est transformée en $B$7. La cellule nommée
« TVA » est aussi maintenant associée à $B$7.

♦ Une formule est déplacée : ses références ne sont pas modifiées.

- Déplacez la plage D1:D5 en E1:E5.
- Remarquez qu'aucune référence de formule n'a été modifiée (même si ces

références sont relatives).

Partie B. Evaluation

Dans les exercices qui suivent, essayez de répondre sans l'ordinateur, puis vérifiez
votre réponse à l'aide du tableur.

Exercice n°45. Enoncé 1

Quelles formules mettrez-vous en B3 et B5 pour obtenir le résultat en C3 et C5 après
recopie ?

IMG. 71 : ENONCÉ 1 - SPÉCIFIQUE

Exercice n°46. Enoncé 2

Que devient la formule en B5 lorsque la plage E1:F1 est déplacée d'une ligne
au-dessous ?
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IMG. 72 : ENONCÉ 2 - SPÉCIFIQUE

Exercice n°47. Enoncé 3

Combien de références sont modifiées dans l'ensemble des formules du tableau lorsque
la plage A5:C5 est déplacée en A4:C4 ?

IMG. 73 : ENONCÉ 3 AVANT - SPÉCIFIQUE

IMG. 74 : ENONCÉ 3 APRÈS - SPÉCIFIQUE

Exercice n°48. Enoncé 4

A partir du tableau précédent, combien de formules seraient modifiées par l'insertion
d'une ligne à la ligne 1 ?

Question subsidiaire : combien de références seraient modifiées dans ces formules ?
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IMG. 75 : ENONCÉ 4 : - SPÉCIFIQUE

Exercice n°49. Enoncé 5

Trouvez la formule unique en B2 qui permet, après recopie, de calculer le produit
ligne-colonne pour obtenir une table de multiplication. Vous ne devez saisir qu'une
seule formule puis la recopier.

IMG. 76 : ENONCÉ 5 - SPÉCIFIQUE

Exercice n°50. Enoncé 6

Etude de cas.

Il s'agit de représenter les statistiques d'emplois salariés et non salariés dans une région
française entre 1998 et 2003 selon le modèle ci-dessous. Les totaux et pourcentages
sont calculés par des fonctions et formules utilisant des références relatives, mixtes ou
absolues.

Utiliser la recopie des formules et les différents types de références 97



IMG. 77 : ENONCÉ 6 - SPÉCIFIQUE

♦ Chargez le fichier :

♦ Tableau 1, cellule B11 : entrez la fonction qui permet de calculer le total des
emplois sur l'année 1998.

Recopiez cette formule pour les autres années.

♦ Tableau 1, cellule H7 : entrez la fonction qui permet de calculer le total des emplois
pour l'agriculture sur les années 1998-2003.

Recopiez cette formule sur l'ensemble des secteurs d'activité.

♦ Tableau 2 : copiez la plage de cellules B6:G11 en B15. En B16, remplacez la valeur
par une formule calculant le pourcentage d'emplois dans l'agriculture en 1998.

Recopiez cette formule pour l'ensemble des années et l'ensemble des secteurs
d'activité.

♦ Tableau 3 : copiez la plage B15:G15 en B24 et la plage B20 :G20 en B25. Modifiez
la formule en B25 pour calculer le pourcentage d'emplois en 1998 par rapport à
2003.

Recopiez cette formule pour les autres années.
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C. Synthèse

Ce chapitre vous a montré comment l'utilisation des références relatives, absolues,
mixtes et symboliques permet de simplifier et d'automatiser les calculs par des
recopies. Il s'agit d'une des fonctionnalités les plus importantes du tableur : grâce à
elle, vous ne rentrez que les quelques formules nécessaires aux calculs. Vous recopiez
ensuite ces formules « types » pour étendre les calculs à l'ensemble des données, et le
tour est joué !

La compréhension de ce chapitre est fondamentale pour la suite. N'hésitez pas à refaire
les exercices s'ils vous semblent encore un peu compliqués.
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Chapitre

VII
Bien présenter un

tableau

Niveau de difficulté : intermédiaire

Comme pour un texte que vous structurez et mettez en forme pour rendre le document
plus lisible, un tableau doit être simple, clair et évolutif. Ce chapitre vous apprendra à
définir les zones de votre tableau (titre, données, calculs, résultats) et à utiliser les
différents formats de présentation pour identifier ces zones et les rendre
immédiatement identifiables.

Pré-requis : connaître les fonctions de base du tableur : données, formules,
références. Savoir entrer une formule et formater les données

Temps d'apprentissage : 60 minutes



A. Définition des objectifs d'un tableau

Il est important de bien définir les objectifs d'un tableau avant de passer à son
élaboration.
♦ A quoi est-il destiné ?

♦ Par qui sera-t-il mis à jour ?

♦ Par qui sera-t-il lu ?

♦ Quels sont les résultats les plus importants, ceux qui doivent être mis en évidence ?

Il faut également veiller à respecter trois règles primordiales :
♦ Un tableau doit être simple : les manipulations doivent être limitées au minimum, les

déplacements du pointeur également, la saisie des données doit être la plus simple
possible.

♦ Un tableau doit être clair : il ne faut pas négliger d'introduire des commentaires et
des explications pour faciliter son utilisation.

♦ Un tableau doit être évolutif : il faut prévoir son évolution possible, pour qu'il soit
aisément modifiable.

B. Définition des zones et des feuilles d'un tableau

Pour répondre aux 3 critères de base définis précédemment, un tableau peut être
organisé en 3 zones distinctes.
♦ Zone d'identification : positionnée en haut à gauche du tableau pour être

éventuellement visible sur le premier écran, elle donne divers renseignements
facilitant l'exploitation du tableau :

- Le nom du projet,
- Le nom de l'auteur,
- Le titre,
- Une explication globale sur le rôle du tableau.

♦ Zone de données : placée immédiatement après l'identification, en haut du tableau,
elle permet l'introduction des données.

♦ Zone de calcul : elle contient les formules qui permettent d'arriver aux résultats, les
titres de chaque étape de calcul et les commentaires éventuels. Les résultats finaux
qui répondent aux objectifs du tableau seront clairement mis en évidence.
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C. Mise en page et présentation du tableau

Pour améliorer la clarté de la présentation, vous devriez également appliquer les
quelques règles suivantes :
♦ Définir l'alignement des titres, qui doivent être clairs et explicites.

♦ Définir le format des plages de cellules devant contenir : les titres, les chiffres, les
commentaires.

♦ Définir la largeur des colonnes et la hauteur des lignes en fonction des chiffres, de la
taille du tableau, des possibilités de l'imprimante, etc.

Le menu Format permet de réaliser ces opérations. Vous avez déjà vu comment
modifier la largeur d'une colonne pour l'adapter à son contenu et comment appliquer
un format en fonction du type de données qui se trouvent dans une plage de cellules.

Les autres options du menu Format vous permettront de mettre en évidence les
différentes zones de votre tableau en rajoutant des bordures, des couleurs, des
arrière-plans, et en modifiant la police de caractères et les alignements de textes.
Enfin, la mise en forme conditionnelle permettra d'appliquer automatiquement un
format en fonction du contenu d'une cellule.
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Partie A. Une étude de cas

Nous allons illustrer l'importance de la présentation d'un tableau sur un exemple : la
simulation d'emprunt pour l'achat de la maison de vos rêves.

IMG. 78

Nous allons calculer les mensualités à verser pour rembourser un emprunt d'un
montant Vo = 100 000 € à un taux annuel i = 3,5%, sur une durée D = 12 ans, selon un
remboursement à mensualités constantes.

Pour calculer le montant des mensualités, il faut réaliser 2 calculs :
♦ Calculer le taux t mensuel équivalent à i = 3,50 % annuel, puisque les

remboursements se font au mois, et non à l'année :

IMG. 79 : TAUX MENSUEL ÉQUIVALENT - SPÉCIFIQUE

♦ Utiliser ensuite le taux mensuel équivalent t pour calculer le montant de chacune des
n (n = 144) mensualités M :

104 MODULE B4 - REALISER DES DOCUMENTS DESTINES A ETRE IMPRIMES – TABLEURS



IMG. 80 : CALCUL DE LA MENSUALITÉ M - SPÉCIFIQUE

Les formules paraissent compliquées, mais rassurez-vous, il suffit de télécharger le
fichier suivant pour démarrer l'exercice :

Chaque étape de l'étude de cas commence avec une feuille indiquée en début
d'exercice. Si vous ne pouvez pas réaliser une étape, regardez le corrigé sur la feuille
suivante.

S'il s'agit simplement de calculer le montant des mensualités, vous pourriez réaliser le
tableau suivant :

IMG. 81 : FEUILLE « EMPRUNT(1) » - SPÉCIFIQUE

Vous avez la réponse : 848,834 € . Maintenant, posez-vous les questions suivantes :
♦ A qui ce tableau est-il destiné ?

Si c'est simplement un calcul ponctuel pour vous, il remplit sa fonction, mais vous
auriez probablement fait aussi bien avec une calculatrice.

♦ Le tableau est-il clair ?

Non : pas de libellés ni de commentaires. On ne sait pas ce qu'il réalise, où sont les
données et où se trouvent les résultats.
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♦ Le tableau est-il évolutif ?

Non : le montant V0 de l'emprunt et le taux annuel i peuvent être modifiés, mais la
durée D n'apparaît pas comme variable. Vous ne pourrez sans doute pas reprendre ce
tableau pour une utilisation ultérieure.

1. Zone d'identification

Nous allons insérer en haut à gauche du tableau, une zone indiquant le titre et l'objectif
du tableau.

Feuille de départ : « Emprunt(1) » .

Conseil

Pour insérer une ligne, cliquez sur l'en-tête de ligne 1 pour sélectionner toute la ligne,
puis clic-droit et menu contextuel.

IMG. 82 : FEUILLE « EMPRUNT(2) » - SPÉCIFIQUE

C'est déjà plus clair !

Et pour retrouver ce tableau ultérieurement, sauvegardons-le sous un nom significatif,
par exemple : « Remboursement_emprunt » (avec l'extension associée au tableur).
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2. Zone de données

Occupons-nous maintenant des données : la date d'emprunt, le montant V0 de
l'emprunt, le taux annuel i.

Il nous manque la durée D en années pour pouvoir réaliser des simulations complètes.
N'oublions pas non plus de rajouter des libellés pour savoir à quoi correspondent les
cellules.
N'hésitons pas à « aérer » le tableau en laissant des espaces libres entre les différentes
zones du tableau !

Feuille de départ : « Emprunt(2) ».

IMG. 83 : FEUILLE « EMPRUNT(3) » - SPÉCIFIQUE

♦ Déplacez la plage A2:A6 en B3 :B7 puis les cellules B6:B7 contenant les formules
en B9:B10 (vous vous en occuperez plus tard).

♦ Rajoutez les libellés :

- A3 : « Date d'emprunt »
- A4 : « Montant : »
- A5 : « Taux annuel : »
- A6 : « Durée : »

♦ Rajoutez la durée 12 en B6.

♦ Certains libellés dépassent la largeur de la colonne A : il va falloir élargir cette
colonne.

♦ Glissez avec la souris, la barre de séparation des colonnes A et B dans l'en-tête de
colonne.
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♦ Alignez à droite ces libellés. Comme il s'agit d'un format d'affichage, vous devinez
peut-être déjà comment procéder :

- Sélectionnez la plage A3:A8.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

"Spécifique Calc"

Alignement à droite dans Calc

♦ Menu Format > Cellules > Alignement - Horizontal : A droite.

♦ Ou cliquez sur l'icône de la barre d'outils :

IMG. 85

♦ Il faut maintenant formater les nombres en fonction de ce qu'ils représentent (voir le
chapitre « Saisir les données d'un tableau : contenu et format », puis rajouter le
libellé « ans » pour la durée :

Feuille de départ : « Emprunt(3) »
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IMG. 86 : FEUILLE « EMPRUNT(4) - SPÉCIFIQUE

Les données sont maintenant parfaitement identifiées. Nous allons pouvoir passer aux
calculs.

3. Zone de calcul

Feuille de départ : « Emprunt(4) ».
Calcul et mise en forme

Pour calculer le montant des mensualités, il faut ... :
1. calculer le nombre de mensualités à partir de la durée de l'emprunt en années, en B8

;

2. calculer le taux équivalent mensuel t, en B9 ;

3. introduire la formule du calcul des mensualités, en B10.

Pour bien identifier chacun de ces 3 calculs, nous allons rajouter un libellé sur la ligne
correspondante à partir de la cellule A8, puis saisir les 3 formules de calcul, et enfin
formater les résultats numériques.

Vous devriez obtenir le résultat suivant :

IMG. 87 : ZONE DE CALCUL - SPÉCIFIQUE
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Conseil

Rappelez-vous de la priorité des opérateurs et des exercices réalisés dans le chapitre «
Ecrire des formules simples ».

Attention

Pensez à modifier la formule de calcul des mensualités en remplaçant 144 par la
référence à B8.

Insertion d’un commentaire

Toujours dans un esprit de clarté, nous allons rajouter un commentaire dans cette zone
pour préciser à l'utilisateur qu'il s'agit d'un taux mensuel équivalent et non
proportionnel (taux annuel divisé par 12).

Explication

L'utilisation de commentaires permet de faciliter la lecture et la révision de la feuille
de calcul par vous ou par un autre utilisateur.

♦ Pour insérer un commentaire en B9, sélectionnez cette cellule, puis ... :

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

"Spécifique Calc"

nsertion d'un commentaire dans Calc
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Menu Insertion > Note, puis entrez le commentaire : « Taux équivalent et non
proportionnel ! ».

IMG. 89 : INSERTION DE COMMENTAIRE - SPÉCIFIQUE CALC

Le nom de l'utilisateur insérant le commentaire est automatiquement rajouté.
Remarquez le petit carré rouge en haut à droite de la cellule, signalant la
présence d'un commentaire.

Conseil

Pour visualiser le commentaire, positionnez le curseur de la souris sur la cellule
comportant l'indication de commentaire.
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4. Mise en page et présentation du tableau

Il faut maintenant améliorer la présentation du tableau pour en faire ressortir les
différentes parties. Pour cela, nous allons jouer sur ... :
♦ l'alignement des libellés dans les cellules et la fusion de cellule,

♦ les formats :

- de contenu : nombre (déjà vu), police de caractère, taille, couleur, ...
- de contenant : bordure, trame (motif), arrière-plan, ...

♦ les largeurs de colonnes et les hauteurs de lignes,

♦ éventuellement, la mise en forme conditionnelle, la fonction du contenu d'une
cellule.

La présentation qui suit illustre ces trois aspects :

IMG. 90 : SUGGESTION DE PRÉSENTATION - SPÉCIFIQUE

Remarquez la zone d'identification en caractères rouges et la zone de données en fond
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jaune. Le résultat est parfaitement identifié et les calculs intermédiaires sont sur fond
gris.

Bien sûr, les goûts et les couleurs, ça ne se discute pas...

N'hésitez pas à faire preuve de créativité : encore une fois, l'essentiel est de rendre
votre tableau clair et lisible.

IMG. 91

Nous allons successivement explorer les différents onglets du menu Format de cellule.

♦ Feuille de départ : « Emprunt(5) ».

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

IMG. 93 : ONGLETS DU MENU FORMAT DE CELLULE - SPÉCIFIQUE CALC
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Alignement des données et fusion de cellules

Vous avez vu précédemment comment aligner un libellé à droite, en particulier par la
barre d'outils « Format ». Le titre du tableau a un alignement « centré », mais pas
uniquement sur la cellule A1. En effet, les 3 cellules A1, B1, C1 ont été fusionnées
pour permettre de centrer le titre sur ces trois cellules.
♦ Pour fusionner les trois cellules et centrer le texte, sélectionnez la plage A1:C1 puis

...,

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

"Spécifique Calc"

Alignement des données et fusion de cellules dans Calc

♦ Menu Format > Fusionner les cellules.

L'icône « Fusionner les cellules » de la barre d'outils « Format » réalise
directement cette fusion.

IMG. 95

♦ Menu Format > Cellules - Alignement - Alignement du texte - Horizontal :
Centré.

Remarque
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Les 3 cellules A1:C1 ne font désormais plus qu'une, de référence A1.

Le titre ne peut pas s'afficher complètement dans cette cellule fusionnée.
L'alignement étant centré, le titre déborde à gauche et à droite.

Attention

La fusion ne conserve que le contenu de la cellule supérieure gauche de la sélection.

Evitez de fusionner des cellules non vides avec cette cellule : leur contenu
disparaitrait.

♦ Pour afficher la totalité du titre, plusieurs solutions :

- Elargir la colonne A (vous savez comment).
- Ajuster le contenu à la cellule :

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

"Spécifique Calc"

Ajuster le contenu à la cellule dans Calc

Format > Cellules - Alignement - Propriétés - cocher la case « Ajuster ».

Remarque

La taille des caractères diminue pour afficher la totalité du titre.

♦ Renvoyer à la ligne automatiquement.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

"Spécifique Calc"
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Renvoi àla ligne automatique dans Calc

Format > Cellules - Alignement - Propriétés - cocher la case « Renvoi à la ligne
automatique ».

La hauteur de ligne s'ajuste automatiquement pour afficher la totalité du titre.

Les formats de contenu : nombre, police, taille, couleur, …

Vous avez déjà vu les formats de nombre : ils permettent d'afficher les nombres en
fonction de ce qu'ils représentent.
♦ Pour modifier la police et la taille de caractère ou rajouter des effets (couleurs,

attributs, ...), vous pouvez utiliser l'onglet « Polices » et « Effets de caractères ».

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

"Spécifique Calc"

Onglets "Police" et "Effets de caractère" dans Calc

Avec l'onglet « Police », vous pouvez changer la police, le style (normal, italique,
gras, etc.) et la taille. Une large zone affiche un aperçu des options choisies.

L'onglet « Effets de caractères » permet d'enrichir l'affichage par différents
effets de soulignement, de barré, de couleur, de relief. Un aperçu est également
disponible.

Conseil

La plupart de ces options sont également disponibles dans la barre d'outils « Format »
pour un accès plus rapide.

Les formats de contenant : bordures

Remarque

Feuille de départ : insérez une nouvelle feuille pour faire vos essais de bordures.
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"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Les formats de contenant : motif (trame) / arrière-plan

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Par l'onglet « Arrière-plan », vous pouvez définir une couleur pour l'intérieur d'une
plage de cellules. Si la couleur des caractères est foncée, choisissez une couleur claire
pour l'intérieur, et inversement. N'abusez pas des couleurs : les impressions se font en
général en noir et blanc !

L'application de couleur et de motif est très simple : choisissez, pour l'intérieur, la
couleur dans la palette de couleurs.

IMG. 99 : APPLICATION DE MOTIFS - SPÉCIFIQUE CALC
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Sélectionnez une zone vierge d'une feuille de calcul et expérimentez !

Pour modifier rapidement la couleur de l'intérieur d'une plage de cellules, passez par
la barre d'outils « Format » sur l'icône « Couleur d'arrière-plan ».

IMG. 100 : ICÔNE « COULEUR D’ARRIÈRE-PLAN » - SPÉCIFIQUE CALC

♦ Retour vers l'étude de cas.

♦ Feuille de départ : « Emprunt(9) ».

♦ Appliquez maintenant ce que vous venez de voir pour obtenir la présentation
suivante :
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IMG. 101 : FEUILLE « EMPRUNT(10) » - SPÉCIFIQUE

Tableau d'arrivée : feuille « Emprunt(10) »

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

"Spécifique Calc"
Tableau final dans Calc

Cliquez sur le lien suivant afin de visualiser l'animation : Animation "Tableau final
dans
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap6/animation_tableau_final_OO.htm]

La mise en forme conditionnelle

Il est souvent utile d'adapter la mise en forme d'une cellule à son contenu, par exemple
ici, pour mettre en évidence en rouge une mensualité trop élevée (900 € ).

♦ Feuille de départ : « Emprunt(10) »
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"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Il faut définir préalablement un style de cellule à appliquer lorsque la condition est
vraie. La notion de style est analogue à celle que l'on retrouve dans toutes les
applications de la suite bureautique OpenOffice.org.

Un style de cellule regroupe l'ensemble des propriétés d'une cellule : formats,
alignement, bordures, arrière-plan ...

♦ Vérifiez que la fenêtre « Styles et formatage » soit visible (touche de fonction F11,
ou Format > Styles et formatage).

♦ Cliquez dans une cellule vide et activez le menu contextuel « Formater les cellules
».

♦ Dans l'onglet « Police », choisissez le style « Gras ».

♦ Dans l'onglet « Effets de caractères », définissez la couleur de police « Rouge clair
».

♦ Dans la fenêtre « Styles et formatage », cliquez sur l'icône « Nouveau style à partir
de la sélection » (2ème icône en haut à droite). Saisissez le nom du nouveau style,
pas exemple « Trop élevé ».
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IMG. 103 : STYLES ET FORMATAGE - SPÉCIFIQUE CALC

Vous pouvez maintenant définir le formatage conditionnel :
♦ Sélectionnez la cellule B10 affichant le résultat des mensualités.

♦ Menu Format > Formatage conditionnel.

♦ Définissez la condition : « Valeur est » - « supérieure ou égale à » 900.

♦ Choisissez le style de cellule à utiliser lorsque la condition est vraie : « Trop élevé ».

♦ Validez.

IMG. 104 : MISE EN FORME CONDITIONNELLE - SPÉCIFIQUE CALC
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♦ Testez par exemple en diminuant la durée de l'emprunt à 10 ans.

Exercice n°51. Exercez-vous !

A vous de continuer !

Feuille de départ : « Emprunt(7) ».

♦ Fusionnez les cellules B3:C3, puis B4:C4, puis B5:C5 et enfin, B9:C9 puis
B10:C10.

♦ Pour Excel
Réalisez la fusion pour B3 :C3, puis utilisez la touche de fonction F4 pour répéter
l'opération.

Ne fusionnez pas B6:C6 parce que la cellule C6 n'est pas vide. Même chose pour
B8:C8.

Vous pouvez, toujours dans l'onglet alignement, changer l'orientation du texte.
Attention encore à la lisibilité !

Vous devriez obtenir un résultat analogue à celui-ci (feuille « Emprunt(8) »)

IMG. 105 : FEUILLE « EMPRUNT(8) » - SPÉCIFIQUE
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Exercice n°52. Exercez-vous !

A vous de jouer !

Feuille de départ : « Emprunt(8) »

♦ Formatez le titre du tableau. Essayez ces différentes options et observez les résultats.
Par exemple, police taille 12, style gras, couleur rouge.

♦ Mettez en évidence le résultat du calcul en A10:B10. Par exemple, une police taille
12, style « gras », couleur bleu. Essayez de passer par la barre d'outils « Format ».

Vous devriez arriver au résultat suivant (feuille « Emprunt(9) ») :

IMG. 106 : FEUILLE « EMPRUNT(9) - SPÉCIFIQUE

Exercice n°53. Exercez-vous ! (Excel)

Pour réaliser les bordures suivantes :
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IMG. 107 : BORDURES EXTÉRIEURES (NOIR) ET INTÉRIEURES (ROUGE POINTILLÉ) - SPÉCIFIQUE

♦ Sélectionnez une zone d'au moins 2x2 cellules (par exemple 3 lignes, 3 colonnes).

♦ Sélectionnez le style de ligne : épais, noir.

♦ Cliquez sur « Contour ».

♦ Sélectionnez un nouveau style de ligne : épais, pointillé, rouge.

♦ Cliquez sur « Intérieur ».

En cliquant successivement sur les bordures, les formats sont d'abord définis, puis
annulés.

Et voici le résultat dans la feuille de calcul :

IMG. 108 : APPLICATION DES BORDURES - SPÉCIFIQUE

Amusez-vous et n'hésitez pas à expérimenter d'autres types de bordures !

Pour modifier rapidement les bordures d'une plage de cellules, passez par la barre
d'outils « Format » sur l'icône « Bordures »
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IMG. 109 : ICÔNE « BORDURES » - SPÉCIFIQUE

Exercice n°54. Exercez-vous ! (Calc)

Pour réaliser les bordures suivantes :

IMG. 110 : BORDURES EXTÉRIEURES (NOIR) ET INTÉRIEURES (ROUGE POINTILLÉ) - SPÉCIFIQUE

♦ Sélectionnez une zone d'au moins 2x2 cellules (par exemple 3 lignes, 3 colonnes).

♦ Sélectionnez le style de ligne : double trait, noir, 2,60pt.
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♦ Cliquez sur le bouton « Bordure extérieure » : les flèches indiquent les bordures
sélectionnées qui seront modifiées par le style de ligne.

♦ Cliquez au centre de l'aperçu. La souris pointe l'intersection des 2 bordures
horizontales et verticales : ces 2 bordures sont donc sélectionnées et apparaissent
avec le style de ligne précédemment défini.

Si vous cliquez sur une des bordures en dehors de leur intersection, seule la bordure
correspondante est sélectionnée.

♦ Sélectionnez le style de ligne plein, 2,50pt, rouge clair : les bordures sélectionnées
changent de style.

Pour tracer les bordures intérieures verticales et horizontales, il faut se repérer
avec les petits triangles gris de l'aperçu.

En cliquant successivement sur les bordures, les formats sont d'abord définis, puis
annulés, et enfin les bordures sont supprimées.

Si vous cliquez au centre de l'un des petits carrés (aidez-vous des petits triangles gris),
vous allez créer une bien jolie figure avec des bordures obliques.

Amusez-vous et n'hésitez pas à les faire apparaître et disparaître !

Et voici le résultat dans la feuille de calcul :

IMG. 111 : APPLICATION DES BORDURES - SPÉCIFIQUE

et une petite animation pour bien comprendre.

Cliquez sur le lien suivant afin de visualiser l'animation : Animation "Création de
bordures dans
OpenOffice" [http://projet.c2imes.org/V2/tutorielsB5/Chap6/animation_bordures_OO.htm]

Il existe d'autres options pour espacer les bordures du contenu, ou rajouter un effet
d'ombre pour créer un relief.

Pour modifier rapidement les bordures d'une plage de cellules, passez par la barre
d'outils « Format » sur l'icône « Bordure ».
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IMG. 112 : ICÔNE « BORDURES » - SPÉCIFIQUE

Partie B. Evaluation

QUESTION N°1

Lorsque je fusionne les 4 cellules de la plage A1:B2, quelle est la référence des cellules
fusionnées ?

A 1) A1

B 2) A2

C 3) B1

D 4) B2
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Exercice n°55. Exercice 1

Statistiques d'abonnés à la bibliothèque municipale de Cédeuzy.

Vous avez créé un tableau montrant l'évolution du nombre d'abonnés et vous voudriez
le présenter pour le rapport annuel d'activités.

IMG. 113 : TABLEAU 1 - SPÉCIFIQUE

Formatez le tableau de départ pour mettre en valeur les différentes zones du tableau, à
la manière du tableau suivant :

IMG. 114 : TABLEAU 1 MIS EN FORME - SPÉCIFIQUE
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Définition des objectifs :

Ce tableau sera inséré dans un rapport d'activité. Il est important d'en soigner la
présentation et de mettre clairement en évidence l'évolution du nombre d'abonnés. Il
devra facilement resservir pour l'année suivante par une simple copie et la
modification des données.

Définition des zones :
♦ La feuille porte le nom de la bibliothèque et l'année de référence. Le titre du tableau

indique clairement son rôle : montrer l'évolution du nombre d'abonnés.

♦ La zone de données contient les libellés lignes et colonnes et les nombres à saisir à
chaque trimestre.

♦ La zone de calcul et de résultat contient le total et le pourcentage d'évolution.

Mise en page et présentation :
♦ Le nom de la bibliothèque est en taille 16 et de couleur bleue. La présentation

respecte la charte graphique de la municipalité. Nous pourrions insérer également à
ce niveau le logo de la ville de Cédeuzy.

♦ Le titre du tableau est centré sur ses 5 colonnes, en caractères de taille 12.

♦ Le libellé de chaque colonne est bien mis en évidence par un style blanc, italique,
gras, taille 9, sur fond bleu indigo.

♦ Le libellé de chaque ligne est en caractères indigo, gras sur fond bleu clair. La
largeur de la colonne A est adaptée à la longueur du plus long libellé.

♦ La zone de donnée est identifiée en bleu clair : l'utilisateur sait qu'il devra les saisir
dans cette zone.

♦ La zone de calcul et de résultat est entourée par une bordure plus large. La mise en
forme conditionnelle colorie en vert les pourcentages positifs et en rouge les
négatifs.

Exercice n°56. Exercice 2

Gestion d'un restaurant universitaire.

Voici un petit tableau récapitulant les repas servis et les recettes du restaurant
universitaire de CEDEUZY. Les données et les formules sont déjà saisies.

Fichier de départ :
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IMG. 115 : TABLEAU 2 - SPÉCIFIQUE

A vous de mettre en forme le tableau 2 pour bien mettre en valeur ses parties
importantes. N'hésitez pas à faire preuve de créativité, ... tout en restant clair et lisible !
Et pour aller plus vite, essayez de n'utiliser que la barre d'outils « Format » (c'est
possible !).

D. Synthèse

Ce chapitre vous a montré combien il est important de rendre un tableau simple, clair
et évolutif.
♦ Veillez, dans tout tableau, à présenter une partie en-tête pour expliquer l'objectif du

tableau : sans ces informations élémentaires, le tableau final ne présentera aucune
utilité pour celui qui le lira !

♦ Enrichissez de façon générale tout tableau avec des libellés clairs (étiquette, titres...)
qui facilitent la compréhension ou tableau par l'utilisateur final.

♦ Distinguez les informations "fixes" (libellés, étiquettes, titres...) des informations
variables (données saisies ou calculées) !

♦ Isolez dans des cellules distinctes toutes les informations qui sont amenées à évoluer
à l'occasion d'une nouvelle utilisation du tableau.
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Chapitre

VIII
Tri et filtres

Niveau de difficulté : intermédiaire

En plus de leurs fonctions de calcul, les tableurs disposent de quelques outils
habituellement réservés aux systèmes de gestion de bases de données[Ensemble de
programmes qui assurent la gestion et l'accès à une ou plusieurs bases de données.
Pour simplifier, cet ensemble est appelé SGBD.]. Parmi ces outils, on peut citer les tris
et les filtres qui permettent d'organiser et de rechercher des données dans un tableau.
Ce chapitre vous apprendra à les utiliser en passant par la notion de liste.

Pré-requis :

♦ Connaître les fonctions de base du tableur : données, formules, références.

♦ Savoir entrer une formule et formater les données.

Temps d'apprentissage : 30 minutes

A. Notion de base de données et de liste

Base de données

Une base de données est un ensemble structuré et organisé permettant le stockage de
grandes quantités d'informations afin d'en faciliter l'exploitation (ajout, mise à jour,
recherche de données) (définition de Wikipédia).

Microsoft Access et OpenOffice.org Base sont les Systèmes de Gestion de Bases
de Données SGBD de Microsoft et d'OpenOffice respectivement.



Une base de données est généralement formée de tables constituées de lignes (ou
enregistrements) et de colonnes (ou champs). Par exemple, une base de données d'une
université gère toutes les informations concernant les étudiants. Elle peut contenir de
nombreuses tables (identité, inscriptions, notes, ...) contenant chacune des dizaines de
milliers de lignes (une ligne par étudiant) et des dizaines de colonnes (par exemple une
colonne par résultat d’UE pour la table « notes »).

Un tableur permet de traiter un tableau comme une table simplifiée appelée « Liste ».

Liste

Une liste est une table simplifiée, avec des colonnes et des lignes. Chaque colonne
comporte un titre et ne doit contenir qu'un seul type d'informations, par exemple l'âge.

Attention

Un tableur n'est pas un gestionnaire de base de données. Si vous utilisez régulièrement
les outils de tri et de filtrage du tableur, il faut envisager de passer sur un logiciel de
gestion de base de données.

La figure suivante montre un exemple de liste à 7 colonnes issu d'une base de données
d'adhérents à un club sportif. La dernière colonne représente l'indice de masse
corporelle IMC calculée à partir de la formule IMC = Poids/Taille² :
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IMG. 116 : EXEMPLE DE LISTE - SPÉCIFIQUE

Le tableur définit une liste dès qu'il identifie un tableau dont la première ligne peut être
interprétée comme les libellés de colonnes. Il est donc important de donner un titre à
ses colonnes (voir le chapitre « Bien présenter un tableau »).

Un tableur n'a évidemment pas les fonctionnalités d'un SGBD, mais il permet de
réaliser certaines opérations pour organiser et rechercher les données dans un tableau.
L'utilisation des outils de liste ou de bases de données intégrés au tableur va nous
permettre d'effectuer :
♦ des tris pour classer les lignes par ordre croissant ou décroissant d'une propriété,

♦ des filtres pour rechercher dans la liste, sélectionner ou extraire des lignes.

Ces outils sont tous accessibles par le menu Données du tableur.
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Partie A. Trier une liste

Le tri consiste à classer les données d'une liste par ordre croissant ou décroissant selon
une ou plusieurs clé(s) de tri[Clé de tri : Colonne d'une liste sur laquelle porte un tri.].

Ne confondez par le tri et la sélection.

♦ Le titre
Le tri suppose une relation d'ordre (croissant ou décroissant), par exemple du plus
jeune au plus âgé.

♦ La sélection
La sélection n'établit pas d'ordre mais affiche les données répondant à certains
critères, par exemple les individus de plus de 25 ans.

Les exercices s'appuient sur l'exemple de liste précédent que vous pouvez télécharger
ici :

1. Trier une liste sur une seule clé

Pour trier les données :
♦ Commencez par sélectionner une cellule de la liste : il n'est pas nécessaire de

sélectionner l'intégralité du tableau.

♦ Choisissez le menu Données > Trier : le tableur identifie la liste et détermine son
étendue en excluant la ligne de titres. Remarquez la sélection automatique qu'il
opère.

♦ La boîte de dialogue qui s'affiche vous propose une ou plusieurs clés de tri, et l'ordre
de classement.

♦ La liste contient une ligne de titres qui a été détectée et exclue du tri.

♦ Triez par « Sport » (clé de tri), croissant.

Remarque

Pour les textes, le tri normal se base sur l'ordre alphabétique de la première lettre du
libellé. Si la première lettre est identique, c'est la seconde lettre qui compte, etc.

Pour les jours de la semaine ou les mois de l'année, il faut définir un ordre
différent de l'ordre alphabétique dans les options de tri (Mercredi < Jeudi).

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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IMG. 118 : TRI AVEC CALC - SPÉCIFIQUE CALC

L'onglet « Options » vous permet de changer l'ordre de tri utilisateur (normal ou jour
ou mois), ainsi que la prise en compte de la casse (majuscule ou minuscule différents).
Remarquez qu'OO Calc a détecté la présence d'une ligne de titres de colonnes
(étiquettes de colonne).

Si vous décochez la case « La plage contient des étiquettes de colonne », la clé de tri
sera remplacée par le numéro de colonnes et le titre sera trié en même temps que la
liste.

Pour le tri de lignes, laissez cochée la case « De haut en bas ».
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IMG. 119 : OPTIONS DE TRI AVEC CALC - SPÉCIFIQUE CALC

♦ Validez.

Conseil

Vérifiez immédiatement le résultat du tri. Si le résultat ne vous convient pas, il vous
suffit d'annuler la commande par CTRL+Z.

Le résultat est conforme à vos attentes. BADMINTON est inférieur à BASKET parce
que D est inférieur à S. Les lignes ont été réorganisées en fonction du sport par ordre
alphabétique croissant.

2. Trier rapidement une liste

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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Les icônes pour effectuer un tri rapide sont inutilisables car elles ne détectent pas
automatiquement la ligne de titre du tableau et ne permettent pas de trier une autre
colonne que la première. Espérons que ce petit « défaut » soit corrigé dans les versions
ultérieures.

IMG. 121

3. Trier une liste sur plusieurs clés

Les lignes sont maintenant groupées par sport. A l'intérieur d'un groupe, vous pouvez
définir un deuxième ordre de classement avec une seconde clé de tri, et ainsi de suite
jusqu'à 3 clés de tri.

Exercice n°57. Exercez-vous !

♦ Triez le tableau sur les 3 critères de tri : Sport - Croissant, Age - Croissant, Sexe -
Décroissant.

♦ Vérifiez le résultat du tri.

♦ Remarquez les individus qui font le même sport, ont le même âge et le même sexe
(il y en a 2 en basket et 2 en football) : pour ceux-là il faudrait une 4ème clé de tri.

4. Tri et formules

La 7ème colonne du tableau contient une formule de calcul de l'indice de masse
corporelle (IMC).

Vous avez peut-être remarqué que, bien que les lignes aient été réorganisées en
fonction du tri, les formules n'ont pas été modifiées. Tout se passe comme si les
formules n'avaient pas été triées. Par exemple, la cellule G2 contient toujours la
formule « E2/(F2/100)^2 ». L'individu de la ligne 2 a changé avec le tri, mais l'indice
IMC est toujours calculé de la même façon, ce qui est normal.
Par contre, si la formule fait référence à une autre ligne de la liste, le résultat dépendra
de la façon dont la liste est réorganisée. En cas de doute, vérifiez immédiatement le
résultat du tri et revenez en arrière s'il y a lieu.

Attention

Dans un tri par ligne, les références à des cellules de la même ligne restent correctes.
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Partie B. Filtrer une liste avec des filtres
automatiques

Filtrer une liste consiste à n'afficher que les lignes répondant à certains critères de
sélection, par exemple les individus de plus de 25 ans. Tout le reste est masqué.

Vous pouvez définir des filtres automatiquement ou de façon plus élaborée. Nous ne
verrons, dans ce module, que les filtres automatiques qui sont plus simples et plus
rapides à mettre en oeuvre et qui suffisent dans bon nombre de situations.

1. Filtrer sur un seul critère de sélection

Pour utiliser les filtres automatiques, sélectionnez une cellule quelconque de la liste,
puis choisissez le menu ... :

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Données > Filtrer > AutoFiltre.

Le tableur affiche des petites flèches de listes déroulantes à droite de chaque en-tête de
colonne. En cliquant sur l'une de ces flèches, vous affichez les différentes valeurs de la
colonne, ainsi que des options de filtrage.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Attention

Les lignes non affichées sont seulement masquées. Elles ne sont pas supprimées. Vous
pouvez les retrouver en sélectionnant « Tout » dans la liste déroulante « Sport ».

Exercice n°58. Exercez-vous ! (Excel)

Affichez uniquement les individus qui pratiquent le Badminton.
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"Spécifique Excel"

Une image explicative "Filtre « Badminton »" vous est proposée en Annexes "Pour aller plus
loin ..."

♦ Excel
Pour vous rappeler qu'un filtre est actif, les en-têtes de lignes affichées sont en bleu
ainsi que la flèche de la colonne « Sport » qui a servi de critère de sélection. Le
nombre d'enregistrements trouvés est affiché dans la barre d'état.

Exercice n°59. Exercez-vous ! (Calc)

Affichez uniquement les individus qui pratiquent le Badminton.

IMG. 123 : FILTRE « BADMINTON » - SPÉCIFIQUE CALC

♦ Calc
Pour vous rappeler qu'un filtre est actif, les en-têtes de lignes masquées sont affichés
par des barres plus épaisses. La flèche de la colonne « Sport » qui a servi de critère
de sélection est coloriée en bleu.

2. Filtrer sur plusieurs critères de sélection

Vous pouvez appliquer plusieurs critères de sélection, par exemple, n'afficher que les
individus masculins ET pratiquant le badminton.

Il suffit de sélectionner les critères les uns après les autres.
Les flèches des colonnes ayant servi de critères sont coloriées en bleu.
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Exercice n°60. Exercez-vous !

Après avoir filtré les individus pratiquant le badminton, déroulez la liste « Sexe » et
sélectionnez la valeur « M ». Vous affichez les 4 individus masculins qui pratiquent le
badminton.

Les lignes affichées répondent aux deux critères de sélection « Sport =
BADMINTON » ET « Sexe = M ».

3. Créer des filtres personnalisés

Les filtres personnalisés permettent de définir des critères de sélection plus complexes,
par exemple, afficher les individus qui pratiquent le Badminton OU le Football ET
dont l'âge est supérieur à 20 ans ET inférieur à 35 ans. Dans cet exemple, il y a 1
opérateur OU, et 2 opérateurs ET. Il faudra en tenir compte dans les critères de
sélection et procéder en 2 étapes :
♦ Sélectionner les individus pratiquant le Badminton OU le Football.

Remarque

Pensez à l'opérateur OU comme un opérateur « + » : le critère « Sport=Badminton »
OU « Sport=Football » affiche les individus qui pratiquent le badminton plus les
individus qui pratiquent le football.

♦ Parmi ces individus, sélectionner ceux dont l'âge est supérieur à 20 ans ET inférieur
à 35 ans.

Exercice n°61. Exercez-vous !

Affichez les individus qui pratiquent le Badminton OU le Football ET dont l'âge est
supérieur à 20 ans ET inférieur à 35 ans.

Etape 1 :

Pour Excel :
♦ Commencez par réafficher tous les individus en sélectionnant « (Tous) » dans la

colonne « Sport » et « Sexe »,

♦ Déroulez la liste de sélection de « Sport » et choisissez « Personnalisé ».

La boîte de dialogue « Filtre automatique personnalisé » s'ouvre. Choisissez Sport
« égal » « BADMINTON », cochez « Ou » « égal » « FOOTBALL ».
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IMG. 124 : FILTRE AUTOMATIQUE PERSONNALISÉ EXCEL - SPÉCIFIQUE

Pour Calc :
♦ Commencez par réafficher tous les individus en sélectionnant « - tout - » dans la

colonne « Sport » et « Sexe »,

♦ Déroulez la liste de sélection de « Sport » et choisissez « Standard ». La boîte de
dialogue « Filtre standard » s'ouvre. Choisissez « Sport » « = » « BADMINTON »,
« OU » « Sport » « = » « FOOTBALL »,

♦ Affichez les « Options » et cochez la case « Copier le résultat vers » et indiquez une
zone libre de votre feuille (par exemple A30). En effet, le résultat de la sélection doit
être extrait du tableau d'origine pour poursuivre la sélection sur l'âge.

Tri et filtres 141



IMG. 125 : FILTRE AUTOMATIQUE PERSONNALISÉ CALC - SPÉCIFIQUE

Vous avez maintenant les 10 individus pratiquant l'un ou l'autre sport. Parmi ceux-là,
établissons les critères d'âge dans une 2ème étape.

Etape 2 :

Pour Excel :
♦ Déroulez la liste de sélection de « Age » et choisissez « Personnalisé ». Choisissez :

« Age » « est supérieur à » « 20 », « Et » « est inférieur à » « 35 ».

Pour Calc :
♦ Dans la liste extraite du tableau d'origine, déroulez la liste de sélection de « Age » et

choisissez « Standard ». Choisissez : « Age » « > » « 20 » (tapez 20), « ET »
« Age » « < » « 35 » (tapez 35).

Voilà ! Vous avez extrait les 3 lignes qui répondent aux critères de sélection. Vous
pouvez éventuellement copier ces 3 lignes dans une autre feuille pour sauvegarder
l'extraction.

4. Désactiver les filtres automatiques

Pour désactiver les filtres automatiques, passez par le même menu que pour leur
activation, et décochez l'élément correspondant :

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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Données > Filtrer > AutoFiltre.

Les flèches des listes déroulantes disparaissent. La liste complète non filtrée est de
nouveau affichée.

Partie C. Evaluation

QUESTION N°1

Qu'est-ce qu'un filtre ?

A 1) Un critère de tri d'une liste.

B 2) Un critère de sélection d'une liste.

C 3) Un ensemble d'opérateurs ET et OU.

D 4) Un moyen de supprimer les lignes ne répondant pas aux conditions du filtre.

E 5) Un moyen d'afficher uniquement les lignes répondant aux conditions du filtre.

QUESTION N°2

Qu'est-ce qu'un tri ?

A 1) Un classement de liste.

B 2) Un filtre de liste.

C 3) Un filtre qui ne porte que sur l'ordre.

D 4) Une clé qui permet de classer.

E 5) Le résultat d'un critère de sélection.
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QUESTION N°3

Lorsque j'établis un filtre automatique sur 2 colonnes, par exemple « Sport = ATHLETISME OU
BASKET » sur la colonne 2 et « Sexe = F » sur la colonne 3, quel sera le résultat du filtre ?

A 1) Tous les individus pratiquant l'athlétisme seront affichés.

B 2) Toutes les femmes pratiquant l'athlétisme seront affichées.

C 3) Toutes les femmes pratiquant l'athlétisme et le basket seront affichées.

D 4) Toutes les femmes pratiquant l'athlétisme et toutes les femmes pratiquant le basket seront
affichées.

E 5) Toutes les femmes pratiquant l'athlétisme ou le basket seront affichées.

F 6) Il n'est pas possible de réaliser un tel filtre automatiquement.

Exercice n°62. Exercice 1

On considère qu'un individu a un poids normal si son indice de masse corporelle
(IMC) est compris entre 19 et 25.

Affichez les individus qui ont un poids normal à partir des données du fichier
téléchargé au début du chapitre ou à récupérer ici.

Exercice n°63. Exercice 2

On reprend la liste filtrée des individus qui ont un poids normal, dans l'exercice 1.

Affichez maintenant cette liste triée sur le sport (croissant) en première clé et sur l'âge
(croissant) en deuxième clé.
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B. Synthèse

Les tableurs permettent de réaliser assez sommairement certaines opérations
rencontrées dans les logiciels de gestion de base de données : les tris et les filtres. La
liste du tableur s'apparente à une table de base de données avec des lignes et des
colonnes. Il est important de faire la distinction entre le tri qui classe les lignes et le
filtre qui n'en affiche que certaines.

L'outil de filtre automatique est rapide et simple à utiliser. Il permet de combiner des
critères avec des opérateurs ET et OU pour des requêtes complexes.
Les outils de tris et de filtres intégrés aux tableurs sont très pratiques et très utilisés,
mais si vous les utilisez souvent, il est probable que vous devriez plutôt vous orienter
vers un logiciel de gestion de base de données dédié à ces tâches.
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Chapitre

IX
Réaliser un

graphique à partir
d'un tableau

Niveau de difficulté : facile

En plus de leurs possibilités de calcul et de traitement automatisé, une des
fonctionnalités importantes des tableurs réside dans la représentation automatique des
données sous forme de graphique. Sans avoir toutes les fonctionnalités des logiciels
spécialisés appelés « grapheurs », le tableur permet néanmoins de réaliser de
nombreuses représentations parmi les plus courantes.

Dans ce chapitre, vous verrez comment réaliser et modifier un graphique, et vous
apprendrez à choisir le type de graphique le plus adapté à la représentation de vos
données.

Pré-requis : connaître les fonctions de base du tableur : données, formules, références

Temps d'apprentissage : 60 minutes



A. Les types de graphiques communs à MS Excel et
OO Calc

Un graphique est une représentation de données chiffrées, tirées d'un tableau. Il permet
d'avoir rapidement une vue d'ensemble sur la comparaison de ces chiffres.

MS Excel et OO Calc mettent à disposition toute une série de types de graphiques (voir
ci-dessous). Le type de graphique à utiliser dépend des données à représenter et de
l'effet recherché dans leur représentation.

IMG. 126 : TYPES DE GRAPHIQUES - SPÉCIFIQUE

Outil méthodologique

Les exercices qui suivent ont pour but d'apprendre à choisir le graphique approprié à
vos données et à le réaliser.

Ils se basent sur les statistiques INSEE de l'emploi salarié et non salarié d'une région
française de 1997 à 2003 par secteur d'activité.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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Le fichier est à télécharger ici :

IMG. 127 : TABLEAU DE DÉPART POUR LES EXERCICES - SPÉCIFIQUE

Conseil

Avant de réaliser chaque graphe, copiez la feuille « Données » et définissez le graphe
sur la nouvelle feuille.

Partie A. Réaliser un graphique avec une ou
plusieurs séries

Pour créer un graphique, les tableurs disposent en général d'un assistant graphique
pour vous aider pas à pas dans sa réalisation.
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1. Avant de vous lancer …

Réfléchissez à la nature de vos données et à ce que vous voulez vraiment montrer :
♦ Quel est le type de graphique approprié pour représenter vos données ?

♦ Quelle est l'abscisse (coordonnée horizontale) de ce graphique ? Les données
sont-elles disposées en ligne ou en colonne ?

♦ Combien y aura-t-il de courbes sur le même graphique ?

♦ Quelles sont les ordonnées (coordonnées verticales) :

- de la 1ère courbe ? (1ère série de données)
- de la 2ème courbe ? (2ème série de données)
- etc.

♦ Sont-elles disposées en ligne ou en colonne ?

Vous vous apercevrez qu'en essayant différents types de graphiques, vos données
« parleront » différemment.

2. Les étapes de la réalisation d'un graphique

♦ Sélectionner la partie du tableau qui doit être représentée sous forme de graphique,
en incluant éventuellement les libellés de ligne ou de colonne.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

♦ Appeler l'assistant graphique par le menu Insertion > Diagramme ou directement
par l'icône « Insérer un diagramme » de la barre d'outils Standard.

"Spécifique Excel"

Une image explicative "" vous est proposée en Annexes "Pour aller plus loin ..."

Dans OO Calc, l'assistant graphique s'appelle « AutoFormat de diagramme ».

Les cinq étapes de l'élaboration d'un graphique avec Calc sont :
♦ Le choix de l'emplacement du graphique sur la feuille de calcul,

♦ La définition des données sources du graphique (abscisse, ordonnées),
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♦ Le choix du type de graphique et la disposition des données (en ligne ou en
colonne),

♦ Le choix d'une variante du type de graphique et du quadrillage,

♦ Les options du graphique : titres et légendes.

Partie B. Les histogrammes, ou diagrammes en
bâtons

1. Utilisation

Ce type de graphique est utilisé pour montrer des variations sur une période donnée ou
pour comparer différents éléments, par exemple comparer les emplois dans les
différents secteurs d'activités sur la période 1997-2003.

Les tableurs (OO Calc, MS Excel) ne permettent pas de faire de manière simple de
vrais histogrammes, au sens statistique : il s'agit en réalité de diagrammes en bâtons.

2. Construction du diagramme en bâtons

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

♦ Sélectionnez A5:H8 en utilisant les touches MAJ+CTRL + → et ↓ .

Vous sélectionnez 4 séries de données (une par secteur d'activité) ainsi que le nom des
séries (Agriculture, Industrie, ...)

♦ Appelez l'assistant graphique AutoFormat de diagramme, puis suivez-en les 5
étapes :

♦ Etape 0 :

Dans la feuille de calcul, le curseur souris se transforme en croix avec une petite icône
graphique pour définir la zone où s'affichera le graphique.

Glissez ce curseur de A11 à H25.

♦ Etape 1 :
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L'étape 1 de l'AutoFormat vous permet de préciser la sélection et d'indiquer si celle-ci
contient les étiquettes de lignes et de colonnes.

Cochez ces deux options.

IMG. 136 : AUTOFORMAT, ÉTAPE 1 - SPÉCIFIQUE CALC

♦ Etape 2 :

L'étape 2 vous permet de sélectionner le type de graphique « Colonnes », ce qui
correspond à un diagramme en bâtons. L'aperçu vous montre 4 groupes (Agriculture,
Industrie, ...) et 7 séries de données (199,1998,... ). En effet la case « Colonnes » est
cochée, indiquant que les données sont positionnées en colonnes (il y a 7 colonnes).

Cochez « Lignes » et observez la modification de l'aperçu.
Cochez également « Afficher l'aperçu des objets de texte ». Vous avez maintenant un
aperçu de votre graphe définitif.
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IMG. 137 : AUTOFORMAT, ÉTAPE 2, « TYPE DE DIAGRAMME » - SPÉCIFIQUE CALC

Le choix du type de graphique est l'étape la plus importante : choisissez bien !

Vous pourrez changer ultérieurement ce type si vous vous apercevez qu'il ne
correspond pas à vos attentes.

Passez à l'étape 3.

♦ Etape 3 :

Elle consiste à définir la variante - ou sous-type - de graphique, et le quadrillage.

Laissez les options par défaut.

N'hésitez pas à cocher ou décocher les cases pour voir la signification de ces
variantes dans l'aperçu !
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IMG. 138 : AUTOFORMAT, ÉTAPE 3, « VARIANTES ET QUADRILLAGE » - SPÉCIFIQUE CALC

Passez à l'étape suivante.

♦ Etape 4 :

Elle consiste à définir les titres et l'affichage ou non de la légende.

- Titre du diagramme : « Statistique d'emplois ».

Le titre du graphique et les titres des 2 axes sont indispensables à la bonne
compréhension du graphe. Sans eux, le graphe serait inutile.

♦ Titre Axe X : « Année ».

♦ Titre Axe Y : « Nombre d'emplois ».

♦ Légende : affichez la légende.

Vous devez afficher une légende dès que votre graphe présente plusieurs séries de
données, de façon à les identifier.

Note : le graphique étant lié au tableau, toute modification apportée aux chiffres de ce
tableau sera automatiquement répercutée dans le graphique.
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IMG. 139 : AUTOFORMAT, ÉTAPE 4 « TITRES » - SPÉCIFIQUE CALC

Cliquez sur le lien suivant afin de découvrir l'animation qui vous résume la démarche :
Animation "Création d'histogrammes dans
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap8/animation_creation_histogramme_OO.htm]

Cliquez sur « Créer » pour afficher le graphe dans la feuille de calcul à l'endroit défini
à l'étape 0.

La présentation reste à améliorer : la zone de traçage grisée est illisible et les titres et
légendes ont une police de taille disproportionnée. Arrangeons cela.

3. Redimensionnement et repositionnement du graphique

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Les graphiques d'OpenOffice CALC sont flottants, c'est-à-dire que leur position et leur
taille peuvent changer dans la feuille.
♦ En cliquant une seule fois sur le graphique, vous le sélectionnez. Les poignées de

redimensionnement sont vertes : vous pouvez le redimensionner, le repositionner, le
copier, etc. (voir le menu contextuel), mais pas l'éditer.

♦ En double-cliquant sur le graphique, vous l'activez. Celui-ci s'entoure de bordures
grisées et de poignées de redimensionnement noires. Vous pouvez alors l'éditer et le
modifier.
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Lorsqu'un graphique est activé, la barre d'outils « Formatage » du graphique
apparaît. Elle permet d'accéder à la plupart des options du graphe. Vous pouvez
déplacer cette barre d'outils et la rendre flottante.

IMG. 141 : BARRE D’OUTILS « FORMATAGE » - SPÉCIFIQUE CALC

4. Modification du graphique

Notion d’objet graphique

La zone graphique est constituée d'objets qui sont des entités dont vous pouvez
modifier les propriétés (formats ou attributs) et que vous pouvez supprimer, copier,
déplacer, agrandir, etc. Ca ne vous rappelle rien ?

Remarque

Eh oui ! La cellule est aussi un objet que l'on peut supprimer, copier, déplacer,
agrandir et dont on peut changer les propriétés (formats).

Vous pouvez identifier chacun de ces objets en promenant votre souris sur la zone
graphique : dès qu'elle pointera un objet graphique (titre, axe, légende, série de
données, zone de traçage, quadrillage), une bulle d'information vous en indiquera le
nom.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Le graphe doit être activé en double-cliquant dessus.

En cliquant sur un objet, il sera sélectionné et son nom apparaîtra dans la barre d'état.
Modification d’un objet graphique

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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Vous devez d'abord activer le graphique en double-cliquant dessus. Ensuite,
sélectionnez l'objet sur lequel portera la modification.

Vous pouvez sélectionner les objets successivement en appuyant sur la touche TAB.

Après sélection, l'objet est pourvu de poignées de redimensionnement vertes, et son
nom apparaît dans la barre d'état. A ce stade, vous pouvez :
♦ le supprimer, le copier, le déplacer, l'agrandir, etc.

♦ modifier ses propriétés (formats) :

- en cliquant-droit par l'intermédiaire du menu contextuel « Propriétés de l'objet »,
- ou en double-cliquant sur l'objet,
- ou en utilisant le menu Format de la barre de menus.

Exercice n°64. Exercez-vous !

Trouvez et identifiez au moins 12 objets graphiques.

Exercice n°65. Exercez-vous ! (Excel)

Essayez de modifier les formats des différents objets graphiques pour arriver au
résultat de la figure suivante. Dans ce graphique ... :
♦ les titres sont en taille 12, caractères gras,

♦ les autres libellés sont en taille 10,

♦ la zone de traçage a une Aire automatique,

♦ le quadrillage principal de l'axe des ordonnées est en pointillés gris,

♦ la série « Tertiaire » est en vert clair,

♦ l'ordre des séries est modifié.
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IMG. 142 : FIGURE APRÈS MODIFICATIONS - SPÉCIFIQUE

Cette présentation montre la prédominance et l'augmentation du secteur tertiaire, et la
relative stagnation des autres secteurs sur la période considérée. On peut également
comparer l'agriculture et la construction dont les séries sont affichées l'une à côté de
l'autre.

Cliquez sur le lien suivant afin d'ouvrir l'animation associée :
♦ Animation "Modification d'histogrammes" dans

Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap8/animation_modification_histogramme_MS.htm]

Exercice n°66. Exercez-vous ! (Calc)

Essayez de modifier les formats des différents objets graphiques pour arriver au
résultat de la figure suivante. Dans ce graphique ...,
♦ les titres sont en taille 12, caractères gras,

♦ les autres libellés sont en taille 10,

♦ l'arrière-plan du diagramme n'a aucun remplissage,

♦ le quadrillage principal de l'axe des ordonnées est en pointillés gris,

♦ la série « Tertiaire » est en vert clair,

♦ l'ordre des séries est modifié (Menu contextuel, puis Disposition > Vers
l'arrière/l'avant).
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IMG. 143 : FIGURE APRÈS MODIFICATIONS - SPÉCIFIQUE

Cette présentation montre la prédominance et l'augmentation du secteur tertiaire, et la
relative stagnation des autres secteurs sur la période considérée. On peut également
comparer l'agriculture et la construction dont les séries sont affichées l'une à côté de
l'autre.

Cliquez sur le lien suivant afin d'ouvrir l'animation associée :
♦ Animation "Modification d'histogrammes dans

Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap8/animation_modification_histogramme_OO.htm]

5. Les variantes ou sous-types de graphique

Sur la base du graphe précédent, vous pouvez réaliser des variantes « empilé » et
« empilé pourcentage » pour comparer les contributions relatives de chaque série,
ainsi que des effets 3D.
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Variantes 2D

Sélectionnez le graphique et modifiez-en la variante (ou sous-type), par exemple en
diagramme empilé.

IMG. 144 : HISTOGRAMME EMPILÉ - SPÉCIFIQUE

Explication

Le sous-type « empilé » donne une indication supplémentaire : le nombre d'emplois
augmente globalement sur la période, et cette augmentation est essentiellement due au
secteur tertiaire.

Variantes 3D

Il faut remarquer que les tableurs ne créent pas de vrais graphiques en 3D, ce qui
impliquerait 3 axes, mais génèrent des graphiques ayant 2 axes plus un effet de
profondeur.

Amusez-vous à créer une vue 3D comme sur la figure suivante. Modifiez la vue 3D
(propriété du graphe) en jouant sur l'orientation, la perspective, etc. Selon les
dimensions de votre graphe, vous serez peut-être également amenés à diminuer les
tailles de caractères.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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IMG. 146 : HISTOGRAMME 3D - SPÉCIFIQUE CALC

En activant le graphique et en sélectionnant l'arrière-plan du diagramme, vous
obtenez des poignées de redimensionnement rouges qui vous permettent de pivoter le
graphique.

Amusez-vous bien, mais n'oubliez pas de sauvegarder votre classeur avant !

Joli n'est-ce pas ? Cependant, la question est de savoir si cette variante 3D apporte plus
d'information que le graphe 2D. A vous de juger ... et de voir les avantages et les
inconvénients d’une telle représentation.

Quelques conseils pour l'effet 3D

♦ Usez de l'effet 3D avec modération.

♦ Les graphiques en 3D sont déconseillés si l'on veut afficher des valeurs avec
précision.

♦ Il faut faire attention à bien régler l'angle de vue et l'ordre des séries car
certaines parties du graphique peuvent être cachées.

Attention

Les représentations 3D sont souvent spectaculaires, mais moins précises que leurs
équivalents 2D.
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Partie C. Les graphiques en courbes (ou en lignes)

Ils sont utilisés pour représenter l'évolution de grands ensembles de données dans le
temps (ventes d'un produit sur une période donnée, évolution de la population, de
l'inflation, de l'emploi, du tourisme, du prix d'une denrée, des taux de change, des
cours de la Bourse, de l'audience d'un site Web, etc.).
♦ Ces graphiques s'utilisent donc comme des graphiques en bâtons (ou en colonnes).

♦ Ce type de graphique est souvent combiné à un autre type de graphique (ex.
graphique en bâtons, en aires).

♦ Il y a autant de courbes qu'il y a de séries. Il faut utiliser des couleurs différentes
pour chaque série et les préciser dans la légende.

Attention : le type « Courbes » est différent du type nuage de points XY.
♦ Le type « Courbes » : l'abscisse est un libellé comme pour un diagramme en bâtons.

Pour représenter une évolution dans le temps, ces libellés doivent correspondre à des
intervalles de temps constants (ex. : « janvier », « février », ... ou « lundi », « mardi
», etc.).

♦ Le type « nuage XY » : l'abscisse X correspond à une variable numérique continue
(ex. : 1,28 ; 3,1415 ; ... ).

Comparaison entre les 2 types de graphiques : remarquez la position des libellés des
abscisses et la présence ou non de traits entre les marques.
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IMG. 147 : COMPARAISON ENTRE LES GRAPHIQUES « COURBES » ET « XY » - SPÉCIFIQUE

Exercice n°67. Exercez-vous ! (Excel)

Visualisez le type « Courbes ».

Copiez la feuille précédente et appelez-la « Courbes ».

Ce type s'utilisant comme un graphique en bâton, il suffit de changer le type du
graphique précédent.
Essayez aussi les différentes variantes ou sous-types, et retenez celui qui correspond le
mieux à ce que vous voulez montrer.
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IMG. 148 : GRAPHIQUE DE TYPE « COURBES » - SPÉCIFIQUE

Exercice n°68. Exercez-vous ! (Calc)

Visualisez le type « Lignes ».

Copiez la feuille précédente et appelez-la « Lignes ».

Ce type s'utilisant comme un graphique en bâton, il suffit de changer le type du
graphique précédent.
Essayez aussi les différentes variantes ou sous-types, et retenez celui qui correspond le
mieux à ce que vous voulez montrer.
La figure ci-dessous est de variante « Normale » avec un épaisseur de trait de 0,10 cm.

IMG. 149 : GRAPHIQUE DE TYPE « LIGNES » - SPÉCIFIQUE
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Partie D. Les graphiques en aires (ou en zones)

C'est un graphique en courbes dont les espaces entre les lignes sont remplis. Un
graphique en aires empilées est utilisé pour représenter les valeurs de chaque série par
rapport au total sur une période donnée.

♦ L'aire la plus grande doit être en bas. Le mieux est d'ordonner les séries en fonction
de la taille de leur aire.

♦ Utiliser des couleurs (ou des motifs) plus claires au fur et à mesure que l'on monte.

♦ Pas plus de 5 séries car sinon l'interprétation est difficile.

IMG. 150 : AIRES EMPILÉES - SPÉCIFIQUE

Le secteur tertiaire représente plus des deux-tiers des emplois, la tendance est à son
augmentation.

Exercice n°69. Exercez-vous ! (Excel)

Visualisez le type « Aires ».

Copiez la feuille précédente et appelez-la « Aires ».

Ce type s'utilisant comme un graphique en courbes, il suffit de changer le type du
graphique précédent. La variante la plus utilisée est « Aires empilées » puisqu'il s'agit
de montrer les variations par rapport au total. Pensez à changer l'ordre des séries,
comme vous l'avez fait pour les diagrammes en bâtons, et à modifier leurs motifs de
remplissage.
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Exercice n°70. Exercez-vous ! (Calc)

Visualisez le type « Zones ».

Copiez la feuille précédente et appelez-la « Zones ».

Ce type s'utilisant comme un graphique en lignes, il suffit de changer le type du
graphique précédent.
La variante la plus utilisée est « Aires empilées » puisqu'il s'agit de montrer les
variations par rapport au total. Pensez à changer l'ordre des séries, comme vous l'avez
fait pour les diagrammes en bâtons, et à modifier leurs motifs de remplissage.

Partie E. Les graphiques en « Nuage de points XY »

Le type « Nuage de points XY » représente la relation (ou la corrélation) entre deux
variables numériques (par exemple, le nombre d'emplois dans l'industrie en fonction
du nombre d'emplois dans le tertiaire). L'abscisse X et l'ordonnée Y sont toutes les
deux des variables continues pouvant prendre n'importe quelle valeur. Les graphes de
ce type sont souvent complétés d'une courbe de tendance (en général, une droite) qui
modélise la relation entre les variables.

Les points d'un graphique « Nuage de points XY » ne sont jamais reliés entre eux,
mais leur relation peut être modélisée par une courbe de tendance.

Ne confondez pas graphique en « Nuage de points XY » et graphique en « Courbes ».

Exercice n°71. Exercez-vous ! (Excel)

Visualisez le type « Nuage de points XY ».

♦ Copiez la feuille précédente et appelez-la « XY ».

♦ Commencez par sélectionner l'abscisse X correspondant aux emplois dans l'industrie
entre 1997 et 2003, soit la plage B6:H6.

♦ La plage correspondant à la première série des ordonnées (secteur « Tertiaire ») n'est
pas adjacente à la plage des X. Appuyez sur la touche CTRL et sélectionnez la plage
B8:H8.

♦ Appelez l'assistant graphique et suivez les étapes de réalisation.

♦ Ajoutez une courbe de tendance linéaire.
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IMG. 151 : GRAPHIQUE EN « NUAGE DE POINTS XY » - SPÉCIFIQUE

Cliquez sur le lien suivant afin de découvrir l'animation correspondante :

♦ Animation "Création d'un nuage de points XY dans
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap8/animation_creation_XY_MS.htm]

Il y a une relation entre le tertiaire et l'industrie : lorsque le nombre d'emplois
industriels augmente, le secteur tertiaire emploie davantage. Le secteur tertiaire
emploie en moyenne environ 4,7 fois plus que l'industrie (équation de la droite de
tendance : Tertiaire = 4,6663*Industrie - 167157).

Exercice n°72. Exercez-vous ! (Calc)

Visualisez le type « Diagramme XY ».

♦ Copiez la feuille précédente et appelez-la « XY ».

♦ Commencez par sélectionner l'abscisse X correspondant aux emplois dans l'industrie
entre 1997 et 2003, soit la plage B6:H6.

♦ La plage correspondant à la première série des ordonnées (secteur « Tertiaire ») n'est
pas adjacente à la plage des X. Appuyez sur la touche CTRL et sélectionnez la plage
B8:H8.

♦ Appelez l'assistant graphique et suivez les étapes de réalisation.

♦ Ajoutez une courbe de tendance linéaire.
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IMG. 152 : GRAPHIQUE EN « DIAGRAMME XY » - SPÉCIFIQUE

Cliquez sur le lien suivant afin de découvrir l'animation correspondante :

♦ Animation "Création d'un nuage de points XY dans
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap8/animation_creation_XY_OO.htm]

Il y a une relation entre le tertiaire et l'industrie : lorsque le nombre d'emplois
industriels augmente, le secteur tertiaire emploie davantage.

Partie F. Les graphiques en secteurs

Ce type de graphique est utilisé pour montrer les proportions entre des parties formant
un tout. Un graphique en secteurs ne peut contenir qu'une seule série. Ce type de
graphique est aussi appelé « en camembert ». Vous comprendrez pourquoi en
regardant les figures les représentant.

♦ Les pourcentages de chaque secteur doivent apparaître car les angles sont
difficilement estimables.

♦ Les étiquettes de catégorie doivent accompagner le graphe pour savoir à quelle
catégorie correspond chaque secteur.

♦ Eclatez les secteurs pour mettre en évidence un élément particulier.
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Exercice n°73. Exercez-vous ! (Excel)

Visualisez le type « Secteurs ».

Créez un graphique en secteurs 2D représentant les proportions de chaque domaine
d'activité sur l'année 2003. Affichez le texte de l'étiquette et sa valeur en pourcentage.
Eclatez ensuite les secteurs (représentation de droite) :

IMG. 153 : GRAPHIQUES EN SECTEURS - SPÉCIFIQUE

Cliquez sur le lien suivant afin de découvrir l'animation correspondante :

♦ Animation "Création d'un graphique en secteurs 2D dans
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap8/animation_creation_secteurs_MS.htm]

Exercice n°74. Exercez-vous ! (Calc)

Visualisez le type « Secteurs ».

Créez un graphique en secteurs 2D représentant les proportions de chaque domaine
d'activité sur l'année 2003. Affichez le texte de l'étiquette et sa valeur en pourcentage.
Eclatez ensuite les secteurs (représentation de droite) :
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IMG. 154 : GRAPHIQUES EN SECTEURS - SPÉCIFIQUE

Cliquez sur le lien suivant afin de découvrir l'animation correspondante :

♦ Animation "Création d'un graphique en secteurs 2D dans
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap8/animation_creation_secteurs_OO.htm]
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Partie G. Graphiques divers

1. Les graphiques à barres

♦ Un graphique à barres est utilisé pour montrer des nombres individuels sur une
période donnée ou pour comparer des éléments.

♦ Cet outil est similaire à un graphique en colonnes, mais la façon dont les barres
horizontales sont disposées met moins l'accent sur la durée que sur les
comparaisons.

♦ Une autre raison d'utiliser les barres plutôt que les colonnes est la longueur des
libellés des catégories.

Toutes les variantes vues précédemment sur les graphiques en bâtons sont disponibles
pour les graphiques à barres.

IMG. 155 : GRAPHIQUE À BARRES - SPÉCIFIQUE
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2. Les graphiques en radar (en toile)

♦ Ils sont semblables aux graphiques en courbes, mais généralement utilisés pour
comparer la valeur totale de plusieurs séries de données.

♦ Un graphique en radar comporte des courbes et des marques.

♦ Dans un graphique en radar, chaque abscisse possède son propre axe partant du
point central. Les points appartenant à la même série sont reliées par des courbes.

♦ Dans un graphique en radar, chaque catégorie a son propre axe des ordonnées
partant du point central. Des traits relient entre elles toutes les valeurs d'une même
série.

IMG. 156 : GRAPHIQUE EN RADAR (EN TOILE) - SPÉCIFIQUE

3. Autres graphiques

Il existe bien d'autres types de graphiques, boursiers, graphiques en surface 3D (MS
Excel), graphiques à bulles (MS Excel), etc., pour des applications particulières. Ils ne
seront pas détaillés dans ce module.
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Partie H. Evaluation

Le site de l'INSEE (Institut national de la statistique et des études économiques)
propose de très nombreux tableaux et graphiques pour analyser l'économie et la société
française. Les exercices proposés s'inspirent des informations et données recueillies
sur ce site. N'hésitez pas à télécharger les tableaux de données proposés (au format
Excel, importables sous OpenOffice Calc) et à créer des graphiques à partir de ces
tableaux : vous verrez qu'un graphique approprié parle bien mieux qu'un tableau !

Exercice d'appariement 1. Exercice d’appariement

Un exercice interactif vous est proposé dans la vesion en ligne

QUESTION N°1

Selon vous, quels sont les types de graphiques les plus adaptés pour représenter une évolution
dans le temps ?

A 1) Un graphique en bâtons ou en colonnes.

B 2) Un graphique en barres.

C 3) Un diagramme en ligne ou graphique en courbes.

D 4) Un diagramme en nuage de points XY.

E 5) Un graphique en secteurs.

F 6) Un camembert.

QUESTION N°2

Quelles sont les différences entre un graphique de type « Lignes » ou « Courbes » et un
graphique de type « Nuage de points XY » ?

A 1) Il n'y en a pas.

B 2) Dans le graphique de type « Courbes » ou « Lignes », on peut afficher plusieurs séries de
données.

C 3) Dans le graphique de type « Courbes » ou « Lignes », les abscisses peuvent ne pas être
des nombres.

D 4) Dans le graphique de type « Courbe » ou « Lignes », on ne peut pas modéliser la
tendance par une droite de régression.

E 5) Dans un graphique de type « Nuage de points XY », il faut relier les points par des droites
pour montrer la tendance, alors que le type « Lignes » ou « Courbes » le fait par défaut.
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Exercice n°75. Exercice 1

Récupérez, depuis le site de l'INSEE, le tableau du taux d'activité par tranche d'âge de
1975 à 2005 (tableau des données ci-dessous).

Si vous ne le trouvez pas, téléchargez-le ici.

IMG. 157 : TAUX D’ACTIVITÉ PAR TRANCHE D’ÂGE DE 1975 À 200 - SPÉCIFIQUE

Exercice n°76. Exercice 2

Récupérez, depuis le site de l'INSEE, le tableau de la répartition des actifs ayant un
emploi par âge et par catégorie socioprofessionnelle, en 2005.

Si vous ne le trouvez pas, téléchargez-le ici.

Eliminez les données de 2003 et 2004 et les détails des professions pour arriver au
tableau des données ci-dessous.
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IMG. 158 : TABLEAU EXERCICE 2 - SPÉCIFIQUE

Exercice n°77. Exercice 3

Reprenez à partir du tableau de l'exercice 2.

IMG. 159 : TABLEAU EXERCICE 2 - SPÉCIFIQUE
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B. Synthèse

Un graphique parle souvent mieux qu'un tableau de nombres. Selon son type, le
graphique montrera les données sous différents aspects, et ceci facilitera l'analyse.
♦ Pour établir des comparaisons sur plusieurs séries de données, utilisez les

diagrammes en « bâtons »,

♦ Pour montrer une évolution dans le temps, préférez les diagrammes en « courbes »
(« lignes ») ou en « aires » (« zones »).

♦ Pour établir des relations entre deux variables, choisissez le type « Nuage de points
XY ». Attention à ne pas confondre avec le type « Coubes » !

♦ Pour comparer des éléments faisant partie d'un tout, le graphique en « Secteurs » est
le plus adapté.

Chacun de ces types offre plusieurs sous-types ou variantes qui peuvent apporter des
informations complémentaires. Evitez cependant le sous-type 3D, trop beau pour être
précis.
La réalisation d'un graphique est facile, mais les très nombreuses options disponibles
demandent un peu de pratique. Alors ... entraînez-vous et expérimentez !
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Chapitre

X
Imprimer une feuille

de calcul

Niveau de difficulté : facile

Ca y est ! Vous avez réussi à créer un tableau, à bien le présenter, et vous avez rajouté
un graphique pour illustrer vos données dans la feuille de calcul. Vous voulez
maintenant l'imprimer pour montrer à tout le monde vos progrès dans le module
tableur.

En général, il ne suffit pas d'appuyer sur le bouton « Imprimer » pour obtenir une
impression correcte comme dans un traitement de texte. Le tableur est plus orienté vers
la manipulation et le traitement automatique des données que leur présentation : par
exemple, les marges, la pagination, les en-têtes et pieds de pages ne sont pas affichés.
Ce chapitre vous montrera comment paramétrer l'impression d'une feuille de calcul et
d'un graphique pour arriver au résultat attendu sans gaspiller une ramette complète de
papier.

Pré-requis : Savoir créer un tableau et un graphique

Temps d'apprentissage : 30 minutes



A. L'aperçu avant impression

La feuille de calcul étant faite avant tout pour calculer, ce qui est affiché ne sera pas
exactement ce qui sera imprimé.

Pour régler les paramètres de l'impression, il est très fortement conseillé de passer par
l'aperçu avant impression qui vous donnera un affichage de la feuille telle qu'elle sera
imprimée (affichage WYSIWYG : What You See Is What You Get = Ce que vous
voyez est ce que vous obtenez).

Les options de mise en page par défaut donnent un résultat rarement satisfaisant :
♦ L'impression ne tient pas sur une page au format standard A4 (problème très

courant) : un tableau est tronqué et une partie des lignes ou des colonnes se retrouve
sur une autre page.

♦ La zone d'impression n'est pas positionnée correctement sur la page.

♦ Il n'y a pas de numéro de page, ni d'en-têtes ou de pieds de pages.

♦ Les marges ne conviennent pas.

Pour toutes ces raisons, il faut régler la mise en page avec l'aide de l'aperçu.

Attention

Passez toujours par l'aperçu avant impression avant de lancer l'impression.

Vous allez vous familiariser avec les options d'impression à partir d'un classeur du
chapitre précédent : « Réaliser un graphique à partir d'un tableau » où vous avez
représenté différents graphiques sur les statistiques d'emplois.

Vous pouvez aussi télécharger ce classeur ici.

Voir annexe A en fin de fascicule - Spécifique Excel

Voir annexe A en fin de fascicule - Spécifique Calc

Pour lancer l'aperçu ... :

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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"Spécifique Calc"

L'aperçu d'impression dans Calc

♦ Menu Fichier > Aperçu,

♦ ou l'icône correspondante de la barre d'outils nomal :

IMG. 162

♦ Par défaut, si aucune zone d'impression n'a été définie, l'impression porte sur
tous les objets de toutes les feuilles du classeur : plages de cellules et
graphiques. La page courante est indiquée dans la barre d'état (figure
ci-dessous).

♦ Vous pouvez définir/supprimer une zone d'impression en sélectionnant une ou
plusieurs plages de cellules puis le menu Format > Zones d'impression >
Définir / Supprimer.
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IMG. 163 : APERÇU AVANT IMPRESSION - SPÉCIFIQUE CALC

Cliquez sur le lien suivant afin de découvrir l'animation : Animation "Aperçu
dans
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap9/animation_apercu_OO.htm]

Partie A. Faire la mise en page

C'est par le bouton « Page » de l'aperçu avant impression que se règle la mise en page.
La plupart des options d'impression par défaut sont suffisantes. Mais n'hésitez pas à les
modifier, et observez le résultat sur l'aperçu !

Exercice n°78. Exercez-vous ! (Excel)

Découvrez et modifiez les options de mise en page.

Rajouter un en-tête et un pied de page donnant des informations sur le fichier, le nom

180 MODULE B4 - REALISER DES DOCUMENTS DESTINES A ETRE IMPRIMES – TABLEURS



de feuille, le numéro de page et la date.

Les options de mise en page sont accessibles par les quatre onglets suivants :

♦ Pages
Il permet de :

- Sélectionner l'orientation de la page,
- Préciser un pourcentage d'agrandissement ou de réduction via l'option « Échelle »,
- Ajuster la taille des zones d'impression pour qu'elles puissent « entrer » dans le

nombre de pages précisé,
- Choisir la taille du papier et la qualité d'impression,
- Spécifier à quelle valeur doit débuter la numérotation des pages.

Choisissez les options par défaut telles que sélectionnées à la figure « Page ».

IMG. 164 : MISE EN PAGE, ONGLET « PAGE » - SPÉCIFIQUE
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♦ Marges
Cet onglet permet de :

- spécifier les marges que devra respecter le document,
- déterminer si les feuilles de calcul doivent être centrées en largeur, en hauteur ou

les deux.

Choisissez les options par défaut de la figure « Marges ».

IMG. 165 : MISE EN PAGE, ONGLET « MARGES » - SPÉCIFIQUE

♦ En-tête/Pied de page
Il permet d'ajouter du texte en haut et en bas de chaque page, soit à partir d'un
format pré-sélectionné soit à partir d'un format personnalisé.

- Optez pour le nom du classeur en en-tête,
- Personnalisez le pied de page avec les 3 parties entrées à l'aide des icônes comme

sur la figure suivante :
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IMG. 166 : OPTIONS « PIED DE PAGE » - SPÉCIFIQUE

Les champs entre crochets seront remplacés par leur valeur au moment de
l'impression.

Vous devriez arriver au résultat de la figure suivante : Nom de la feuille ; n° de page ;
date courante.
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IMG. 167 : MISE EN PAGE, ONGLET « EN-TÊTE/PIED DE PAGE » - SPÉCIFIQUE

♦ Feuille
Cet onglet offre diverses autres options comme ... :

- la suppression du quadrillage tel qu'il apparaît à l'écran,
- la spécification de la zone d'impression et de titres à imprimer à chaque page,
- l'ordre de présentation des pages dans le cas d'une impression de plus d'une feuille

de calcul par page,

Choisissez les options par défaut comme sur la figure ci-dessous.
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IMG. 168 : MISE EN PAGE, ONGLET « FEUILLE » - SPÉCIFIQUE

Vous devriez arriver à l'aperçu suivant :
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IMG. 169 : APERÇU APRÈS MISE EN PAGE - SPÉCIFIQUE

En affichant les marges (bouton Marges), vous pouvez les ajuster ainsi que la largeur
des colonnes grâce aux repères qui s'affichent.

En fermant l'aperçu, vous pouvez visualiser les sauts de page par des pointillés dans
la feuille de calcul.

Exercice n°79. Exercez-vous ! (Calc)

Découvrez et modifiez les options de mise en page.

Rajouter un en-tête et un pied de page donnant des informations sur le fichier, le nom
de feuille, le numéro de page et la date.

Les options de mise en page sont accessibles par les sept onglets suivants :
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♦ Gérer
Il permet de mémoriser un style de page à partir des options de mise en page
choisies. Il suffit alors de rappeler ce style sur une autre feuille de calcul pour
obtenir la même mise en page (touche de fonction F11).

IMG. 170 : MISE EN PAGE, ONGLET « GÉRER » - SPÉCIFIQUE

♦ Pages
Il permet de :

- Choisir la taille du papier,
- Sélectionner l'orientation de la page, Portrait ou Paysage,
- Définir les marges,
- Déterminer si les feuilles de calcul doivent être centrées en largeur, en hauteur ou

les deux.

Un aperçu vous aide à choisir les options de mise en page.

Choisissez les options par défaut de la figure « Page ».
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IMG. 171 : MISE EN PAGE, ONGLET « PAGE » - SPÉCIFIQUE

« Bordure » et « Arrière-plan » : ces onglets permettent de rajouter des encadrements
et un fond à la page.

♦ En-tête et Pied de page
Ils permettent d'ajouter du texte en haut et en bas de chaque page, soit à partir d'un
format présélectionné soit à partir d'un format personnalisé.

- Cochez « Activer l'en-tête» et « Editer ».
- Optez pour le nom du fichier dans la partie centrale de l'en-tête : personnalisez-la

à l'aide des icônes comme sur la figure suivante et validez.
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IMG. 172 : EDITION DE L’EN-TÊTE - SPÉCIFIQUE

Cochez « Options », puis sélectionnez l'onglet « Bordures » pour rajouter une bordure
inférieure à l'en-tête.

IMG. 173 : OPTION D’EN-TÊTE, ONGLET « BORDURES » - SPÉCIFIQUE

Validez l'en-tête et éditez de la même façon le pied de page en vous servant
uniquement des icônes pour insérer les champs « nom de feuille », « n° de page », et «
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date ». Rajoutez une bordure supérieure au pied de page.

IMG. 174 : EDITION DE PIED DE PAGE - SPÉCIFIQUE

♦ Classeur
Cet onglet offre diverses autres options comme ... :

- l'ordre de présentation des pages dans le cas d'une impression de plus d'une feuille
de calcul par page.

- le choix des éléments à imprimer. Choisissez « En-têtes de colonnes/lignes » et «
Grille » si vous souhaitez imprimer la structure de votre feuille de calcul.

- adapter la taille des zones d'impression pour qu'elles puissent « entrer » dans le
nombre de pages précisé.

Choisissez les options par défaut comme sur la figure ci-dessous.
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IMG. 175 : MISE EN PAGE, ONGLET « CLASSEUR - SPÉCIFIQUE

Vous devriez arriver à l'aperçu suivant :
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IMG. 176 : APERÇU APRÈS MISE EN PAGE - SPÉCIFIQUE

En cliquant sur l'icône « Page suivante », vous verrez que la mise en page créée
précédemment reste valable pour la feuille suivante avec le même style de page.

En fermant l'aperçu, vous pouvez visualiser les sauts de page par un trait plein dans la
feuille de calcul.
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Partie B. Mettre en page de grands tableaux

Lorsque les dimensions d'un tableau à imprimer dépassent les dimensions d'une feuille
standard A4, plusieurs possibilités s'offrent à vous :
1. Si le tableau est plus large que haut, passez à une orientation « Paysage ».

2. Si le tableau n'est pas trop grand, vous pouvez essayer de limiter son impression à
une seule feuille par les options « Ajuster » ou « Adapter » de la mise en page. La
taille des caractères sera réduite en conséquence. Attention de ne pas réduire
exagérément : le tableau doit rester lisible !

3. Si le tableau est vraiment très grand (plusieurs dizaines de lignes ou de colonnes), il
faut en gérer l'impression sur plusieurs feuilles.

Avant de penser à imprimer un grand tableau, pensez à ceux qui le liront et à
l'indigestion qui pourrait en résulter. Souvent un graphique est plus approprié pour
analyser les données.

Exercice n°80. Exercez-vous ! (Excel)

Vous allez créer un grand tableau de 100 lignes par 20 colonnes en utilisant des séries
incrémentées comme sur la figure ci-dessous (représentant seulement une partie des
100 lignes x 20 colonnes).

IMG. 177 : PARTIE DU TABLEAU 100 LIGNES X 20 COLONNES - SPÉCIFIQUE

♦ Affichez un aperçu avant impression. Six pages sont nécessaires pour imprimer
l'ensemble du tableau. Certaines pages n'affichent pas le titre des lignes, des
colonnes ou des deux.

♦ Voyez maintenant si vous pouvez ajuster la taille du tableau pour qu'il puisse
s'imprimer sur une seule page.
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♦ Menu Fichier > Mise en Page à partir de la feuille de calcul, ou bouton Page à
partir de l'aperçu.

♦ Dans l'onglet « Page », choisissez l'option « Ajuster » 1 page en hauteur et 1 page en
largeur comme sur la figure ci-dessous :

IMG. 178 : AJUSTER L’IMPRESSION AU NOMBRE DE PAGES - SPÉCIFIQUE

Le résultat est illisible. Il faut revenir à une taille normale de caractères et gérer les
titres de lignes et de colonnes ainsi que les sauts de pages.
♦ Pour revenir à une taille normale d'impression, choisissez « Réduire/agrandir », et

retapez 100%.

♦ Pour indiquer que vous voulez répéter l'impression de la première ligne et de la
première colonne sur chaque page, revenez à la feuille de calcul, puis appelez le
menu Fichier > Mise en Page, onglet « Feuille ». Sélectionnez la 1ère ligne et la
1ère colonne à répéter (figure ci-dessous) :
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IMG. 179 : RÉPÉTITIONS DES TITRES DE LIGNES ET DE COLONNES - SPÉCIFIQUE

Le nombre total de pages est maintenant passé à 10 au lieu de 6. Certaines pages n'ont
qu'une seule colonne : pour éviter cette mise en page déséquilibrée, vous allez insérer
des sauts de page manuel et augmenter le nombre de colonnes imprimées sur certaines
pages.
♦ En mode aperçu, cliquez sur le bouton « Aperçu des sauts de page », ou en mode

normal, dans la feuille de calcul, appelez le menu Affichage>Aperçu des sauts de
page.

Ce mode permet d'avoir une vue précise des données imprimées sur chaque page.
Pour insérer un saut de page manuel, il suffit de glisser le repère de sauts de page.

Pour avoir une vue générale des sauts de page, utilisez le zoom d'affichage et
réduisez-le à 25%.

♦ Glissez le repère de saut de page pour augmenter d'un le nombre de colonnes
imprimées sur la page 1 et 2, comme sur la figure ci-dessous :
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IMG. 180 : INSÉRER UN SAUT DE PAGE MANUEL - SPÉCIFIQUE

Vous n'avez maintenant plus que 6 pages et aucune page avec une seule colonne.
♦ Vérifiez la mise en page avec l'aperçu. Tout devrait être en ordre. Il ne reste plus

qu'à ajouter un en-tête et un pied de page, et à imprimer.

Cliquez sur le lien ci-dessous afin d'ouvrir l'animation correspondante :

♦ Animation "Création d'un grand tableau dans Microsoft
Office" [http://projet.c2imes.org/V2/tutorielsB5/Chap9/animation_grand_tableau_MS.htm]

Exercice n°81. Exercez-vous ! (Calc)

Vous allez créer un grand tableau de 100 lignes par 20 colonnes en utilisant des séries
incrémentées comme sur la figure ci-dessous (représentant seulement une partie des
100 lignes x 20 colonnes).
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IMG. 181 : PARTIE DU TABLEAU 100 LIGNES X 20 COLONNES - SPÉCIFIQUE

♦ Affichez un aperçu avant impression. Six pages sont nécessaires pour imprimer
l'ensemble du tableau. Certaines pages n'affichent pas le titre des lignes, des
colonnes ou des deux.

♦ Voyez maintenant si vous pouvez ajuster la taille du tableau pour qu'il puisse
s'imprimer sur une seule page.

♦ Menu Format > Page à partir de la feuille de calcul, ou bouton Page à partir de
l'aperçu.

♦ Dans l'onglet « Classeur », choisissez l'option « Adapter » les zones d'impression au
nombre de pages comme sur la figure ci-dessous :
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IMG. 182 : AJUSTER L’IMPRESSION AU NOMBRE DE PAGES - SPÉCIFIQUE

Le résultat est illisible. Il faut revenir à une taille normale de caractères et gérer les
titres de lignes et de colonnes ainsi que les sauts de pages.
♦ Pour revenir à une taille normale d'impression, choisissez « Réduire/agrandir

l'impression », échelle 100%, toujours dans l'onglet « Classeur ».

♦ Pour indiquer que vous voulez répéter l'impression de la première ligne et de la
première colonne sur chaque page, revenez à la feuille de calcul, puis appelez le
menu Format > Zones d'impression > Editer. Sélectionnez la 1ère ligne et la 1ère
colonne à répéter (figure ci-dessous) :

IMG. 183 : RÉPÉTITIONS DES TITRES DE LIGNES ET DE COLONNES - SPÉCIFIQUE
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En rajoutant les titres de lignes et de colonnes, le nombre total de pages a augmenté.

Il y a maintenant 8 pages. Les deux dernières ne contiennent que 2 colonnes : pas très
équilibré. Nous allons augmenter le nombre de colonnes imprimées par page en
insérant des sauts de page manuel.

♦ En mode normal, dans la feuille de calcul, appelez le menu Format > Aperçu des
sauts de page.

Pour avoir une vue générale des sauts de page, utilisez le zoom d'affichage et
réduisez-le à 25%.

Ce mode permet d'avoir une vue précise des données imprimées sur chaque page. Pour
insérer un saut de page manuel, il suffit de glisser le repère de sauts de page.
♦ Glissez le repère de saut de page pour augmenter d'un le nombre de colonnes

imprimées sur la page 1 et 2, comme sur la figure ci-dessous :

IMG. 184 : INSÉRER UN SAUT DE PAGE MANUEL - SPÉCIFIQUE

Il y a maintenant 7 colonnes par page (y compris sur les pages 3 et 4), sauf sur les 2
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dernières pages puisqu'il n'y a pas suffisamment de colonnes à imprimer.

Nous sommes revenus à 6 pages au total avec les titres de lignes et de colonnes.
♦ Vérifiez la mise en page avec l'aperçu. Tout devrait être en ordre. Il ne reste plus

qu'à ajouter un en-tête et un pied de page, et à imprimer.

Cliquez sur le lien ci-dessous afin d'ouvrir l'animation correspondante :

♦ Animation "Création d'un grand tableau dans
OpenOffice" [http://projet.c2imes.org/V2/tutorielsB5/Chap9/animation_grand_tableau_OO.htm]

Partie C. Evaluation

Exercice d'appariement 2. Appariement

Un exercice interactif vous est proposé dans la vesion en ligne

QUESTION N°1

Quelle est la première chose à faire avant d'imprimer une feuille de calcul ?

A Définir les zones d'impression.

B Définir les marges.

C Afficher un aperçu pour se faire une idée de la mise en page.

D Régler les sauts de page.

E Enregistrer le classeur.

Exercice n°82. Exercice 1

Impression sur une seule page.

♦ Reprenez la feuille de calcul de l'exercice 2 du chapitre « Bien présenter un tableau
» sur la gestion d'un restaurant universitaire. Si vous n'avez pas fini l'exercice,
téléchargez-le ici :

Effectuez la mise en page pour que l'impression donne le résultat suivant (à télécharger
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au format PDF ci-dessous ). Vous ne devez pas modifier la feuille de calcul, mais
uniquement sa mise en page.

Voir annexe B en fin de fascicule

IMG. 185 : TABLEAU DES RECETTES À IMPRIMER - SPÉCIFIQUE

Exercice n°83. Exercice 2

Impression d'un grand tableau.

Téléchargez sur le site de l'INSEE, le tableau donnant la population active (au sens du
BIT) pour la France métropolitaine, observée jusqu'en 2002, projetée ensuite au 1er
janvier, et âge atteint en cours d'année.

Vous pouvez également le télécharger ici :

Effectuez la mise en page de ce tableau pour permettre une impression sur 2 pages
seulement. Ajoutez « Statistiques INSEE » en en-tête et le numéro de page en pied de
page. A vous de choisir l'orientation du papier, la taille des marges, les sauts de pages.
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IMG. 186 : STATISTIQUES INSEE - SPÉCIFIQUE

B. Synthèse

Effectuez toujours un aperçu avant d'imprimer une feuille de calcul.

En effet, il est rare que la mise en page par défaut corresponde exactement à ce que
vous souhaitez. L'aperçu affiche ce qui sera réellement imprimé. Vous pouvez alors
modifier les sauts de page et adapter la taille du tableau au nombre de pages à
imprimer. De nombreuses options de mise en page sont disponibles : n'hésitez pas à les
essayer pour obtenir une impression claire et lisible.

Imprimez seulement lorsque l'aperçu avant impression vous donne satisfaction : vous
économiserez beaucoup de papier !
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Chapitre

XI
Incorporer un
tableau et un

graphique dans un
document
composite

Niveau de difficulté : intermédiaire

Très souvent, vous aurez besoin d'intégrer un tableau ou un graphique dans un autre
document, par exemple dans un document texte pour un rapport écrit, ou dans un
diaporama pour une présentation orale. Le document qui intègre ainsi des objets créés
par différentes applications (tableur, traitement de texte, logiciel de présentation, etc.)
est appelé document composite.

Ce chapitre décrit comment créer et gérer ce type de document mêlant texte, tableau et
graphique.

Pré-requis : Savoir créer un tableau et un graphique. Maîtriser les fonctionnalités
élémentaires d'un traitement de texte

Temps d'apprentissage : 45 minutes



Partie A. Les objets OLE

Un mécanisme de collage et de liaison appelé OLE - Object Linking and Embedding,
littéralement « Liaison et incorporation d'objets » - permet l'incorporation de ces objets
dans un document et leur accès direct vers l'application à laquelle ils sont liés.

Un objet OLE (feuille de calcul, graphique, ...) est un objet lié à une application et
collé dans un document composite. Il suffit de double-cliquer sur l'objet pour le
modifier directement par l’application à laquelle il est lié.

Les objets OLE du tableur disponibles dans le traitement de texte sont les tableaux et
les graphiques.

1. Collage d'une feuille de calcul en tant qu'objet OLE

Collage

Attention

L'objet « feuille de calcul » incorporé dépend de l'application à laquelle il est lié. Vous
ne pouvez donc coller un objet « feuille de calcul » Excel que dans un traitement de
texte Microsoft, et un objet « feuille de calcul » Calc que dans le traitement de texte
d'OpenOffice.

Vous pouvez modifier l'objet par le tableur à partir d'un double-clic sur l'objet puisque
le lien avec le tableur est conservé.
Modification de l’objet incorporé

Lorsque vous double-cliquez sur un objet incorporé, l'application à laquelle cet objet
est lié est appelée et l'objet peut être directement modifié.
♦ Double-cliquez sur la feuille de calcul incorporé au document texte,

♦ Observez ce qui se passe...

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

204 MODULE B4 - REALISER DES DOCUMENTS DESTINES A ETRE IMPRIMES – TABLEURS



IMG. 188 : MODIFICATION DE LA FEUILLE DE CALCUL INCORPORÉE - SPÉCIFIQUE CALC

L'objet est entouré d'une ligne grisée et apparaît comme une feuille de calcul Calc.

Les menus et barres d'outils de Calc ont remplacé ceux de Writer. Et pourtant, vous
êtes toujours dans la fenêtre de Writer (barre de titre de l'application) !
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Collage avec et sans liaison

Lorsque vous avez collé le tableau en tant que feuille de calcul, vous avez eu le choix
entre coller avec ou sans liaison :

IMG. 189 : COLLAGE AVEC OU SANS LIAISON - SPÉCIFIQUE

Si le collage spécial a été réalisé sans liaison avec le fichier source, la modification
directe de l'objet incorporé ne modifie pas ce fichier. Le collage avec liaison est un
simple raccourci vers le fichier source et la modification porte sur ce fichier. L'option
par défaut est le collage « sans liaison ».

Conseil

Utilisez le collage avec liaison si vous voulez enregistrer vos modifications dans le
classeur Excel, et pas uniquement dans la feuille incorporée au texte.

Exercice n°84. Exercez-vous !

Dans le tableur, sélectionnez le tableau, plage A4:H10, puis copiez-le dans le
traitement de texte. Placez votre curseur sous le titre 1, puis faites un collage spécial en
tant qu'objet « feuille de calcul » comme ci-dessous :

"Spécifique Excel"

Une image explicative "Options de collage d’une feuille de calcul comme objet OLE" vous est
proposée en Annexes "Pour aller plus loin ..."
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IMG. 191 : OPTIONS DE COLLAGE D’UNE FEUILLE DE CALCUL COMME OBJET OLE - SPÉCIFIQUE CALC

Un fois collé, sélectionnez l'objet dans le traitement de texte et remarquez ses bordures
avec ses poignées de redimensionnement. Par le menu contextuel, notez également les
propriétés de l'objet incorporé et les actions possibles comme copier, coller, modifier,
... :

"Spécifique Excel"

Une image explicative "Document texte après incorporation du tableau en tant qu’objet
OLE" vous est proposée en Annexes "Pour aller plus loin ..."

La barre d'état propose de double-cliquer pour modifier la feuille de calcul.
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IMG. 193 : DOCUMENT TEXTE APRÈS INCORPORATION DU TABLEAU EN TANT QU’OBJET OLE - SPÉCIFIQUE CALC

La zone de style indique l'incorporation d'un objet « OLE ».

Exercice n°85. Exercez-vous ! (Excel)

Modifiez la couleur des caractères de la plage A4:A8 : eh oui, c'est bien Excel !

Cliquez en dehors de l'objet feuille de calcul.
Observez l'apparence de l'objet : vous êtes de retour dans le traitement de texte et les
modifications sont prises en compte.
Revenez au tableur.
Notez que la modification ne s'est pas répercutée dans le tableau d'origine, mais
uniquement dans l'objet incorporé : l'objet n'a pas été collé avec liaison.

Exercice n°86. Exercez-vous ! (Calc)

Modifiez la couleur des caractères de la plage A4:A8 : eh oui, c'est bien Calc !
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Cliquez en dehors de l'objet feuille de calcul.
Observez l'apparence de l'objet : vous êtes de retour dans le traitement de texte et les
modifications sont prises en compte.
Revenez au tableur.
Notez que la modification ne s'est pas répercutée dans le tableau d'origine, mais
uniquement dans l'objet incorporé.

2. Collage en tant qu'objet graphique du tableur

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Sélectionnez maintenant le graphique en bâtons dans la feuille de calcul, et copiez-le
dans le traitement de texte en tant que Star Object Descriptor (XML).

IMG. 196 : OPTIONS DE COLLAGE D’UN GRAPHIQUE COMME OBJET OLE - SPÉCIFIQUE CALC

Double-cliquez sur l'objet incorporé, vérifiez la présence des menus graphiques de
Calc : vous pouvez modifier le graphique comme vous le feriez dans Calc.
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IMG. 197 : MODIFICATION DU GRAPHIQUE INCORPORÉ - SPÉCIFIQUE CALC

L'objet est entouré d'une ligne grisée et apparaît comme une feuille graphique Calc.
Comme pour l'incorporation d'une feuille de calcul, les menus et barres d'outils de
Calc ont remplacé ceux de Writer. Et pourtant, vous êtes toujours dans la fenêtre de
Writer (barre de titre de l'application) !

Le collage étant sans liaison, la modification du graphique n'affectera pas le graphique
d'origine.

Partie B. Collage en tant qu'image

En collant un tableau ou un graphique du tableur en tant qu'image dans le traitement de
texte, vous perdez le lien avec le tableur : l'image ne peut plus être mise à jour à partir
des données du tableur. L'image collée n'est plus un objet OLE. Par contre, vous
pouvez retoucher l'image par les outils de dessin du traitement de texte.
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1. Les formats d'images

Deux formats d'images sont possibles :
♦ Les images « bitmap » ou en mode point : ce sont des images décrites pixel par

pixel.

- Avantage
Elles sont affichées rapidement.

- Inconvénients
- Elles occupent un volume de stockage important. Le collage d'une image «

bitmap » dans un texte augmente sensiblement la taille du fichier texte.
- Elles ne peuvent pas être redimensionnées sans perte de qualité.

♦ Les images de type « métafichier » : ce sont des fichiers décrivant la façon de
dessiner l'image.

- Avantages
- Elles occupent peu de volume de stockage : un document dans lequel une image

métafichier est collée prend peu d'espace.
- Elles peuvent être redimensionnées sans perte de qualité.

- Inconvénients
Elles sont affichées moins rapidement que les images bitmap (au moins pour des
images complexes).

2. Application au collage du tableau

Attention

Vous ne pouvez plus modifier directement les données du tableau par le tableur.

En tant qu'image, vous pouvez la retoucher par les outils de traitement d'image du
traitement de texte.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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IMG. 199 : DOCUMENT TEXTE APRÈS COLLAGE DU TABLEAU EN TANT QU’IMAGES - SPÉCIFIQUE CALC

La sélection de l'objet fait apparaître la palette « Image » permettant sa modification.

Le menu contextuel est associé au type « Image ».
La zone de style indique le type « image ».

♦ Notez la différence de qualité entre l'image « bitmap » et l'image « métafichier ».

Exercice n°87. Exercez-vous !

Copiez le tableau A4:A10.

Le tableau étant dans le presse-papier, collez-le maintenant dans le traitement de texte
après le tableau précédent, en tant qu'image au format métafichier, puis au format
bitmap.
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Une fois collé, sélectionnez l'objet dans le traitement de texte et remarquez ses
bordures avec ses poignées de redimensionnement.

Par le menu contextuel, notez également les propriétés de l'objet incorporé et les
actions possibles comme copier, coller, modifier, ...

3. Application au collage du graphique

Les graphiques du tableur peuvent être collés en tant qu'image « métafichier ».

L'option « bitmap » n'est pas proposée : la qualité de l'image est ainsi optimale.

Exercice n°88. Exercez-vous !

Faites un collage spécial du graphique en bâtons en tant qu'image.

Vous ne pouvez maintenant plus modifier les paramètres du graphe, mais vous pouvez
retoucher l'image par les outils de dessin du traitement de texte.
Observez les différences de qualité entre l'image « bitmap » et l'image « métafichier ».

Partie C. Collage de type « Texte »

En collant un tableau du tableur en tant que texte dans le traitement de texte (les
graphiques ne sont pas concernés), vous perdez le lien avec le tableur : le tableau collé
ne peut plus être mis à jour à partir des données du tableur. Le tableau collé n'est plus
un objet OLE. Par contre, étant de type texte, vous pouvez, et c'est normal, le modifier
directement dans le traitement de texte.

Après un collage au format texte, vous ne pouvez plus modifier directement le tableau
par l'intermédiaire du tableur, mais uniquement avec le traitement de texte. Vous ne
pouvez pas coller de graphique avec ce type de collage.
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1. Les formats de texte

Trois formats de texte sont possibles :
♦ Le format HTML « HyperText Markup Language »

Format standard du web qui décrit le contenu et la forme du tableau.

C'est le moyen le plus sûr pour coller un tableau dans une autre application, tout en
conservant la mise en forme. Vous pouvez ainsi coller une feuille de calcul Excel
dans le traitement de texte d'OpenOffice.

♦ Le format RTF (Rich Text Format - format de texte enrichi)
La mise en forme est obtenue par un langage de description reconnu par la plupart
des logiciels de traitement de texte, mais diversement interprété.

Préférez le format HTML, plus standardisé.

♦ Le format texte brut non formaté
Seul le contenu des cellules du tableau est récupéré. Il vous faut redéfinir les
tabulations perdues et remettre en forme l'ensemble. Ce type de collage présente peu
d'intérêt. A n'utiliser que si aucun autre type de collage ne donne de résultats.

2. Application

Collage au format HTML

Le tableau A4:H10 étant copié dans le presse-papier, collez-le maintenant dans le
traitement de texte en tant que format HTML.

Une fois collé, vous remarquerez que l'objet collé se comporte comme un tableau que
vous auriez pu créer dans le traitement de texte : le lien avec le tableur n'existe plus.

Vous pouvez modifier les éléments du tableau et le redimensionner avec les outils du
traitement de texte.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."
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IMG. 201 : DOCUMENT TEXTE APRÈS COLLAGE DU TABLEAU AU FORMAT HTML - SPÉCIFIQUE CALC

Collage au format RTF

Le tableau étant toujours copié dans le presse-papier, collez-le en tant que texte au
format RTF.

Le résultat est analogue au format HTML, mais certaines mises en forme peuvent être
perdues.
Collage au format texte brut

Le tableau étant toujours copié dans le presse-papier, collez-le en tant que texte non
mis en forme.

Comme prévu, vous devez remettre en forme le tableau. Evitez cette option !

IMG. 202 : COLLAGE D’UN TEXTE NON FORMATÉ - SPÉCIFIQUE

Conseil

♦ Evitez de coller en tant que texte RTF ou texte non formaté.

♦ Privilégiez le format HTML pour conserver la mise en forme de vos tableaux.
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A. Animations de synthèse

Les différents types de collage de tableau

Si vous souhaitez voir une animation montrant les différents types de collage de
tableau, cliquez sur un des liens ci-dessous afin de découvrir l'animation associée,
selon la suite bureautique choisie :

♦ Animation "Les différents types de collage dans
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap10/animation_objet_feuille_MS.htm]

♦ Animation "Les différents types de collage dans
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap10/animation_objet_feuille_OO.htm]

Les différents types de collage de graphique

Si vous souhaitez voir une animation montrant les différents types de collage de
graphique, cliquez sur un des liens ci-dessous afin de découvrir l'animation associée,
selon la suite bureautique choisie :

♦ Animation "Les différents types de collage graphique dans
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap10/animation_objet_graphique_MS.htm]

♦ Animation "Les différents types de collage graphique dans
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap10/animation_objet_graphique_OO.htm]

Partie D. Evaluation

QUESTION N°1

Vous souhaitez inclure un tableau créé par un tableur dans un document texte, et vous voulez
pouvoir le modifier dans le tableur.

Quel type de collage faites-vous ?

A 1) Texte RTF

B 2) Objet OLE

C 3) Image « bitmap »

D 4) Image « métafichier »

E 5) HTML
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QUESTION N°2

Les possibilités de mise en forme de caractères étant réduites dans le tableur, vous souhaitez
transférer un tableau dans un traitement de texte.

Quel type de collage allez-vous faire (2 possibilités) ?

A 1) Texte RTF

B 2) Objet OLE

C 3) Image « bitmap »

D 4) Image « métafichier »

E 5) HTML

F 6) Texte brut

QUESTION N°3

Le document dans lequel vous allez coller votre tableau est destiné à être diffusé à un maximum
de personnes.

Parmi ces types de collage, lesquels leur permettront de récupérer facilement les données ?

A 1) Texte RTF

B 2) Objet OLE

C 3) Image « bitmap »

D 4) Image « métafichier »

E 5) HTML

F 6) Texte brut
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QUESTION N°4

Vous souhaitez coller un graphique dans un document texte.

Parmi ces types de collage, quelles sont les deux options qui donneront les meilleurs résultats ?

A 1) Texte RTF

B 2) Objet OLE

C 3) Image « bitmap »

D 4) Image « métafichier »

E 5) HTML

F 6) Texte brut

Exercice n°89. Exercice

Coller une feuille de calcul complète avec tableau et graphique.

Dans un traitement de texte, incorporez le tableau et le graphique des statistiques
d'emplois, en une seule étape de façon à pouvoir faire la mise à jour de l'un ou de
l'autre.

Vous pouvez reprendre votre propre fichier si vous l'avez, ou le télécharger ici.

Portez le nombre d'emplois industriels en 2003 à 300 000.

Vérifiez la mise à jour du graphique.

Ajoutez un pied de page avec divers renseignements, dont le numéro de page.

Votre page devrait avoir l'aspect suivant :
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IMG. 203 : APERÇU DU DOCUMENT TEXTE APRÈS INCORPORATION DU TABLEAU ET DU GRAPHIQUE - SPÉCIFIQUE
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B. Synthèse

Il existe plusieurs façons de coller un tableau ou un graphique créés par un tableur
dans un document texte ou une diapositive de présentation. Le choix dépend de
l'utilisation qui en sera faîte.

♦ Si le tableau ou le graphique sont collés comme objet OLE, ils gardent le lien avec
le tableur et leur accès direct est possible.

♦ Si le tableau ou le graphique sont collés comme image, ils perdent le lien avec le
tableur et la modification des données n'est plus possible. Les images de type «
métafichier » sont celles qui donnent le meilleur résultat.

♦ Enfin, pour coller un tableau comme texte directement modifiable dans le traitement
de texte, le format HTML est le plus adapté.
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Chapitre

XII
Exercice de

synthèse



Niveau de difficulté : intermédiaire

Vous voilà au bout de vos efforts. Vous avez appris les fonctionnalités de base du
tableur et réalisé les exercices proposés au cours des chapitres de ce module. Ce
dernier chapitre vous propose une étude de cas qui reprend les notions et compétences
que vous devriez avoir assimilées. Il vous permet aussi de vous positionner et, en cas
d'hésitations, de vous permettre de revenir en arrière dans le module pour revoir les
chapitres qui vous ont un peu échappés. Maintenant, à vous de jouer !!!

Durée estimée du chapitre : 45 minutes

Il s'agit de représenter les budgets successifs alloués à l'action sociale de l'université de
Cédeuzy entre 2002 et 2005 à partir des données à saisir ou à télécharger ici.

♦ Excel :

♦ Calc :

IMG. 204 : TABLEAU BRUT DE L’ACTION SOCIALE DE L’UNIVERSITÉ DE CÉDEUZY - SPÉCIFIQUE

Pour bien mettre en évidence ce budget, vous allez créer 3 tableaux et 2 graphiques.
Les tableaux seront imprimés séparément sur une seule feuille, et chaque graphique
sera également imprimé sur une feuille.

Enfin, vous réaliserez un document composite présentant le tableau 1 et les deux
graphiques.
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A. Réaliser les tableaux

Chapitres associés :

♦ « Saisir les données d'un tableau »,

♦ « Ecrire des formules simples »,

♦ « Utiliser des fonctions dans les formules »,

♦ « Utiliser la recopie des formules et les références relatives et absolues »,

♦ « Tri et filtres ».

Tableau 1

♦ Calcul de la totalité des sommes allouées par année,

♦ Calcul de la totalité des sommes allouées pour chaque aide sur l'ensemble des 4
années (budget quadriennal),

♦ Tri du tableau par ordre croissant du montant des aides allouées au budget
quadriennal (somme des 4 années pour chaque aide).

Tableau 2

♦ Calcul du pourcentage de chacune des aides par rapport au budget annuel.
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Tableau 3

♦ Calcul du pourcentage de la somme globale de chaque année par rapport à la somme
globale de 2005 prise comme année de référence.

IMG. 205 : UNE IDÉE DE FEUILLE DE CALCUL - SPÉCIFIQUE

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Cliquez sur le lien suivant afin de découvrir l'animation : Animation "Réalisation de
tableau dans
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap11/actionsociale_tableaux_OO.htm]
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B. Mettre en forme les tableaux

Chapitre « Bien présenter un tableau ».

♦ Mettez en évidence les éléments importants des tableaux, par les formats de
caractères, les bordures, les arrière-plans, etc.

IMG. 206 : UNE IDÉE DE PRÉSENTATION - SPÉCIFIQUE

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Cliquez sur le lien suivant afin de découvrir l'animation : Animation "Mettre en forme
un tableau dans
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap11/actionsociale_presentation_OO.htm]

C. Mettre en page et imprimer la feuille de calcul

Chapitre « Imprimer une feuille de calcul ».
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♦ Réalisez la mise en page des 3 tableaux pour une impression sur une seule feuille,
avec un en-tête et un pied de page donnant les informations « nom de fichier », «
numéro de page », « date ».

Voir annexe D en fin de fascicule

Voir annexe E en fin de fascicule

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Cliquez sur le lien suivant afin de découvrir l'animation : Animation "Mettre en page
et imprimer la feuille de calcul dans
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap11/actionsociale_impression_OO.htm]

D. Créer les graphiques

Chapitre « Réaliser un graphique à partir d'un tableau ».

♦ Choisissez et réalisez les graphiques les plus adaptés aux représentations suivantes :

Graphique n°1 : l'évolution des aides sur les 4 ans

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Voir annexe G en fin de fascicule - Spécifique Calc

Cliquez sur le lien suivant afin de découvrir l'animation : Animation "Solution à
l'exercice numéro 1 dans
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap11/actionsociale_graphique_aires_OO.htm]
Graphique n°2 : la répartition des aides en 2005

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Voir annexe I en fin de fascicule - Spécifique Calc
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Cliquez sur le lien suivant afin de découvrir l'animation : Animation "Solution à
l'exercice numéro 2 dans
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap11/actionsociale_graphique_secteurs_OO.htm]

E. Incorporer le tableau et les deux graphiques dans
un document texte

Chapitre « Incorporer un tableau et un graphique dans un document composite ».

♦ Créez, dans un traitement de texte, un document qui présente sur la même page, le
tableau 1 et les deux graphiques créés précédemment.

Rajoutez un titre principal et 3 titres de niveau 2 présentant le tableau, et les 2
graphiques.

Voir annexe J en fin de fascicule

Si vous n'avez pas réalisé les parties précédentes, vous pouvez télécharger les tableaux
et les graphiques ici.

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

"Spécifique Excel"

Le contenu de cette section vous est proposé en Annexes "Pour aller plus loin ..."

Cliquez sur le lien suivant afin de découvrir l'animation : Animation "Solution à
l'exercice dans
OpenOffice" [http://projet.c2imes.org/V2/tutorielsB5/Chap11/document_composite_OO.htm]
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F. Synthèse

Vous avez réussi cet exercice de synthèse ? Eh bien bravo ! Vous maîtrisez les
fonctionnalités de base du tableur.

Le tableur recèle bien d'autres fonctionnalités très utiles, voire étonnantes, et ce
module vous aura certainement donné envie d'aller plus loin. Alors, n'hésitez pas !
Interrogez votre moteur de recherches favori, fréquentez les forums de discussion sur
les tableurs, allez au rayon informatique de la librairie du coin, vous verrez que ce ne
sont pas les ressources qui manquent... Bonne découverte !

♦ Quelques liens de Webographie :
- OpenOffice [http://fr.openoffice.org/Documentation/Index.html]

Documentations, guides, tutoriaux réalisés par les membres bénévoles de la
communauté OpenOffice.org.

- Le tableur par OpenOffice.org [http://www.framasoft.net/article3640.html]
25 fiches pour apprendre le tableur.

- Introduction à la notion de
tableur [http://www.commentcamarche.net/tableur/tablintro.php3]

- Le site de vulgarisation informatique.
- Formation Excel

2000 [http://www.informatiquepourtous.com/formation/bureautique/excel/xl0011.php]
- Formation en bureautique sur le site informatique pour tous.

♦ Les forums de discussion
- http://www.forum-openoffice.org/forum/ [http://www.forum-openoffice.org/forum/]
- microsoft.public.fr.excel [http://microsoft.public.fr.excel]
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Corrigés des exercices

Voici les réponses aux Exercices de Classement
Le corrigé de cet exercice interactif vous est proposé dans la vesion en ligne

Le corrigé de cet exercice interactif vous est proposé dans la vesion en ligne





Corrigés des exercices

Corrigé de l'exercice n°6 : Explorez toute la feuille de calcul !

Question n°1

Après la référence de colonne Z, la numérotation continue à AA, AB ... jusqu'à AZ,
puis BA... etc. ... jusqu'à IV. Au total, le tableur présente 256 colonnes.

Question n°2

Pourquoi 65536 ?

65536 correspond à 216, ce qui est une valeur courante en informatique. Le numéro de
ligne peut donc être codé sur 16 bits.

Corrigé de l'exercice n°7 : Exercez-vous !

IMG. 207 : SÉLECTION D’UNE PLAGE DE CELLULES - SPÉCIFIQUE

MS Excel définit l'ancre B2 de la plage (la cellule à partir de laquelle la souris a glissé)
dans la zone de nom. La cellule active de la sélection est l'ancre.



IMG. 208 : SÉLECTION D’UNE PLAGE DE CELLULES - SPÉCIFIQUE

OpenOffice Calc indique la plage complète dans la zone de nom. La cellule active de
la plage de cellules est la dernière cellule de la sélection.

Corrigé de l'exercice n°9 : Exercez-vous !

Cliquez sur le lien suivant afin de visualiser l'animation.

Animation "Insérer une feuille avec la souris dans Microsoft
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap1/capture_1-13_MS.swf.html]

Cliquez sur le lien suivant afin de visualiser l'animation.

Animation "Insérer une feuille avec la souris dans OpenOffice
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap1/capture_1-13_OO.swf.html]

Corrigé de l'exercice n°13 : Enoncé 4

IMG. 209 : VOICI LE RÉSULTAT ATTENDU - SPÉCIFIQUE

Corrigé de l'exercice n°16 : Exercez-vous !

Vous devriez obtenir la feuille de calcul suivante :

"Spécifique Excel"

Une image explicative "Résultat de la saisie" vous est proposée en Annexes "Pour aller plus loin
..."
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IMG. 211 : RÉSULTAT DE LA SAISIE - SPÉCIFIQUE CALC

Corrigé de l'exercice n°17 : Exercez-vous !

En mélangeant des nombres et du texte en C4, l'ensemble est considéré comme de type
texte et aligné à gauche par défaut. Pour réaliser des calculs sur la taille, il faut mettre
la valeur 1,82 dans la cellule C5, et l'unité de mesure (le mètre) dans la cellule D5
adjacente.

Corrigé de l'exercice n°19 : Exercez-vous !

Effacer le contenu et/ou le format ne supprime pas la cellule. Une autre commande
permet de réaliser cette suppression.

Corrigé de l'exercice n°20 : Exercez-vous !

Solution sous forme d'animation.

♦ Microsoft Office Excel :

- Cliquez sur le lien suivant afin de visualiser l'animation.
Animation "Solution sous Microsoft
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap2/Exercice_Formats_MS.htm]

♦ OpenOffice Calc :

- Cliquez sur le lien suivant afin de visualiser l'animation.
Animation "Solution sous
OpenOfficeCalc" [http://projet.c2imes.org/V2/tutorielsB5/Chap2/Exercice_Formats_OO.htm]

Si les caractères ### apparaissent, c'est que la colonne est trop étroite pour afficher la
donnée entièrement. Pour augmenter la largeur d'une colonne, pointez le trait de

Corrigés des exercices 233



séparation des colonnes dans la barre des coordonnées (en-têtes de colonnes A,B,C,...),
et glissez la souris.

Cliquez sur les liens qui suivent afin de visualiser l'animation correspondante.
♦ Animation "Excel : Augmenter la largeur d’une

colonne" [http://projet.c2imes.org/V2/tutorielsB5/Chap2/capture_001_MS.htm]

♦ Animation "Calc : Augmenter la largeur d’une
colonne" [http://projet.c2imes.org/V2/tutorielsB5/Chap2/capture_001_00.htm]

Corrigé de l'exercice n°21 : Une petite énigme…

Question n°1

39115,5625. Vérifiez en formatant cette valeur pour afficher la date et l'heure.

Corrigé de l'exercice n°23 : Une histoire d'arrondis

Question n°1

La valeur est affichée avec un arrondi supérieur.

Corrigé de l'exercice n°24 : Exercez-vous !

♦ Calc
Par défaut, le nombre de décimales affichées est de 2. Pour modifier cette option,
utilisez le menu Outils > Options > OpenOffice.org Calc > Calcul : Décimales.

Corrigé de l'exercice n°26 : Exercez-vous !

IMG. 212 : CALENDRIER : RÉSULTAT FINAL AVEC 4 RECOPIES - SPÉCIFIQUE

Cliquez sur le lien suivant afin de visualiser l'animation :

♦ Animation de
solution [http://projet.c2imes.org/V2/tutorielsB5/Chap2/capture_007.htm]
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Corrigé de l'exercice n°28 : Enoncé 1

Cliquez sur les liens suivants afin de visualiser les solutions pour Excel ou Calc sous
forme d'animation.

♦ Corrigé pour Microsoft
Excel [http://projet.c2imes.org/V2/tutorielsB5/Chap2/Evaluation_1_corrige_MS.htm]

♦ Corrigé pour OpenOffice
Calc [http://projet.c2imes.org/V2/tutorielsB5/Chap2/Evaluation_1_corrige_OO.htm]

Corrigé de l'exercice n°29 : Enoncé 2

Cliquez sur les liens suivants afin de visualiser les solutions pour Excel ou Calc sous
forme d'animation.

♦ Corrigé pour Microsoft
Excel [http://projet.c2imes.org/V2/tutorielsB5/Chap2/Evaluation_2_corrige_MS.htm]

♦ Corrigé pour OpenOffice
Calc [http://projet.c2imes.org/V2/tutorielsB5/Chap2/Evaluation_2_corrige_OO.htm]

Corrigé de l'exercice n°30 : Enoncé 3

Cliquez sur les liens suivants afin de visualiser les solutions pour Excel ou Calc sous
forme d'animation.

♦ Corrigé pour Microsoft
Excel [http://projet.c2imes.org/V2/tutorielsB5/Chap2/Evaluation_3_corrige_MS.htm]

♦ Corrigé pour OpenOffice
Calc [http://projet.c2imes.org/V2/tutorielsB5/Chap2/Evaluation_3_corrige_OO.htm]
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Corrigé de l'exercice n°33 : Exercez-vous !

Question n°1

IMG. 213 : RÉSULTAT FORMULE ? - SPÉCIFIQUE

Solution :

8. En effet, l'opérateur « * » a priorité sur l'opérateur « + ». Le calcul 2*A2 est donc
d'abord réalisé, puis le résultat est ajouté à A1.

Question n°2

Solution :

4. L'opération -A1 est d'abord effectuée, suivie du calcul 2*A2. A la fin les deux
résultats sont ajoutés.

Question n°3

Solution :

5. Les opérateurs « * » et « / » ont la même priorité, supérieure à l'opérateur « + ».
L'expression 4*A2/A3 est donc d'abord évaluée, de gauche à droite : 4*A2. Le résultat
est ensuite divisé par A3 puis ajouté à A1.

Question n°4

Solution :

4,5. (A1+4) est d'abord évalué, puis le résultat est multiplié par A2. Le résultat de cette
multiplication est enfin divisé par A3.
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Question n°5

Solution :

-15. (A3+1) et (A1/2) sont d'abord évalués, puis -5 et A2^1 et enfin -5 et 3 sont
multipliés.

Corrigé de l'exercice n°34 : Enoncé n°1

Question n°1

Seules les cellules D2 et E2 contiennent des formules. Toutes les autres contiennent
des données.

Question n°2

Cliquez sur le lien suivant afin de visualiser l'animation :

♦ Animation de
solution [http://projet.c2imes.org/V2/tutorielsB5/Chap3/Enonce_1_solution.htm]

Corrigé de l'exercice n°35 : Enoncé n°2

En E2, vous obtenez la formule « =(1+TVA)*D2 ».

Corrigé de l'exercice n°36 : Enoncé n°3

Formule de calcul des annuités :
♦ V0 : montant du capital emprunté.

♦ i : taux d'intérêt annuel.

♦ n : nombre d'annuités.

♦ a : montant de l'annuité.

IMG. 214 : FORMULE DE CALCUL DES ANNUITÉS - SPÉCIFIQUE

Question n°2

L'annuité est de 1552,26 €
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IMG. 215 : TABLEAU ANNUITÉS - SPÉCIFIQUE

Question n°3

Il faut calculer le taux t mensuel équivalent avec la formule :

IMG. 216

(Le banquier se contente en général de diviser le taux annuel i par 12 !), puis utiliser la
formule suivante :

IMG. 217 : CALCUL DES MENSUALITÉS - SPÉCIFIQUE

Question n°4

127,33 €
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IMG. 218 : TABLEAU MENSUALITÉS - SPÉCIFIQUE

Pour Excel :

Pour Calc :

Corrigé de l'exercice n°37 : Exercez-vous !

=SOMME(D1:D5)/NB(D1:D5)

Corrigé de l'exercice n°38 : Entrainez-vous !

Question n°1

D2 : =ENT(A2

D3 : =ARRONDI.SUP(A3 ;B3)
D4 : =RACINE(A4)
D5 : = PI()

Question n°2

D2 : =AUJOURDHUI()

D3 : =DATE(A3 ;B3 ;C3)
D4 : =JOURS360(A4 ;B4)

Question n°3

D2 : =MAJUSCULE(A2)

D3 : =CONCATENER(A3 ;B3)
D4 : =MAJUSCULE(CONCATENER(A4 ;B4))
D5 : =CHERCHE(B5 ;A5)
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Question n°4

=SI(A2>B2 ; " Plus grand " ; " Plus petit ")

=SI(A2>B2 ; " Plus grand " ; SI(A2<B2 ;" Plus petit " ; " Egal ")

Corrigé de l'exercice n°39 : Enoncé 1

Question n°1

♦ A1 : 45

♦ A2 : =RADIANS(A1)

♦ B1 : =COS(A2)

♦ B2 : =SIN(A2)

♦ B3 : =TAN(A2)

Corrigé de l'exercice n°40 : Enoncé 2

Question n°1

=ENT(ALEA()*49+1)

Corrigé de l'exercice n°41 : Enoncé 3

Corrigé de l'exercice n°42 : Exercez-vous !

Question n°1

« =1,196*E1 »

Question n°2

« =1,196*A5 »

Question n°3

« =1,196*E7 »

Corrigé de l'exercice n°45 : Enoncé 1

Question n°1

En B3: « =B1*B2 » ; en B5 : « =B3*(1+$F$1)».
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Corrigé de l'exercice n°46 : Enoncé 2

« =B3*(1+$F$2) » : la TVA ayant été déplacée, la formule qui y fait référence est
modifiée.

Corrigé de l'exercice n°47 : Enoncé 3

Aucune ! Les références des cellules B5 et C5 n'ont pas changé de place.

Corrigé de l'exercice n°48 : Enoncé 4

4 formules seraient modifiées : les 2 prix total HT et les 2 prix total TTC.

En effet, ces prix sont calculés à partir des données qui ont été déplacées d'une ligne.
Pour chacune des formules, 2 références ont été transformées, soit 8 références en tout.

Corrigé de l'exercice n°49 : Enoncé 5

en B2 : « =$A2*B$1 » .

Si vous ne bloquez pas la première colonne, le A se transformera dans les copies sur
les colonnes suivantes. Si vous ne bloquez pas la ligne 1, ce numéro se transformera
dans les copies sur les lignes suivantes.

Corrigé de l'exercice n°50 : Enoncé 6

♦ Chargez le fichier :

Cliquez sur le lien suivant afin de visualiser l'animation : Animation de synthèse de cet
exercice [http://projet.c2imes.org/V2/tutorielsB5/Chap5/exercice_6_corrige.htm]

Corrigé de l'exercice n°51 : Exercez-vous !

Et pour bien comprendre, une petite animation!

Cliquez sur les liens qui suivent afin d'ouvrir l'animation associée :
♦ Animation "Solution dans

Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap6/animation_fusion_MS.htm]

♦ Animation "Solution dans
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap6/animation_fusion_OO.htm]
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Corrigé de l'exercice n°52 : Exercez-vous !

Et pour bien comprendre, une petite animation!

Cliquez sur les liens qui suivent afin d'ouvrir l'animation associée :
♦ Animation "Solution dans

Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap6/format_police_MS.htm]

♦ Animation "Solution dans
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap6/format_police_OO.htm]

Corrigé de l'exercice n°55 : Exercice 1

Le corrigé pour Excel : cliquez sur le lien qui suit afin d'ouvrir l'animation, puis ouvrez
le document .XLS présentant la correction.

♦ Animation "Corrigé de l'exercice pour
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap6/animation_exercice_1_corrige.htm]

Le corrigé pour Calc : cliquez sur le lien qui suit afin d'ouvrir l'animation, puis ouvrez
le document .ODS présentant la correction.

♦ Animation " Corrigé de l'exercice pour
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap6/animation_exercice_1_OO_corrige.htm]

Corrigé de l'exercice n°56 : Exercice 2

Suggestion de présentation pour Excel :

♦ Cliquez sur le lien suivant pour ouvrir l'animation associée : Animation "Corrigé
pour Excel sous forme
d'animation" [http://projet.c2imes.org/V2/tutorielsB5/Chap6/animation_exercice_2_MS_corrige.htm]
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IMG. 219 : TABLEAU 2 MIS EN FORME (EXCEL) - SPÉCIFIQUE

Suggestion de présentation pour Calc :

♦ Cliquez sur le lien suivant pour ouvrir l'animation associée : Animation "Corrigé
pour Calc sous forme
d'animation" [http://projet.c2imes.org/V2/tutorielsB5/Chap6/animation_exercice_2_OO_corrige.htm]

IMG. 220 : TABLEAU 2 MIS EN FORME (CALC) - SPÉCIFIQUE
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Corrigé de l'exercice n°62 : Exercice 1

Cliquez sur les liens suivants afin d'ouvrir l'animation correspondante vous présentant
la solution à l'exercice, dans la suite bureautique indiquée :

♦ Animation "Solution pour
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap7/animation_exercice_1_MS.htm]

♦ Animation "Solution pour
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap7/animation_exercice_1_OO.htm]

Corrigé de l'exercice n°63 : Exercice 2

Cliquez sur les liens suivants afin d'ouvrir l'animation correspondante vous présentant
la solution à l'exercice, dans la suite bureautique indiquée :

♦ Animation "Solution pour
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap7/animation_exercice_2_MS.htm]

♦ Animation "Solution pour
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap7/animation_exercice_2_OO.htm]

Corrigé de l'exercice n°75 : Exercice 1

Question n°1

Cliquez sur un des liens suivants afin de découvrir l' animation associée, en fonction
de la suite bureautique de votre choix :

♦ Animation "Solution à l'exercice pour
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap8/animation_exercice_1_MS.htm]

♦ Animation "Solution à l'exercice pour
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap8/animation_exercice_1_OO.htm]

Corrigé de l'exercice n°76 : Exercice 2

Question n°1

Cliquez sur un des liens suivants afin de découvrir l' animation associée, en fonction
de la suite bureautique de votre choix :
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♦ Animation "Solution à l'exercice pour
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap8/animation_exercice_2_MS.htm]

♦ Animation "Solution à l'exercice pour
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap8/animation_exercice_2_OO.htm]

Corrigé de l'exercice n°77 : Exercice 3

Question n°1

Cliquez sur un des liens suivants afin de découvrir l' animation associée, en fonction
de la suite bureautique de votre choix :

♦ Animation "Solution à l'exercice pour
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap8/animation_exercice_3_MS.htm]

♦ Animation "Solution à l'exercice pour
Calc" [http://projet.c2imes.org/V2/tutorielsB5/Chap8/animation_exercice_3_OO.htm]

Corrigé de l'exercice n°82 : Exercice 1

Cliquez sur un des liens suivants afin de visualiser l'animation associée, selon la suite
bureautique choisie :

♦ Animation "Solution à l'exercice pour Microsoft
Office" [http://projet.c2imes.org/V2/tutorielsB5/Chap9/bilan_corrige_MS.htm]

♦ Animation "Solution à l'exercice pour
OpenOffice" [http://projet.c2imes.org/V2/tutorielsB5/Chap9/bilan_corrige_OO.htm]

Corrigé de l'exercice n°83 : Exercice 2

Cliquez sur un des liens suivants afin de visualiser l'animation associée, selon la suite
bureautique choisie :

♦ Animation "Solution à l'exercice pour Microsoft
Office" [http://projet.c2imes.org/V2/tutorielsB5/Chap9/insee_MS.htm]

♦ Animation "Solution à l'exercice pour
OpenOffice" [http://projet.c2imes.org/V2/tutorielsB5/Chap9/insee_OO.htm]

Corrigé de l'exercice n°89 : Exercice
Voir annexe C en fin de fascicule
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Cliquez sur un des liens suivants afin de visualiser l'animation correspondante, selon la
suite bureautique choisie :

♦ Animation "Solution à l'exercice pour Microsoft
Office" [http://projet.c2imes.org/V2/tutorielsB5/Chap10/animation_exercice_1_MS.htm]

♦ Animation "Solution à l'exercice pour
OpenOffice" [http://projet.c2imes.org/V2/tutorielsB5/Chap10/animation_exercice_OO.htm]
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Glossaire

Abscisse

Coordonnée horizontale d'un point.

Absolue

Référence unique définie par la position dans la feuille de calcul.

Accès n. m.

Définition : Le fait d'engager la consultation d'un document sur un serveur.

Note :
♦ Le nombre d'accès est une mesure de l'audience d'un site ou de la fréquence de

consultation d'un document.

♦ En anglais, le terme « hit » a un autre sens dans le domaine des moteurs de
recherche.

Voir aussi : visite.

Équivalent étranger : hit



Administrateur de site, de serveur

Définition : Personne chargée de la maintenance et du suivi d'un site ou d'un serveur
sur la toile mondiale.

Voir aussi : toile d'araignée mondiale.
Équivalent étranger : webmaster.

Adresse IP (Adresse Internet
Protocole) n. f.

Définition : Identifiant unique, qui d'un point de vue conceptuel, est similaire à un
numéro de téléphone. Cette adresse numérique est utilisée pour identifier un
composant (en général un ordinateur, mais aussi un routeur, une imprimante, etc.) sur
un réseau local, un réseau étendu ou sur Internet. Elle peut être attribuée de façon fixe
ou de manière dynamique à chaque connexion (adresse I.P. dynamique).

Adresse universelle

Synonyme : adresse réticulaire.

Définition : Dénomination unique à caractère universel qui permet de localiser une
ressource, un document sur l'internet, et qui indique la méthode pour y accéder, le nom
du serveur et le chemin à l'intérieur du serveur. Note : Par exemple, l'adresse
universelle de la page d'accueil de la Délégation générale à la langue française est
http://www.culture.gouv.fr/culture/dglf/accueil.htm. Elle comprend trois parties : http
indique la méthode d'accès, en soit le protocole ; www.culture.gouv.fr est le nom du
serveur du ministère de la culture et de la communication en France sur la toile
d'araignée mondiale ; culture/dglf/ est le chemin d'accès et accueil.htm le nom du
document.
Voir aussi : domaine, internet, page d'accueil, système d'adressage par domaines.
Équivalent étranger : uniform resource locator, universal resource locator, URL.
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Agenda électronique n. m.

Définition :
♦ Logiciel pour la gestion de données personnelles telles que rendez-vous, adresses,

etc.

♦ Par extension, ordinateur de poche remplissant essentiellement cette fonction. Note :
on rencontre parfois aussi, moins bien, " organiseur ".

Équivalent étranger : organizer.

Agent

Définition : Logiciel envoyé sur un réseau pour effectuer une tâche à la place de
l'utilisateur et sans son intervention.

Note :
♦ On utilise, par exemple, les agents pour le filtrage d'informations et la recherche sur

l'internet.

♦ Un agent est dit intelligent lorsqu'il utilise les techniques de l'intelligence artificielle.

Amorce n. m.

Définition : Programme nécessaire à la mise en marche d'un ordinateur, et exécuté à
chaque mise sous-tension ou réinitialisation.

Équivalent étranger : boot.

Amorçer verbe

Définition : Mettre en marche un ordinateur en provoquant l'exécution de l'amorce.

Équivalent étranger : boot (to).
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Analogique , adj.

Définition : Signal représenté par la variation d'une grandeur physique la variation de
l'information qu'il représente.

Équivalent étranger : anchor.

Ancre, n.f.

Synonyme : point d'ancrage. Définition : Zone déterminée d'un document servant de
départ ou d'arrivée à un lien hypertextuel avec une autre zone de ce document ou avec
une zone déterminée d'un autre document.

Équivalent étranger : anchor.

Ancre (Excel)

La cellule à partir de laquelle une plage est définie.

Annuaire des domaines

Voir : système d'adressage par domaines.

Anticrénelage n.m.

Définition : Prévention du crénelage par un procédé qui consiste à lisser les lignes et
les contours d'une image.

Voir aussi : crénelage.
Équivalent étranger : antialiasing.
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Appliquette n. f.

Définition : Petite application indépendante du matériel et du logiciel utilisés, qui est
téléchargée depuis un serveur de la toile mondiale et qui est exécutée localement au
sein d'un logiciel de navigation. Note : Les appliquettes sont surtout employées dans le
langage de programmation Java.

Voir aussi : logiciel de navigation, toile d'araignée mondiale.
Équivalent étranger : applet.

Argument

Valeur, cellule ou plage de cellule que l'on met entre parenthèses après le nom d'une
fonction. Si la fonction exige plusieurs arguments, ceux-ci sont séparés par un
point-virgule.

Synonyme : paramètre

Arobase/arrobe, n.f.

Définition : Caractère @ fréquemment employé dans les adresses de courrier
électronique pour séparer le nom identifiant l'utilisateur de celui du gestionnaire de la
messagerie.

Note :
♦ @ est à l'origine le symbole de l'arroba (de l'arabe ar-roub, " le quart "), ancienne

unité de capacité et de poids espagnole et portugaise.Ce sigle est également utilisé
dans les langues anglo-saxonnes, il est alors appelé " a commercial " et son tracé,
identique à celui de l'arroba, résulterait de la ligature de l'accent grave avec le a de la
préposition française à, autrefois d'usage courant dans le commerce international.

♦ Lorsqu'une adresse est fournie oralement, @ se dit " arrobe " alors qu'il se dit " at "
en anglais.

Équivalent étranger : at-sign.
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Arrosage n. m.

Définition : Envoi d'un même message électronique à un très grand nombre de
destinataires au risque de les importuner.

Note : Un exemple est l'envoi de messages publicitaires.
Équivalent étranger : spamming.

Article de forum n.m.

Synonyme : contribution n. f.

Définition : Document similaire à un message électronique, destiné à alimenter un ou
plusieurs forums.
Voir aussi : forum.
Équivalent étranger : news item, news posting, news article.

ASCII (ou American Standard Code
for Information Interchange) n. m.

Définition : Le langage ASCII est un langage informatique permettant de convertir
tout type de caractères en code numérique compris par la plupart des ordinateurs.

asynchrone adj.

Définition : Communication avec émission et réception non simultanées (exemple : la
messagerie électronique). Une formation asynchrone est une formation durant laquelle
les échanges entre les apprenants et le formateur/tuteur s'effectuent de manière non
simultanée.

Autoformation n. f.

Définition : Processus dans lequel l'apprenant gère sa formation en autonome ; cela
permet à l'apprenant de se former à son rythme en utilisant des ressources créées à cet
effet. Cette auto-formation peut-être tutorée dès lors qu'une médiation humaine est
incluse dans le dispositif.
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Autoroute de l’information n. f.

Définition : Structure constituée par des moyens de télécommunication et
d'informatique interconnectés, qui permet d'offrir à un très grand nombre d'usagers de
multiples services, en général à débit élevé, y compris des services audiovisuels.

Note : On rencontre aussi le terme ? inforoute ?, qui n'est pas recommandé. Équivalent
étranger : information highway (ang.), information superhighway (ang.).

Backbone n. m.

Définition : Partie principale d'un réseau de télécommunication ou de téléinformatique,
caractérisée par un débit élevé, qui concentre et transporte les flux de données entre
des réseaux affluents.

Backup n. m.

Définition : Duplication de données dans le but d'avoir une copie d'une source
originale, en cas de destruction partielle ou totale de cette dernière. Ces données en
question peuvent être, soit des documents, soit des programmes informatiques mais le
logiciel de sauvegarde informatique ne fait pas de distinction entre les différents types
de données.

Équivalent étranger : copie de sûreté.

Balise n. f.

Définition : Dans un langage de description de documents, marque destinée à
l'identification, la description ou la mise en forme d'un élément de document.

Équivalent étranger : tag.
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Bande passante n. f.

Définition : Etendue d'informations qui sont véhiculables par un canal de
communication. Plus la bande est large, plus la communication est rapide. La bande
passante est déterminante pour une connexion rapide sur l'lnternet. Se mesure en bits
par seconde.

Équivalent étranger : bandwith.

Barrière de sécurité n. f.

Définition : Dispositif informatique qui filtre les flux d'informations entre un réseau
interne à un organisme et un réseau externe en vue de neutraliser les tentatives de
pénétration en provenance de l'extérieur et de maîtriser les accès vers l'extérieur.

Note : Dans cette acception, on dit aussi " pare-feu " (n.m.) l.
Équivalent étranger : firewall

Bas débit n. m.

Définition : Accès sur Internet à partir d'une ligne téléphonique simple. Les
technologies d'accès haut-débit sont notamment :
♦ le modem, pour un accès analogique (typique : 56 kb/s).

♦ le RNIS, pour un accès numérique (typique 1x ou 2x 64 kb/s).

Base de données n. f.

Définition : Ensemble d'informations organisées afin d'être utilisées par des
programmes.
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Binette n. f. fam.

♦ Définition : Dans un message, association facétieuse de quelques caractères
typographiques qui évoquent un visage expressif.

Note :
♦ Les plus connues sont : - ) pour la bonne humeur et : - ( pour le dépit, où les deux

points représentent les yeux, le trait représente le nez et les parenthèses la bouche.

♦ Le terme " binette " est recommandé au Québec. En France, " frimousse " doit être
préféré à " binette ". Équivalent étranger : emoticon, smiley.

BIOS (Basic Input Output System) n.
m.

Définition : Programme contenu dans la mémoire morte (ROM) de la carte mère
s'exécutant au démarrage de l'ordinateur. Il contrôle les éléments matériels, déclare les
disques, configure les composants et recherche un système d'exploitation avant de le
lancer. Sa tâche principale est de fournir un support de bas niveau pour communiquer
avec les périphériques. Habituellement ceci inclut le support du clavier au moins dans
un mode (pas forcément l'USB) et d'un mode d'affichage simplifié.

Équivalent français : Système de base d'entrée/sortie, système de gestion élémentaire
des entrées/sorties.

Bit n. m.

Définition : Unité de mesure en informatique désignant la quantité élémentaire
d'information représentée par un chiffre binaire.

Note :
♦ Le mot bit est la contraction de l'anglais binary digit, qui signifie « chiffre binaire ».

En anglais, bit a aussi le sens de « fragment » ou de « parcelle ».

♦ Il est utile de signaler l'homophonie avec « byte » (octet en anglais), qui prononcé «
à la française », peut prêter très souvent à confusion.

♦ Vu que la prononciation du terme 'bit' présente une certaine ambiguité homonyme,
on peut aussi parler du chib, c'est-à-dire le chiffre binaire.
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Bitmap

Format de graphismes en mode point dans lequel l'image est une grille de pixels.

Blog n.m.

Synonyme : web log, weblog.

Définition : Site sur la toile, souvent personnel, présentant en ordre chronologique de
courts articles ou notes, généralement accompagnés de liens vers d'autres sites.
Note : La publication de ces notes est généralement facilitée par l'emploi d'un logiciel
spécialisé qui met en forme le texte et les illustrations, construit des archives, offre des
moyens de recherche et accueille les commentaires d'autres internautes.

Bogue informatique n.m.

Abréviation : bogue, n. m.

Définition : Anomalie dans un programme informatique l'empêchant de fonctionner
correctement. Leur gravité peut aller de bénigne (défauts d'affichage mineur) à
majeure (explosion du vol 501 de la fusée Ariane 5).
Note : Les bogues sont généralement dus à un problème de conception du logiciel ;
celui-ci peut être localisé (et la correction simple), mais peut aussi bien être un
problème général de conception, nécessitant une refonte profonde. Plus rarement, les
bogues dans les logiciels peuvent être dus à des erreurs dans les outils de
développement utilisés par les programmeurs du logiciel. Enfin, le matériel lui-même
peut comporter des bogues (célèbre cas des premières versions du processeur
Pentium).
Équivalent étranger : bug.

Bombe logique

Voir : bombe programmée.
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Bombe programmée

Forme abrégée : bombe, n.f.

Synonyme : bombe logique. Définition : Logiciel malveillant conçu pour causer des
dommages à un système informatique et qui est déclenché lorsque certaines conditions
sont réunies. Voir aussi : logiciel malveillant.
Équivalent étranger : logic bomb.

Bombing n. m.

Définition : Envoi d'une grande quantité de messages à un destinataire unique dans une
intention malveillante.

Équivalent français : bombardement.

Boucle locale n. f.

Définition : Partie du réseau de communication situé entre l'infrastructure d'un
opérateur et l'utilisateur final.

Browser n. m.

Domaine : Informatique/Internet.

Synonyme : navigateur n. m.
Définition : Dans un environnement de type internet, logiciel qui permet à l'utilisateur
de rechercher et de consulter des documents, et d'exploiter les liens hypertextuels qu'ils
comportent.
Voir aussi : hypertextuel.
Équivalent étranger : logiciel de navigation.

Bulle d'information

Petit message d'information apparaissant lorsque le pointeur souris survole un objet
(icône, ...)
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Bureau n. m.

Définition :
♦ Ecran principal de l'interface graphique.

♦ Partie de l' écran situé au-dessus de la barre des tâches, on peut y mettre des
raccourcis vers des applications sous forme d'icones Équivalent français :
bombardement.

Cache n. m

Voir : mémoire cache, n. f.

Cadre n. m.

Définition : Sous-fenêtre de la fenêtre principale d'un logiciel de navigation, qui peut
afficher un document différent de ceux affichés dans les autres sous-fenêtres.

Voir aussi : fenêtre, logiciel de navigation.
Équivalent étranger : frame.

Calcul intensif n. m.

Définition : Ensemble des techniques et des moyens destinés à traiter des applications
complexes en faisant appel à des ordinateurs spécialisés dans le traitement rapide de
gros volumes de données numériques.

Équivalent étranger : supercomputing.
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Canular, n.m.

Définition : Information fausse transmise par messagerie électronique et incitant les
destinataires abusés à effectuer des opérations ou à prendre des initiatives inutiles,
voire dommageables.

Note : Il peut s'agir d'une fausse alerte aux virus, de fausses chaînes de solidarité ou
pétitions, de promesses de cadeaux. Les canulars encombrent les réseaux par la
retransmission en chaîne du message et incitent parfois le destinataire à effacer des
fichiers indispensables au bon fonctionnement de son ordinateur ou à télécharger un
fichier contenant un virus ou un ver.

Casse

Majuscule ou minuscule.

Causette n. f. fam.

Définition : Communication informelle entre plusieurs personnes sur l'internet, par
échange de messages affichés sur leurs écrans.

Voir aussi : internet.
Équivalent étranger : chat.

Cédérom, n. m.

Abréviation : CD-Rom, CD-ROM, CDROM.

Défintion : Disque compact pressé (confectionnés sous presse [par opposition à
gravé]). Il constitue un support audio compact de haute qualité permettant un accès
direct aux pistes numériques.
Synonyme : Disque compact. Equivalent étranger : Compact Disc Read Only Memory.

Cellule

Case d'une feuille de calcul.
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Chat, n.m.

Synonyme : I.R.C, n. m.

Définition : Messagerie en ligne permettant des discussions de groupe en mode
synchrone.

Cheval de Troie, n.m.

Définition : Logiciel apparemment inoffensif, installé ou téléchargé et au sein duquel a
été dissimulé un programme malveillant qui peut par exemple permettre la collecte
frauduleuse, la falsification ou la destruction de données.

Équivalent étranger : Trojan horse.

Charte graphique

Ensemble de documents qui pose les règles de mise en page et définit l'aspect
graphique des documents (internes et externes) d'une entreprise.

Classeur

Document enregistré par le tableur. Il contient l'ensemble des feuilles de calcul et
graphique.

Classe virtuelle, n. f.

Définition : peut soit désigner le groupe d'individus inscrits à un cursus de formation à
distance et qui vont être amenés à interagir entre eux et/ou leur formateur tout au long
de leur apprentissage, soit désigner un dispositif de formation à distance synchrone
répliquant dans le virtuel le concept de classe physique. On utilisera pour cela des
solutions de " live collaboration ".
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Clés de tri

Colonne d'une liste sur laquelle porte un tri.

Cliquer, verbe intr.

Définition : Enfoncer et relâcher le bouton (ou cliquet) d'une souris ou d'un dispositif
similaire.

Équivalent étranger : click (to).

Cluster, n. m.

Voir: grappe (équivalent français).

CNIL, n. f.

Définition : La Commission Nationale de l'Informatique et des Libertés a été instituée
par la loi n° 78-17 du 6 janvier 1978 relative à l'informatique, aux fichiers et aux
libertés.

Code à octets, n.m.

Définition : Ensemble d'instructions indépendant de tout processeur, destiné à être
interprété par un logiciel spécialisé.

Note :
♦ Ce terme désigne, par extension, un programme informatique écrit à l'aide d'un tel

ensemble d'instructions.

♦ Sur l'internet, les appliquettes distribuées sont fréquemment écrites à l'aide d'un code
à octets.
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Compression, n. f.

Définition : Action de diminuer le poids de données informatiques par le biais d'un
logiciel spécialisé. Les données compressées doivent être décompressées pour être
réutilisées.

Équivalent étranger : bytecode.

Configurer, verbe

Définition : Définir les sous-ensembles constituant un matériel, un logiciel, ou agir sur
leurs paramètres pour en assurer la mise en oeuvre.

Équivalent étranger : configure (to).

Connectabilité, n. f.

Définition : Aptitude d'un équipement informatique à fonctionner dans un réseau
donné du fait de ses caractéristiques matérielles et logicielles.

Note :
♦ Le terme « connectivité » est déconseillé.

♦ Ce sens de connexité est emprunté aux mathématiques. On dit d'un graphe qu'il est
connexe s'il existe au moins un chemin entre deux noeuds quelconques.

Équivalent étranger : connectivity.

262 MODULE B4 - REALISER DES DOCUMENTS DESTINES A ETRE IMPRIMES – TABLEURS



Connecté, adj.

Définition : Propriété d'un réseau de téléinformatique dans lequel il est toujours
possible de relier directement ou indirectement deux équipements quelconques.

Note :
♦ Le terme « connectivité » est déconseillé.

♦ Ce sens de connexité est emprunté aux mathématiques. On dit d'un graphe qu'il est
connexe s'il existe au moins un chemin entre deux noeuds quelconques.

Équivalent étranger : connectivity.

Connecteur logiciel, n.m.

Définition : Mécanisme logiciel de communication entre processus informatiques,
souvent utilisé entre une application et un réseau.

Équivalent étranger : socket.

Connexion, n. f.

Définition : Procédure permettant à un utilisateur de se mettre en relation avec un
système informatique et, si nécessaire, de se faire reconnaître de celui-ci.

Note :
♦ Le terme « connectivité » est déconseillé.

♦ Ce sens de connexité est emprunté aux mathématiques. On dit d'un graphe qu'il est
connexe s'il existe au moins un chemin entre deux noeuds quelconques.

Équivalent étranger : log in, log on.

Contribution n. f.

Voir : article de forum.
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Cookie, n.m.

Définition :
♦ Appliquette envoyée par un serveur de la toile mondiale à un utilisateur, parfois à

l'insu de celui-ci, au cours d'une connexion, afin de caractériser cet utilisateur.

♦ Par extension, information que l'appliquette peut enregistrer sur le disque de
l'utilisateur et à laquelle le serveur peut accéder ultérieurement.

Note : Dans cette acception, on dit aussi " mouchard " (n.m.).

Voir aussi : appliquette, toile d'araignée mondiale.

Coprocesseur, n.m.

Définition : Processeur complémentaire d'un processeur principal destiné à rendre plus
efficace l'exécution d'un jeu particulier d'instructions.

Équivalent étranger : coprocessor.

Courrier électronique n. m.

Définition : Service de transfert de messages envoyés via Internet vers la boîte aux
lettres électronique des destinataires choisis par l'émetteur. Note : L'Académie
française lui a trouvé le nom de « mél », tandis que les québecois, réputés pour leur
langage imagé, ont adopté le joli terme de « courriel ». Depuis la parution du Journal
Officiel du 20 juin 2003, le terme « courriel » a été adopté comme dénomination
principale du courrier électronique dans la langue française.
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CPU (Central Processing Unit), n.m.

Définition : C'est le cerveau de l'ordinateur. Composant essentiel d'un ordinateur, qui
exécute les programmes et où sont effectués les principaux calculs. Il permet de
manipuler des informations numériques, c'est-à-dire des informations codées sous
forme binaire, et d'exécuter les instructions stockées en mémoire. Sa cadence (le
nombre de micro-instructions qu'il effectue en une seconde) est exprimée en Hertz
(Hz).

Équivalent français : Processeur, Unité centrale [de traitement].

crénelage, n.m.

Définition : Effet visuel indésirable provoqué par l'insuffisance de la définition d'une
image ou par un filtrage inadéquat des contours d'objets, et qui prend habituellement la
forme de dentelures et de contours brisés.

Voir aussi : anticrénelage.
Équivalent étranger : aliasing.

CSS (Cascading style sheets), n.m.

Définition : Langage utilisé pour décrire la présentation d'un document structuré écrit
en HTML ou en XML, et c'est le World Wide Web Consortium (W3C) qui en a la
direction. Ce langage définit les couleurs, les polices, le rendu et d'autres
caractéristiques liées à la présentation d'un document. L'objectif est de bien séparer la
structure (écrite en HTML ou similaire) et la présentation (en CSS) du document.
Cette séparation fournit un certain nombre de bénéfices, permettant d'améliorer
l'accessibilité, de changer plus facilement de structure et de présentation, et de réduire
la complexité de l'architecture d'un document. Enfin, il permet de s'adapter aux
caractéristiques du récepteur.

Équivalent français : Feuille de style en cascade.

définition n. f.

Définition: C'est le nombre de points (pixels) que l'écran peut afficher, ce nombre de
points est généralement compris entre 640x480 (640 points en longueur, 480 points en
largeur) et 1600x1200, mais des résolutions supérieures sont techniquement possibles.
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DHTML (Dynamic HyperText
Markup Language), n.m.

Définition : Nom générique donné à l'ensemble des techniques utilisées par l'auteur
d'une page Web plus interactive pour que celle-ci soit capable de se modifier
elle-même en cours de consultation dans le navigateur Web, c'est-à-dire dont le
contenu peut être modifié grâce à des événements (mouvements de la souris, survol
d'un objet par le curseur, ...) après le chargement de la page..

Équivalent français : (littéralement) HTML dynamique.

diffusion réticulaire systématique ou,
ellipt., diffusion réticulaire n. f.

Voir : diffusion systématique sur la toile.

diffusion sélective n. f.

Voir : distribution sélective.

Diffusion systématique sur la toile
ou, ellipt., diffusion sur la toile n. f.

Synonyme : diffusion réticulaire systématique.

Définition : Envoi systématique de données ou de documents à des utilisateurs de la
toile mondiale.
Voir aussi : distribution sélective. Équivalent étranger : webcasting, netcasting.

Distribution personnalisée n. f.

Voir : distribution sélective.
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Distribution sélective n. f.

Synonyme : distribution personnalisée, diffusion sélective.

Définition : Technique utilisée pour faire bénéficier automatiquement un utilisateur de
la toile mondiale, à sa demande, d'un envoi de données d'un type choisi.
Note : La distribution sélective se distingue de la recherche individuelle.
Équivalent étranger : push technology.

DNS (Domain Name System), n.m.

Définition : Système qui permet d'associer sur Internet un nom de domaine
(c2imes.org) au numéro (adresse IP) de l'ordinateur sur lequel est hébergé le site.

Document composite

Document mêlant du texte, des tableaux, des graphes, ou tout autre objet créé par une
autre application.

Domaine n. m.

Définition : Ensemble d'adresses faisant l'objet d'une gestion commune.

Voir aussi : système d'adressage par domaine.
Équivalent étranger : domain.

Données

Constante (nombre, date, logique, texte) entrée dans une cellule.
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DOS (Disk Operating System), n.m.

Définition : Système d'exploitation relativement basique, constitué d'interfaces
destinés à simplifier l'utilisation des ordinateurs. En particulier, il permet d'unifier les
systèmes d'accès aux périphériques de stockage sur disque tels que les disquettes et
disques durs.

Équivalent français : (littéralement) Système d'exploitation de disque.

Driver n. m.

Voir : pilote informatique.

Digital Versatile Disk (DVD), n.m.

Définition : Disque numérique optique de grande capacité, à usages divers (audio,
vidéo, multimédia, mémoire vive, mémoire morte).

Note : La capacité des disques polyvalents numériques est supérieure à celle des
cédéroms et nécessite des lecteurs appropriés.
Équivalent français : disque numérique polyvalent.

Echange de données informatisé, n.
m.

Abréviation : EDI, n. m.

Définition : Transfert, entre systèmes d'information, de données structurées
directement émises et traitées par des applications informatiques, selon des procédures
normalisées.
Équivalent étranger : Electronic Data Interchange, EDI.
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Ethernet n. m.

Définition : Standard de transmission de données pour réseau local basé sur le principe
suivant "Toutes les machines du réseau Ethernet sont connectées à une même ligne de
communication, constituée de câbles cylindriques".

Expression booléenne

Expression dont le résultat peut prendre 2 valeurs et 2 valeurs seulement : VRAI ou
FAUX

Extranet n. m.

Définition : Réseau de télécommunication et de téléinformatique constitué d'un
intranet étendu pour permettre la communication avec certains organismes extérieurs,
par exemple des clients ou des fournisseurs.

Voir aussi : intranet.

FAI n. f.

Voir : fournisseur d'accès internet

FAQ n. f.

Voir : foire aux questions.

Fonction volatile

Fonction renvoyant une valeur différente à chaque fois que la feuille est recalculée.
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Fenêtre n. f.

Définition : Partie rectangulaire de l'écran d'un ordinateur à l'intérieur de laquelle sont
affichées les informations relatives à une activité déterminée.

Note : Plusieurs fenêtres peuvent êtres ouvertes simultanément ; elle peuvent être
juxtaposées ou se recouvrir totalement ou partiellement.
Équivalent étranger : window.

Fenêtre d'attente

Définition : Fenêtre qui s'affiche provisoirement sur un écran pendant l'installation
d'un logiciel.

Note : Cette fenêtre incite l'utilisateur à patienter pendant l'exécution de l'opération
tout en lui apportant diverses informations.
Équivalent étranger : splash screen.

Feuille de calcul

Tableau de données constitué de cellules. Equivalent étranger : worksheet

Fichier des questions courantes

Voir : foire aux questions.

Fil (de [la] discussion)

Définition : Dans les échanges au sein d'un forum ou entre utilisateurs du courrier
électronique, enchaînement des commentaires à un article donné.

Voir aussi : article de forum, forum.
Équivalent étranger : thread.
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Flottante

Barre d'outils ou palette flottante : que l'on peut placer n'importe où sur le bureau.

Foire aux questions

Abréviation : FAQ.

Synonymes : fichier des questions courantes, questions courantes.
Définition : Rubrique présentant par sujets les questions les plus fréquemment posées
par les utilisateurs, accompagnées des réponses correspondantes.
Note : La foire aux questions a, en particulier, pour but de faciliter l'intégration des
internautes novices dans un groupe de discussion et de diminuer le nombre des
messages diffusés dans le réseau.
Équivalent étranger : frequently asked questions (file), FAQ.

Formatage n. m.

: Action de préparer un support de données informatique (disquette, disque dur, etc.)
en y inscrivant un système de fichiers, de façon à ce qu'il soit reconnu par le système
d'exploitation de l'ordinateur. Il rend l'accès impossible aux données présentes sur le
disque. Il est donc indispensable de procéder à une sauvegarde des données
importantes.

Formules

Expression ou fonction calculant une valeur à partir de données
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forum n. m.

: Service permettant discussions et échanges sur un thème donné : chaque utilisateur
peut lire à tout moment les interventions de tous les autres et apporter sa propre
contribution sous forme d'articles.

Note : Par extension, on désigne également par ce terme les systèmes de discussion
télématiques, qui offrent généralement un service de téléchargement (connus en
anglais sous le nom de B.B.S., Bulletin Board System). Voir aussi : article de forum
(J.O. du 16 mars 1999).

Fournisseur d'accès internet n. m.

Définition : Organisme offrant à des clients d'accéder à l'internet, ou, plus
généralement, à tout réseau de communication.

Note : Le fournisseur d'accès peut aussi offrir des services en ligne.
Équivalent étranger : access provider.

Freeware n. m.

Définition : Logiciel que l'on peut utiliser gratuitement.

Équivalent français: gratuiciel.

Fréquence de balayage vertical n. m.

Définition : Elle représente le nombre d'images qui sont affichées par seconde, ou plus
exactement le nombre de rafraîchissement de l'image par seconde. On l'appelle ainsi
également taux de rafraîchissement, elle est exprimée en Hertz. Plus cette valeur est
élevée meilleur est le confort visuel (on ne voit pas l'image scintiller), il faut donc
qu'elle soit bien supérieure à 67 Hz (limite inférieure à partir de laquelle l'oeil voit
véritablement l'image "clignoter"). La plupart des personnes ne perçoivent plus de
scintillement (en anglais flicker) à partir de 70 Hz, ainsi une valeur supérieure ou égale
à 75 Hz conviendra généralement.

Équivalent étranger : refresh rate.
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Frimousse n. f. fam.

Définition : Dans un message, association facétieuse de quelques caractères
typographiques qui évoquent un visage expressif.

Note :
♦ Les deux frimousses les plus connues sont : - ) pour la bonne humeur et : - ( pour le

dépit, où les deux points représentent les yeux, le trait représente le nez et les
parenthèses la bouche.

♦ Le terme " binette " est recommandé au Québec. " Frimousse " doit être préféré à "
binette ".

Équivalent étranger : emoticon, smiley.

FTP (File Transfer Protocol) n. m.

Définition : Protocole utilisé pour transférer un fichier du serveur vers le poste client
(download) ou du poste client vers le serveur (upload).
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GIF (Graphics Interchange Format) n.
m.

Définition : Format de données informatique d'image numérique, couramment utilisé
sur le World Wide Web.

Note : GIF supporte 16 777 216 nuances de couleur : 8 bits par composante RVB, soit
224 nuances. GIF n'enregistre pas directement la couleur de chaque pixel. Pour chaque
image, une palette de 2 à 256 couleurs est construite. Ensuite chaque pixel de l'image
référence une entrée de la palette. Cette méthode limite donc à 256 le nombre maximal
de couleurs différentes présentes dans un plan de l'image. On parle de format 8 bits car
chaque pixel est codé sur 8 bits, representant donc au maximum 256 valeurs. L'usage
d'une palette permettait un affichage beaucoup plus rapide sur les ordinateurs de
l'époque dont les cartes graphiques contenaient elle-même une palette d'au plus 256
couleurs. La limitation à 256 couleurs n'est pas gênante pour les logos, les graphiques
et la plupart des images synthétiques, ainsi que les photographies noir et blanc. En
revanche une photographie couleur de qualité nécessite plus de nuances. GIF permet
de spécifier qu'une entrée de la palette est transparente. C'est notamment utile
lorsqu'une image non rectangulaire est intégrée à un document comme une page Web :
on voit le document à travers les pixels transparents. GIF propose un mode entrelacé
permettant de commencer par transmettre quelques lignes d'une image, puis les lignes
placées entre elles. Ce mode permet de donner plus rapidement un aperçu de l'image
lorsque la transmission est lente.
Equivalent français : (littéralement) format d'échange de graphiques.

Glisser-déposer n. m.

Définition : Action par laquelle l'utilisateur sélectionne un objet à l'écran, le déplace
jusqu'à une autre position, puis le lâche pour déclencher une action sur cet objet.

Équivalent étranger : drag and drop.

Grappe n. f.

Définition : Ensemble d'appareils de même type (terminaux, ordinateurs, etc.)
rattachés à une même unité de contrôle.

Équivalent étranger : cluster.
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Haut débit n. m.

Définition : Capacités d'accès à Internet supérieures à celle de l'accès analogique par
modem (typique : 56 kb/s) et à l'accès numérique RNIS (typique 1x ou 2x 64 kb/s).
Les technologies d'accès haut-débit sont notamment :
♦ le câble, introduit le premier historiquement par les fournisseur de TV par câble

♦ le satellite, qui a un débit soutenu intéressant, mais des latences importantes en
mode interactif

♦ la DSL, asymétrique (ADSL) ou autres (xDSL)

♦ le Wi-Fi et autres réseaux sans fil

HTML (Hypertext Transmission
Protocol) n. m.

Définition : Langage informatique de description de contenu, créé et utilisé pour
composer des pages Web. HTML permet en particulier d'insérer des hyperliens dans
du texte, donc de créer de l'hypertexte, d'où le nom du langage. Il peut être complété
par d'autres langages (java, javascript, ...) pour offrir des fonctionnalités pl s
sophistiquées.

HTTP (Hypertext Transmission
Protocol) n. m.

Définition : Protocole de communication utilisé pour transmettre d'un serveur Web à
un navigateur le contenu de pages, notamment au format HTML.

HTTPS (Hypertext Transmission
Protocol Secured) n. m.

Définition : Protocole de communication sécurisé, utilisé pour transmettre d'un serveur
Web à un navigateur le contenu de pages, notamment au format HTML. Il permet au
visiteur de vérifier l'identité du site auquel il accède grâce à un certificat
d'authentification. Il permet également de chiffrer la communication. Il est
généralement utilisé pour les transactions financières en ligne : commerce
électronique, banque en ligne, courtage en ligne, etc.
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Hub n. m.

Définition : Dispositif informatique placé au noeud d'un réseau en étoile, qui concentre
et distribue les communications de données.

Note : Un concentrateur n'assure ni routage, ni commutation.
Équivalent français : concentrateur.

hypertexte n. m.

Définition :
♦ Système de renvois permettant de passer directement d'une partie d'un document à

une autre, ou d'un document à d'autres documents choisis comme pertinents par
l'auteur.

♦ Système de structuration de l'information qui permet une lecture non-linéaire d'un
document. Les liens hypertextes sont généralement représentés par du texte souligné
en bleu. Lorsque l'on positionne la souris sur un lien hypertexte, l'aspect du pointeur
change pour indiquer qu'il est possible de cliquer afin d'accéder à une autre
information.

Équivalent étranger : hypertext. Adjectif : hypertextuel.

Icône n. f.

Définition : Sur un écran, symbole graphique qui représente une fonction ou une
application logicielle particulière que l'on peut sélectionner et activer au moyen d'un
dispositif tel qu'une souris.

Note : icône, n. m., ne doit pas être utilisé.
Équivalent étranger : icon.

Importation de fichier

Récupération d'un type de fichier dont le format n'est pas le format natif (par défaut)
de l'application (par exemple, importation de fichier de type texte dans un tableur).
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Internaute, n. m.

Définition : Utilisateur de l'internet.

Note : On rencontre aussi le terme " cybernaute ".
Équivalent étranger : cybernaut.

Internet n. m. sg.

Définition : Réseau mondial associant des ressources de télécommunication et des
ordinateurs serveurs et clients, destiné à l'échange de messages électroniques,
d'informations multimédias et de fichiers. Il fonctionne en utilisant un protocole
commun qui permet l'acheminement de proche en proche de messages découpés en
paquets indépendants.

Note : L'acheminement est fondé sur le protocole IP (Internet Protocol), spécifié par
l'Internet Society (ISOC). L'accès au réseau est ouvert à tout utilisateur ayant obtenu
une adresse auprès d'un organisme accrédité. La gestion est décentralisée en réseaux
interconnectés.
Équivalent étranger : Internet network, Internet, Net.

Intranet n. m.

Définition : Réseau de télécommunication et de téléinformatique destiné à l'usage
exclusif d'un organisme et utilisant les mêmes protocoles et techniques que l'internet.

Équivalent étranger : intranet.

IP (Integrated Protocol) n. m.

Définition : Protocole de communication entre toutes les machines connectées à
Internet, indépendant du type des machines.

Voir : adresse IP.
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Java n. m.

Definition :
♦ Technologie (développée par Sun et lancée en 1995) composée d'un langage de

programmation orienté objet qui a la particularité principale d'être portable sur
plusieurs systèmes d'exploitation tels que Windows ou Linux..

♦ Environnement ou plate-forme d'exécution garantissant la portabilité des
applications développées en langage Java.

JavaScript n. m.

Définition : Langage de programmation de type scripts (petits bouts de programme)
pouvant être intégré directement au sein des pages Web, pour y être exécuté sur le
poste client. C'est alors le navigateur Web qui prend en charge l'exécution de ces
scripts. Généralement, JavaScript sert à contrôler les données saisies dans des
formulaires HTML ou à interagir avec le document HTML (on parle alors parfois
d'HTML dynamique). Il est aussi utilisé pour réaliser des services dynamiques.

JPEG (Joint Photographic Experts
Group) n. m.

Définition : Format de compression d'images qui entraîne une légère perte de qualité,
mais permet, contrairement au GIF, d'utiliser plus de 256 couleurs. Il est
particulièrement utilisé pour les photographies.

kilo-octet n. m.

Abréviation : ko

Définition : 210 octets = 1 024 octets (et pas 1 000 octets comme on pourrait le
supposer), soit 2 à la puissance 10.
Voir : octet.
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Liaison numérique à débit
asymétrique n. f.

Voir : raccordement numérique asymétrique.

logiciel n. m.

Synonyme : application, n. f.

Définition : Ensemble des éléments informatiques qui permettent d'assurer une tâche
ou une fonction (exemple : logiciel de comptabilité, logiciel de gestion des prêts). Le
terme logiciel est souvent employé pour programme informatique et inversement. Un
logiciel peut être composé d'un seul ou d'une suite de programmes. Ce dernier cas est
d'autant plus fréquent que la capacité réduite de calcul de l'ordinateur oblige à une
segmentation des tâches en plusieurs modules séparés ; cependant, les énormes
capacités des micro-ordinateurs actuels en regard des applications typiques de la
bureautique ont permis la réalisation d'applications monolithiques. Généralement, les
programmes sont accompagnés d'un ensemble de données permettant de les faire
fonctionner (par exemple, un jeu viendra avec de nombreuses images, animations,
sons...).

Logiciel antivirus n. m.

Forme abrégée : antivirus, n.m.

Définition : Logiciel conçu pour détecter les virus et les vers et, le cas échéant, les
éliminer ou suggérer des remèdes.
Voir aussi : ver, virus.
Équivalent étranger : antivirus program, antivirus software, vaccine program.
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Logiciel malveillant n. m.

Définition : Ensemble de programmes conçu par un pirate pour être implanté dans un
système afin d'y déclencher une opération non autorisée ou d'en perturber le
fonctionnement.

Note :
♦ Exemples : bombe programmée, virus, ver.

♦ Les logiciels malveillants peuvent être transmis via l'internet ou un réseau local, ou
par des supports tels que les disquettes ou les cédéroms.

Équivalent étranger : malicious logic, malicious software, malware.

Logiciel de navigation n. m.

Domaine : Informatique/Internet.

Synonyme : navigateur n. m.
Définition : Dans un environnement de type internet, logiciel qui permet à l'utilisateur
de rechercher et de consulter des documents, et d'exploiter les liens hypertextuels qu'ils
comportent.
Voir aussi : hypertextuel.
Équivalent étranger : browser.

Mise à jour logicielle n. f.

Abréviation : mise à jour n.f., MAJ, n. f.

Définition : Action de mettre à niveau un outil informatique (action matérielle) ou un
service ou une prestation, en téléchargeant ou chargeant, un nouveau programme
logiciel ou un élément d'un progiciel ou encore simplement le contenu de quelconques
données videos et visuelles, audios ou écrites. Globalement la mise à jour sert à
améliorer le rendement (ou l'efficacité) ou la prestation d'un service et produit, ex : un
ordinateur, et parfois de corriger les bogues d'un programme embarqué.
Equivalent étranger : up to date, upgrade.
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Mandataire n. m.

Voir : serveur mandataire.

Mémoire cache n. f.

Abréviation : cache, n. m.

Définition : Mémoire intermédiaire dans laquelle se trouvent stockées toutes les
informations que le processeur central est le plus susceptible de demander. Elle sert
donc à accélérer la communication entre un élément fournisseur (disque dur par
exemple) plus lent que l'élément demandeur (processeur par exemple). Comme ces
informations sont immédiatement disponibles, le temps de traitement se trouve
diminué d'autant, ce qui mécaniquement accroît notablement les performances de
l'ordinateur. Il existe souvent plusieurs niveaux de mémoire cache : une interne au
processeur, une autre intégrée sur la carte mère, mais on peut en avoir aussi sur le
disque dur.
Equivalent étranger : cache memory.

Mémoire tampon n. f.

Définition : Zone de mémoire vive ou de disque utilisée pour stocker temporairement
des données, notamment entre deux processus ou matériels ne travaillant pas au même
rythme. Ainsi, les données envoyées vers un périphérique (externe) sont le plus
souvent stockées dans des mémoires tampon en attente de leur envoi effectif pour
épargner à l'ordinateur le contretemps dû à la différence de débits entre le
microprocesseur interne et les différents périphériques souvents lents. De même, les
données reçues de l'extérieur sont le plus souvent stockées dans des tampons en attente
de leur traitement par l'ordinateur (pour des raisons d'efficacité, et aussi pour éviter
qu'une réception de données trop rapprochées fasse que certaines, non traitées, ne
soient perdues).

Note : Les périphériques tels que les ports séries sont le plus souvent munis de
tampons file d'attente : les données émises ou reçues en premier sont traitées en
premier. Une émission trop rapide peut remplir le tampon ; on bloque alors
généralement le processus émetteur. Une réception trop rapide peut elle aussi bloquer
le tampon, avec risque de perte de données ; aussi utilise-t-on souvent un dispositif de
contrôle de flux disant à l'émetteur de stopper son émission quand le tampon est
dangereusement près de la limite, et de recommencer quand le niveau est redevenu
acceptable...
Equivalent étranger : buffer.
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Mémoire vive n. f.

Acronyme : RAM (Random Access Memory) Définition : type de mémoire
informatique à accès aléatoire (par opposition à séquentiel) et en lecture-écriture (par
opposition à la lecture seule). On l'appelle aussi mémoire volatile pour signifier que
toutes les données sont perdues à l'extinction de l'alimentation électrique. Il s'agit
typiquement de la mémoire électronique qui contient les données en cours de
traitement dans un ordinateur.

Note : La mémoire vive (RAM) est généralement opposée à la mémoire morte (ROM)
: il est possible de lire et écrire de la mémoire vive alors qu'il est uniquement possible
de lire de la mémoire morte. En revanche, la mémoire morte conserve les données
lorsque l'alimentation électrique est coupée. La mémoire morte n'est donc pas volatile.

Messagerie électronique n. f.

Synonymes : courrier électronique, mél, courriel.

Définition : Service de transfert de messages envoyés via Internet vers la boîte aux
lettres électronique des destinataires choisis par l'émetteur.
Note : L'Académie française lui a trouvé le nom de « mél », tandis que les québecois,
réputés pour leur langage imagé, ont adopté le joli terme de « courriel ». Depuis la
parution du Journal Officiel du 20 juin 2003, le terme « courriel » a été adopté comme
dénomination principale du courrier électronique dans la langue française.

Métafichier

Format de graphismes contenant une suite d'ordres de dessin.

Middleware n. m.

Définition : Logiciel qui permet le fonctionnement de plusieurs ordinateurs en
coordination, en attribuant à chacun une tâche spécifique, comme les échanges avec
les utilisateurs, l'accès aux bases de données ou aux réseaux.

Note : Le terme " logiciel médiateur " désigne aussi un logiciel qui permet de
coordonner le fonctionnement de plusieurs logiciels au sein d'un même ordinateur.
Équivalent français : logiciel médiateur.
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Modem n. m.

Définition : Périphérique servant à communiquer avec des utilisateurs distants qui
permet d'échanger (envoi/réception), via un support de transmission filaire (lignes
téléphoniques par exemple), des fichiers, des fax, de se connecter à Internet, de
recevoir et d'émettre des e-mails. Techniquement, l'appareil sert à convertir les
données numériques de l'ordinateur en données analogiques compréhensibles par une
ligne de téléphone classique et réciproquement.

Note : C'est un dispositif électronique, matérialisé dans un boîtier ou appareil, qui
permet de faire circuler (réception et envoi) des informations numériques sur un canal
analogique. Il effectue la modulation : codage de l'information numérique, synthèse
d'un signal analogique qui est en général une fréquence porteuse modulée. L'opération
de démodulation effectue l'opération inverse et permet au récepteur d'obtenir
l'information numérique.

Modérateur, -trice, n.

Définition : Personne qui veille au respect de l'objet et du règlement des échanges de
messages électroniques effectués dans un cadre organisé.

Note :
♦ Le modérateur veille notamment à éviter les arrosages publicitaires et les

bombardements, ainsi que les propos qui pourraient constituer des infractions
pénales.

♦ Dans un fonctionnement en différé, comme pour certains forums ou listes de
diffusion, le modérateur examine les articles ou messages reçus des participants et
en accepte ou en refuse la diffusion. Dans un fonctionnement en direct, le
modérateur agit par des avertissements et par exclusion des contrevenants.

Équivalent étranger : moderator.

Module d'extension, n. m.

Abréviation : extension n. f.

Définition : Élément logiciel que l'on adjoint à une application pour en étendre les
fonctions.
Équivalent étranger : plug-in.
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Moniteur, n. m.

Définition : Périphérique de sortie usuel d'un ordinateur qui permet de visualiser les
informations générées par l'ordinateur, sous forme de texte et d'image.

Note : Différentes technologies existes :
Ecran à tube cathodique ; ce sont ceux qui ont un angle de vision le plus large et
jusqu'à 2005 le meilleur rendu des couleurs, mais ils sont lourds, encombrants et
gourmands en énergie.
Ecran LCD, légers et commodes, mais dotés d'un moins bon rendu des couleurs et,
pour certains modèles d'entrée de gamme, d'une rémanence parfois gênante pour les
jeux très rapides.
Ecran à plasma, de très bon rendu, mais chers et de durée de vie plus limitée. DLP à
millions de miroirs.
Les écrans plats sont de plus en plus utilisés. Ils affichent environ 266 000 couleurs
étendues par dithering à environ 17 millions.

Moteur d'exécution, n. m.

: Sous-ensemble dérivé d'un logiciel et limité à l'exécution de certaines applications,
elles-mêmes développées avec le logiciel complet.

Équivalent étranger : runtime software.

Moteur de recherche, n. m.

: Système d'exploitation de banque de données, et, par extension, serveur spécialisé
permettant d'accéder sur la toile à des ressources (pages, sites, etc.) à partir de mots
clés.

Équivalent étranger : search engine.
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Mp3, n. m.

Abréviation de MPEG-1/2 Audio Layer 3.

Définition : Format de compression de données audio par destruction de données,
développé par l'organisation de standardisation internationale (ISO). Ce format permet
de compresser à un taux de 1:12 les formats audio habituels (WAV ou CD audio). Il
permet de faire tenir l'équivalent en fichiers de douze albums de musique sur un seul
cédéron. De plus, le format mp3 n'altère que faiblement le son pour l'oreille humaine.
Note : La compression MPEG layer 3 consiste à retirer des données audio les
fréquences inaudibles pour l'auditeur moyen dans des conditions habituelles d'écoute.
La compression vise donc à analyser les composantes spectrométriques d'un signal
audio, et de leur appliquer un modèle psychoacoustique pour ne conserver que les sons
« audibles ». L'oreille humaine est capable de discerner, en moyenne, des sons entre
0.02 kHz et 20 kHz, sachant que sa sensibilité est maximale pour des fréquences entre
2 et 5 kHz (la voix humaine est entre 0.5 et 2 kHz), suivant une courbe donnée par la
loi de Fletcher et Munson. La compression consiste à déterminer les sons que nous
n'entendons pas et à les supprimer, il s'agit donc d'une compression destructive,
c'est-à-dire avec une perte d'information.
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MPEG (Motion Pictures Experts
Group) n. m.

Définition : Norme de compression et de stockage d'éléments vidéo et de données
audio, le principe étant de compresser ce qui ne change pas entre les diverses
séquences vidéos. En effet, dans la plupart des séquences vidéos, la majorité des
scènes sont fixes ou bien changent très peu, c'est ce qui s'appelle la redondance
temporelle.Lorsque seules les lèvres de l'acteur bougent, presque seuls les pixels de la
bouche vont être modifiés d'une image à l'autre, il suffit donc de ne décrire seulement
le changement d'une image à l'autre.

Note : Il existe plusieurs standards MPEG :
♦ Le MPEG-1, développé en 1988, est un standard pour la compression des données

vidéos et des canaux audio associés (jusqu'à 2 canaux pour une écoute stéréo). Il
permet le stockage de vidéos à un débit de 1.5Mbps dans une qualité proche des
cassettes VHS sur un support CD appelé VCD (Vidéo CD). Le MPEG-2, un
standard dédié originalement à la télévision numérique (HDTV) offrant une qualité
élevé à un débit pouvant aller jusqu'à 40 Mbps, et 5 canaux audio surround.

♦ Le MPEG-2 permet de plus une identification et une protection contre le piratage. Il
s'agit du format utilisé par les DVD vidéos.

♦ Le MPEG-4, un standard destiné à permettre le codage de données multimédia sous
formes d'objets numériques, afin d'obtenir une plus grande interactivité, ce qui rend
son usage particulièrement adapté au Web et aux périphériques mobiles.

♦ Le MPEG-7, un standard visant à fournir une représentation standard des données
audio et visuelles afin de rendre possible la recherche d'information dans de tels flux
de données. Ce standard est ainsi également intitulé Multimedia Content Description
Interface.

♦ Le MPEG-21, en cours d'élaboration, dont le but est de fournir un cadre de travail
(en anglais framework) pour l'ensemble des acteurs du numériques (producteurs,
consommateurs, ...) afin de standardiser la gestion de ces contenus, les droits
d'accès, les droits d'auteurs, ...

Mise en forme conditionnelle

Mise en forme qui dépend du contenu de la cellule (par exemple, rouge pour les
nombres négatifs, vert pour les nombres positifs)
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Multimédia, n. m.

Définition :
♦ Assemblage des technologies destinées à gérer les données, le son et l'image sur un

même support (AFNOR).

♦ Combinaison des médias existants (textes, images fixes ou animées, dessins et
graphiques, sons, vidéo) dans un format numérique commun, mis en scène dans une
programmation informatique dédiée et accessible grâce à un lecteur permettant leur
exploitation (ordinateur, station de jeux)

Multiprocesseur, n. m.

: Ordinateur possédant plusieurs processeurs principaux.

Équivalent étranger : multiprocessor.

Navigateur n. m.

Voir : logiciel de navigation, browser.

Nom de domaine, n. m.

: Le nom de domaine est l'adresse d'un site (nom que vous tapez dans le champ adresse
de votre navigateur). Le système est hiérarchique, permettant la définition de
sous-domaine(s) d'un domaine existant.

Numériseur, n. m.

: Appareil permettant de transformer un signal analogique en un signal numérique.
Note : un numériseur permet en particulier de transformer des pages de textes et des
images en signaux numériques.

Voir aussi : scanneur.
Équivalent étranger : scanner, digitizer.
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Octet, n. m.

: Ensemble ordonné de huit éléments binaires traités comme un tout.

Note :
♦ Un octet est souvent utilisé pour représenter un caractère alphanumérique.

♦ Lorsqu'une grandeur est exprimée en multiples de l'octet, les symboles ko, Mo et Go
représentent respectivement le kilooctet, le mégaoctet et le gigaoctet. Dans ce cas, et
contrairement à la norme, on considère généralement que le kilooctet est égal à 2
exposant10 = 1 024 octets et non 1 000 et le mégaoctet à 2 exposant 20 et non 1 000
000. .

Équivalent étranger : byte

Off-line, adj.

: Se dit d'un produit n'utilisant pas un réseau (exemple : CD-ROM).

Équivalent français : hors ligne.

On-line, adj.

: Se dit d'un produit utilisant le réseau, comme l'internet, la télévision interactive....

Équivalent français : en ligne.

Opérateurs

Signe ou symbole permettant de réaliser des opérations.

Ordonnée

Coordonnée verticale d'un point.
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Page d'accueil n. f.

Définition :
♦ Page de présentation d'un site sur la toile mondiale.

♦ Page de tête affichée par un logiciel de navigation.

Voir aussi : logiciel de navigation.

Équivalent étranger : home page.

Pare-feu n. m.

Voir : barrière de sécurité.

Partage d'application n. m.

Définition : Système permettant à plusieurs personnes d'utiliser un logiciel alors que
celui-ci n'est pas physiquement présent sur leur machine mais émulé depuis un poste "
animateur ". .

Partition n. f.

Définition : Zone mémoire indépendante, découpée sur un disque dur et destinée à
accueillir un système de fichiers.

Note : On nomme partition d'amorçage (parfois par abus de langage partition primaire)
celle qui prend le contrôle au démarrage, qu'elle contienne ou non le système
d'exploitation.
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Passerelle n. f.

Définition : Dispositif destiné à connecter des réseaux de télécommunication ayant des
architectures différentes ou des protocoles différents, ou offrant des services différents.

Note : Une passerelle peut par exemple connecter un réseau local d'entreprise avec un
autre réseau local ou un réseau public de données.
Équivalent étranger : gateway.

Patch n. m.

Définition : Section de code que l'on ajoute à un logiciel, pour y apporter des
modifications mineures (correction d'un bogue, traduction, crack) qui a vocation à être
distribué à tous les utilisateurs du logiciel, de manière à minimiser la distribution du
logiciel complet (pour des raisons de coût en bande passante ou tout simplement pour
ne le rendre utilisable que par les utilisateurs enregistrés ou payants du logiciel).

Note : Au pluriel : patches respectant l'orthographe anglophone, patchs par
francisation. Termes français proposés : rustine ou rustine logicielle, terme français
majoritairement utilisé dans les milieux professionnels : correctif.

PDF (Portable Document Format) n.
m.

Définition : format de fichier informatique qui préserve les polices, les images, les
objets graphiques et la mise en forme de tout document source, quelles que soient
l'application et la plate-forme utilisées pour le créer. Les fichiers PDF peuvent être
créés avec des options personnalisées, tant aux niveaux de la compression des images
et des textes, de la qualité d'impression du fichier, ainsi que du verrouillage
(interdiction d'impression, de modification...).

Note : Au pluriel : patches respectant l'orthographe anglophone, patchs par
francisation. Termes français proposés : rustine ou rustine logicielle, terme français
majoritairement utilisé dans les milieux professionnels : correctif.
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Périphérique n. m.

Définition :
♦ Matériel électronique pouvant être raccordé à un ordinateur par l'intermédiaire de

l'une de ses interfaces d'entrée-sortie, le plus souvant par l'intermédiaire d'un
connecteur. Il s'agit dans ce cas de composants externes à l'unité centrale de
l'ordinateur. Dans la catégorie des périphériques externes, on peut citer le moniteur,
les lecteur cédérom/DVD, la souris, le clavier,...

♦ Périphériques internes connectés à l'intérieur du PC, c'est-à-dire sur les ports de la
carte-mère. Il s'agit principalement de la carte son, de la carte vidéo, de la carte
réseau,...

permutation n. f.

Définition : Processus consistant à échanger le contenu d'une zone de mémoire
principale avec le contenu d'une zone de mémoire auxiliaire.

Équivalent français : swap.

Phishing n. m.

Définition : Technique de fraude visant à obtenir des informations confidentielles,
telles que des mots de passe ou des numéros de cartes de crédit, au moyen de messages
ou de sites usurpant l'identité d'institutions financières ou d'entreprises commerciales.

Note : Le terme « hameçonnage » est aussi en usage.
Équivalent français : filoutage.

Pièce jointe n. f.

: Document ou fichier annexé au corps d'un message électronique.

Équivalent étranger : attachment, attachment file.
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Pilote informatique n. m.

Abréviation : pilote, n. m.

Définition : Programme informatique, souvent accompagné de fichiers ASCII de
configuration, destiné à permettre à un autre programme (souvent un système
d'exploitation) d'interagir avec un périphérique. En général, chaque périphérique a son
propre pilote. Sans pilote, l'imprimante ou la carte graphique ne pourraient pas être
utilisées.
Équivalent étranger : driver.

Pirate n. m.

Définition : Personne qui contourne ou détruit les protections d'un logiciel, d'un
ordinateur ou d'un réseau informatique.

Équivalent étranger : cracker.

Pixel n. m.

Définition : Unité de base d'une image numérique. Son nom provient de l'expression
anglaise picture element, c'est-à-dire, « élément d'image » ou « point élémentaire ».

Plate-forme n. f.

: En informatique, base de travail à partir de laquelle on peut écrire, lire, utiliser un
logiciel. Elle est composée du matériel, du système d'exploitation et/ou des outils
logiciels (compilateurs, éditeur de liens, bibliothèques, déboggueurs, éditeur de texte,
etc.).

Plage de cellules

Ensemble de cellules : par exemple B6 :E10 est une plage de cellules commençant en
B6 et s'étendant jusqu'en E10. Remarquez l'opérateur d'extension « : ».
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Plug-in n. m.

: petit programme additionnel venant se greffer à un logiciel principal afin de lui
apporter de nouvelles fonctionnalités.

Équivalent français: module d'extension.

Plug and play n. m.

: Procédure permettant aux périphériques récents d'être reconnus rapidement et
automatiquement par le système d'exploitation dès le redémarrage après l'installation
matérielle. Cette procédure permet l'installation en requérant un minimum
d'intervention de la part de l'utilisateur et donc en minimisant les erreurs de
manipulation et de paramètrage.

Équivalent français : L'expression française prêt-à-tourner a été proposée..

PNG (Portable Network Graphics) n.
m.

: Format d'images numériques libre de droit, qui a été créé pour remplacer le format
propriétaire GIF, dont la compression était soumise à un brevet. Ce format non
destructeur est spécialement adapté pour publier des images simples comprenant des
aplats de couleurs.

Note : Format particulièrement approprié lorsqu'il s'agit d'enregistrer des images
synthétiques destinées au Web comme des graphiques, des icônes, des images
représentant du texte (bonne conservation de la lisibilité) ou des images avec peu de
dégradés. Le PNG surpasse régulièrement le format GIF tant en ce qui concerne la
taille (avec une palette de couleurs bien choisie) que la qualité puisqu'il n'est pas limité
à 256 couleurs..
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Point par pouce, n.m.

Abréviation : ppp

Définition : Unité de précision communément utilisée pour définir la résolution d'un
scanner (on parle de « finesse de numérisation ») ou d'une imprimante(on parle de «
précision de l'impression »). Plus cette valeur est élevée et meilleure est la qualité.

Équivalent étranger : dpi (dot per inch).

POP (Post Office Protocol) , n.m.

Abréviation : ppp

Définition : Protocole permettant d'aller récupérer son courrier sur un serveur distant
(le serveur POP). Il est nécessaire pour les personnes n'étant pas connectées en
permanence à Internet afin de pouvoir consulter les courriels reçus hors connexion.

Pop-up (window) n. f.

Définition : Fenêtre qui s'affiche soudainement à l'écran sans que l'utilisateur en ait fait
la demande.

Port, n.m.

Définition :
♦ Port matériel qui est conçu pour accueillir un certain type de périphériques. Il est

soumis à des normes aussi bien sur ses caractéristiques physiques (forme,
considérations électriques ou optiques) que logiques (quel fil/patte/connecteur sert à
quoi, que signifie tel ou tel signal en entrée, en sortie). Par exemple, USB 2.

♦ Port logiciel qui permet, sur un ordinateur donné, de distinguer différents
interlocuteurs. Ces interlocuteurs sont des programmes informatiques qui, selon les
cas, écoutent ou émettent des informations sur ces ports.
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Portail, n.m.

Définition : Page d'accueil d'un site de l'internet mettant à la disposition de l'internaute
un large ensemble de ressources et services intérieurs et extérieurs au site.

Note : Par extension, ce terme désigne aussi l'organisme qui fournit une telle page
d'accueil.
Équivalent étranger : portal.

PostScript, n.m.

Définition : Langage complet de programmation spécialisé dans la description de page,
mis au point par Adobe qui repose sur des formulations vectorielles de ses éléments.
Ce langage interplates-formes permet d'obtenir un fichier unique comportant tous les
éléments constituant la page (textes, images, polices, couleurs, etc.).

Processeur, n.m.

Synonyme : CPU, Central Processing Unit Définition : C'est le cerveau de l'ordinateur.
Composant essentiel d'un ordinateur, qui exécute les programmes et où sont effectués
les principaux calculs. Il permet de manipuler des informations numériques,
c'est-à-dire des informations codées sous forme binaire, et d'exécuter les instructions
stockées en mémoire. Sa cadence (le nombre de micro-instructions qu'il effectue en
une seconde) est exprimée en Hertz (Hz).

Équivalent français : Unité centrale [de traitement].

Progiciel, n.m.

Définition : Terme qui résulte de la contraction des mots produit et logiciel. C'est un
logiciel commercial vendu par un éditeur sous forme d'un produit complet, composé
de plusieurs modules, plus ou moins « clé en mains ». Ce terme s'oppose aux logiciels
développés « en interne » dans une entreprise pour remplir des fonctions « sur mesure
».
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Protocole, n.m.

Définition : Méthode standard qui permet la communication entre des processus
(s'exécutant éventuellement sur différentes machines), c'est-à-dire un ensemble de
règles et de procédures à respecter pour émettre et recevoir des données sur un réseau.
Il en existe plusieurs selon ce que l'on attend de la communication. Certains protocoles
seront par exemple spécialisés dans l'échange de fichiers (le FTP), d'autres pourront
servir à gérer simplement l'état de la transmission et des erreurs (c'est le cas du
protocole ICMP), ...Sur Internet, les protocoles utilisés font partie d'une suite de
protocoles, c'est-à-dire un ensemble de protocoles reliés entre-eux. Cette suite de
protocole s'appelle TCP/IP.

Provider, n.m.

Voir : fournisseur d'accès internet.

Question(s) courante(s)

Voir : foire aux questions.
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Raccordement numérique
asymétrique, n.m.

Abréviation : RNA. Synonyme : liaison numérique à débit asymétrique.

Définition : Technique de transmission numérique offrant deux canaux de données à
haut débit sur une ligne téléphonique ordinaire en paire symétrique, le débit dans le
sens du réseau étant très supérieur au débit dans l'autre sens.

Note
♦ Dans le sens du réseau vers l'utilisateur, le débit est suffisant pour permettre la

distribution de programmes de télévision ou de documents multimédias, notamment
en provenance de l'internet. Il est de l'ordre de 600 à 800 kbit/s dans l'autre sens. En
outre, le canal téléphonique est conservé.

♦ L'expression " ligne numérique à paire asymétrique " ne doit pas être utilisée car il
s'agit d'une transmission asymétrique sur paire symétrique.

Équivalent étranger : asymetric (bit rate) digital subscriber line, ADSL.

Raccourci clavier, n.m.

Définition : Touche ou combinaison de touches du clavier qui peut se substituer à une
séquence de commandes plus complexes.

Équivalent étranger : hot key.

RAM (Random Access Memory), n.f.

Définition : Type de mémoire informatique à accès aléatoire (par opposition à
séquentiel) et en lecture-écriture (par opposition à la lecture seule). On l'appelle aussi
mémoire volatile pour signifier que toutes les données sont perdues à l'extinction de
l'alimentation électrique. Il s'agit typiquement de la mémoire électronique qui contient
les données en cours de traitement dans un ordinateur.

Équivalent français : mémoire vive.

Glossaire 297



RAW

Définition : Format d'images numériques qui n'est pas réellement un standard, mais
plutôt une désignation commune pour les fichiers générés par les dispositifs tels
qu'appareils photos numériques, ou scanners, et n'ayant subit aucun traitement. Ces
fichiers sont généralement spécifiques à chaque constructeur d'appareil, voire à chaque
appareil, et nécessitent donc souvent un logiciel spécial pour pouvoir les exploiter.

Note : Un fichier au format RAW est un fichier numérique peu compressé qui contient
les informations brutes enregistrées par le capteur de l'appareil photo. Ce fichier est en
quelque sorte « en attente de développement » dans la mesure où il n'a subi aucun des
traitements de linéarisation, dématriçage, contraste, luminosité ou saturation,
nécessaires pour produire une image lisible. C'est le format le plus utilisé par les
photographes, car il leur donne une entière maîtrise sur leurs images en leur permettant
d'effectuer ces traitements par eux-mêmes (un peu comme en argentique lorsque l'on
développe soi-même depuis ses négatifs).

Réamorcer, v.tr.

Définition : Provoquer de nouveau l'exécution de l'amorce.

Équivalent étranger : reboot (to).

Recherche individuelle, n.f.

Définition : Technique utilisée sur la toile mondiale lorsque l'internaute recherche des
données par une démarche active au moyen de son logiciel de navigation, qui lui
présentera ensuite le résultat de cette recherche.

Note : La recherche individuelle se distingue de la distribution sélective.
Équivalent étranger : pull technology.

Recopie incrémentée

Recopie générant une liste ordonnée de valeurs. Exemple : 1, 2, 3, ... ; Lundi, Mardi,
Mercredi... …
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Référence

Adresse d'une cellule (ex. : C7) ou d'une plage de cellules (ex. : B6:E10).

Référentiel, n. m.

Définition : Ensemble structuré d'informations, utilisé pour l'exécution d'un logiciel, et
constituant un cadre commun à plusieurs applications.

Équivalent étranger : repository.

Référence externe

Référence à une cellule se trouvant dans une autre feuille, ou un autre classeur

Réinitialiser, v.tr.

Définition : Remettre un système informatique ou une application dans son état initial.

Équivalent étranger : reset (to).

Relative

Référence définie par rapport à une autre position (à gauche, en haut, ...)

Release, n.f.

Définition : Nouvelle version d'un logiciel dont elle correspond à un état donné. Elle
est souvent associée à une numérotation qui permet de l'identifier, voire dans certains
cas à un nom symbolique.
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Renater (réseau national de
télécommunications pour la
technologie, l'enseignement et la
recherche), n. m.

Définition : Réseau informatique français reliant les différentes universités et les
différents centres de recherche entres eux en France Métropolitaine et dans les
départements d'outre mer. Aujourd'hui, plus de 600 sites sont reliés, via une liaison
très haut débit (liaisons jusqu'à 10Gbps, coeur de réseau à 80Gbps en Île-de-France)
intégrant même progressivement les collèges et les lycées. Les organismes utilisateurs
sont : le CEA, le CNES, le CNRS, l'INRA, l'INRIA, l'INSERM, l'Éducation Nationale,
etc.

Réseau privé virtuel, n. m.

Définition : Extension des réseaux locaux qui procure une norme de sécurité en
télécommunications. Le réseau artificiellement créé consiste à utiliser Internet comme
support de transmission en utilisant un protocole de « tunnelisation » (en anglais
tunneling), c'est-à-dire encapsulant les données à transmettre de façon chiffrée. Ce
réseau dit virtuel relie deux réseaux « physiques » (réseaux locaux) par une liaison non
fiable (Internet), et privé car seuls les ordinateurs des réseaux locaux de part et d'autre
du VPN peuvent « voir » les données. Ce système permet donc d'obtenir une liaison
sécurisée à moindre coût, si ce n'est la mise en œ uvre des équipements terminaux. En
contrepartie il ne permet pas d'assurer une qualité de service comparable à une ligne
louée dans la mesure où le réseau physique est public et donc non garanti.

Équivalent étranger : Virtual Private Network, VPN.

Réseau informatique, n. m.

Locution. Abréviation : réseau n. m.

Définition : Ensemble des moyens matériels et logiciels mis en oeuvre pour assurer les
communications entre ordinateurs, stations de travail et terminaux informatiques.
Note : Tout ou partie de ces matériels peuvent être considérés comme faisant partie du
réseau.
Équivalent étranger : computer network.
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Résolution, n. f.

Définition : Nombre de pixels par unité de longueur ou unité de surface, exprimé en
ppp (point/pixel par pouce) ou dpi (dot per inch) .

Note : Une résolution de 300 dpi signifie 300 colonnes et 300 rangées de pixels sur un
pouce carré ce qui donnerait donc 90000 pixels sur un pouce carré. La résolution de
référence de 72 dpi nous donne un pixel de 1"/72 (un pouce divisé par 72) soit
0.353mm, correspondant à un point pica (unité typographique anglo-saxonne).

Riper, v.tr.

Définition : Extraire directement d'un support enregistré des données numériques en
vue de les reporter sur un autre support, sans recourir à la conversion analogique
intermédiaire habituellement nécessaire.

Équivalent étranger : rip (to).

RNIS (Réseau numérique à
intégration de services), n. m.

Synonyme : Numéris (nom commercial du réseau téléphonique de France Télécom
basé sur la technologie RNIS).

Définition : Liaison autorise une meilleure qualité et des vitesses pouvant atteindre 2
Mb/s (accès S2) contre 56 Kb/s pour un modem classique.
Équivalent étranger : ISDN (Integrated Services Digital Network).

ROM (Read Only Memory), n.f.

Définition : Type de mémoire informatique impossible à modifier qui n'est pas
volatile, c'est-à-dire qu'elle ne perd pas ses données, en l'absence de courant électrique,
contrairement à la mémoire vive. Note : Ce type de mémoire permet notamment de
conserver les données nécessaires au démarrage de l'ordinateur. En effet, ces
informations ne peuvent être stockées sur le disque dur étant donné que les paramètres
du disque (essentiels à son initialisation) font partie de ces données vitales à
l'amorçage.

Équivalent français : mémoire morte.
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Routage, n. m.

Définition : Mécanisme par lequel les données d'un équipement expéditeur sont
acheminées jusqu'à leur destinataire, même si aucun des deux ne connaît le chemin
complet que les données devront suivre. Avoir une procédure de routage efficace est
particulièrement important pour les réseaux décentralisés.

Routeur, n. m.

Définition : Matériel de communication de réseau informatique. Machine clé d'Internet
permettant de "choisir" le chemin qu'un message va emprunter. Lorsque vous
demandez une URL, le client Web interroge le DNS, celui-ci indique l'adresse IP de la
machine visée. Votre poste de travail envoie la requête au routeur le plus proche (en
général la passerelle du réseau) qui choisit la prochaine machine à laquelle il va faire
circuler la demande de telle façon que le chemin choisi soit le plus court.

RTF (Rich Text Format), n. m.

Définition : Format de fichier développé par la société Microsoft. Ce format descriptif
non compressé est reconnu par la plupart des logiciels de traitement de texte. Sa
vocation initiale est celle d'un format de texte mis en forme pivot entre logiciels et
plates-formes hétérogènes.

RVB (Rouge Vert Bleu), n. m.

Définition : Format de codage des couleurs. Les trois couleurs rouge, vert et bleu sont
les couleurs primaires. Elles correspondent en fait à peu près aux trois longueurs
d'ondes auxquelles répondent les trois types de cônes de l'œ il humain. L'addition des
trois donne du blanc, lumière parfaite pour l'œ il humain. Ces couleurs sont utilisées en
vidéo, pour l'affichage sur les écrans, et dans les logiciels d'imagerie.formes
hétérogènes.
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Sauvegarde n. f.

Définition : Opération consistant à mettre en sécurité les données contenues dans un
système informatique. Par extension et par emprunt à l'anglais (to save), ce mot
s'applique à tout enregistrement d'information sur un support permanent (par ex.
l'écriture sur disque dur d'informations en mémoire vive). Dans ce sens, il est
synonyme de « stockage d'information ». Mais le sens premier se rapproche de celui
d'archivage, de conservation.

Note : La technique la plus fréquente est la recopie des données sur un support
indépendant de l'ordinateur et donc utilisable sur un autre ordinateur en cas de panne
ou de perte des données initiales. L'opération inverse qui consiste à réutiliser des
données sauvegardées s'appelle une restauration. On parle de « stockage » pour les
données sauvegardées en attente d'une éventuelle restauration.

Scanneur n. m.

Définition : Numériseur à balayage pouvant inclure un traitement de l'information
numérisée.

Voir aussi : numériseur.
Équivalent étranger : RGB (Red Green Blue).

Scrutation n. f.

Définition : Examen répété de l'état d'un ou plusieurs éléments d'un système pour y
détecter un changement éventuel.

Note : Cette notion a également été définie par la commission spécialisée de
terminologie des télécommunications sous la désignation d'« invitation à émettre »
(arrêté du 3 octobre 1984, Journal Officiel du 10 novembre 1984).
Équivalent étranger : polling.
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Serveur n. m.

Définition : Système informatique destiné à fournir des services à des utilisateurs
connectés et, par extension, organisme qui exploite un tel système.

Note : Un serveur peut par exemple permettre la consultation et l'exploitation directe
de banques de données.
Équivalent étranger : server, on-line data service.

Serveur mandataire n. m.

Abréviation : mandataire.

Définition : Dispositif informatique associé à un serveur et réalisant, pour des
applications autorisées, des fonctions de médiation, telle que le stockage des
documents les plus fréquemment demandés ou l'établissement de passerelles.
Voir aussi : passerelle, serveur.
Équivalent étranger : proxy server, proxy.

Serveur de messagerie n. m.

Définition : Logiciel serveur de courrier électronique ayant pour vocation de transférer
les messages électroniques d'un serveur à un autre. Un utilisateur n'est jamais en
contact direct avec ce serveur mais utilise soit un client e-mail, soit un webmél, qui se
charge de contacter le serveur pour envoyer ou recevoir les messages. La plupart des
serveurs de messagerie possèdent ces deux fonctions (envoi/réception), mais elles sont
indépendantes et peuvent être dissociées physiquement en utilisant plusieurs serveurs.

Note : Entre l'utilisateur et son serveur, l'envoi d'un courrier électronique se déroule
généralement via le protocole SMTP. Puis c'est au serveur d'envoyer le message au
serveur du destinataire, cette fonction est appelée Mail Transfer Agent en anglais, ou
MTA. La réception du courrier électronique se déroule généralement via le protocole
POP3 ou IMAP.

Système de Gestion de Base de
Données

Ensemble de programmes qui assurent la gestion et l'accès à une ou plusieurs bases de
données. Pour simplifier, cet ensemble est appelé SGBD.

304 MODULE B4 - REALISER DES DOCUMENTS DESTINES A ETRE IMPRIMES – TABLEURS



Shareware n. m.

Définition : logiciel propriétaire, protégé par le droit d'auteur, dont l'usage peut être
limité dans le temps ou dans les fonctionnalités, à moins d'en rétribuer l'auteur.

Note : Le mot partagiciel est un calque du mot anglais shareware également très
souvent utilisé en français.
Shareware est lui-même une contraction de share et software. Share se traduit ici par
contribution. On peut aussi trouver le terme contribuciel, mais plus rarement.
Équivalent français : partagiciel, particiel.

Signet n. m.

Définition : Moyen d'accéder rapidement à une adresse universelle préalablement
stockée en mémoire par l'utilisateur.

Voir aussi : adresse universelle.
Équivalent étranger : bookmark.

Signature de virus n. f.

Forme abrégée : signature, n.f.

Définition : Suite d'éléments binaires commune à chacune des copies d'un virus ou
d'un ver particulier, et utilisée par les logiciels antivirus pour détecter leur présence.
Voir aussi : logiciel antivirus, ver, virus.
Équivalent étranger : virus signature.

Site (internet) n.m.

Définition : Ensemble de documents et d'applications placés sous une même autorité et
accessibles par la toile à partir d'une même adresse universelle.

Note : Un site de la toile peut être inclus dans un site plus important.
Équivalent étranger : website, web site.
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Slot, n.m.

Définition : Emplacement muni d'un connecteur, qui permet l'insertion d'un élément
électronique amovible dans un ordinateur.

Équivalent français : logement.

SMTP (Simple Mail Transfert
Protocol) , n.m.

Définition : Protocole standard assez simple de communication utilisé pour transférer
le courrier électronique vers les serveurs de messagerie électronique. Dans ce
protocole fonctionnant en mode connecté, on commence par spécifier le ou les
destinataires d'un message puis, l'expéditeur du message, puis, en général après avoir
vérifié leur existence, le corps du message est transféré.

Spamming n. m.

Définition : Envoi d'un même message électronique à un très grand nombre de
destinataires au risque de les importuner.

Note : Un exemple est l'envoi de messages publicitaires.
Voir aussi : arrosage.

Streaming n. m.

Définition : Principe utilisé principalement pour l'envoi de contenu en « direct » (ou en
léger différé). Très utilisé sur Internet, il permet de commencer la lecture d'un flux
audio ou vidéo à mesure qu'il est diffusé. Il s'oppose ainsi à la diffusion par
téléchargement qui nécessite par exemple de récupérer l'ensemble des données d'un
morceau ou d'un extrait vidéo avant de pouvoir l'écouter ou le regarder.

Note : Le lecteur de contenu streaming va récupérer une partie du contenu qu'il met
dans une mémoire tampon (dite buffer). Lorsque le programme estime qu'il a
suffisamment de données dans sa mémoire tampon pour lui permettre de lire le
contenu audio ou vidéo sans accroche, même en cas de petit ralentissement réseau, la
lecture démarre.
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Suite informatique n. f.

Forme abrégée : suite, n.f.

Définition : Ensemble de logiciels commercialisés ou diffusés ensembles (par exemple
: Microsoft Office, Open Office).

SVG (Scalable Vector Graphics) ,
n.m.

Définition : Format de fichier basé sur XML permettant de décrire des ensembles de
graphiques vectoriels. Ce format est une spécification du W3C.

Synchrone, adj.

Définition : Dans le cadre de la programmation en temps réel, les processus ou tâches
sont autonomes, mais doivent communiquer entre eux. En mode synchrone, les deux
acteurs sont présents en même temps et leur déroulement est suspendu pour attendre
l'autre. Exemples : Chat, téléphone, vidéoconférence, tableau blanc.

Voir : asynchrone (En mode asynchrone, les acteurs envoient des messages ou les
déposent dans une boîte aux lettres.)

Système d'adressage par domaines,
n.m.

Abréviation : adressage par domaines. Synonyme : annuaire des domaines.

Définition : Système de bases de données et de serveurs assurant la correspondance
entre les noms de domaine ou de site utilisés par les internautes et les adresses
numériques utilisables par les ordinateurs. Note : Ce système permet aux internautes
d'utiliser, dans la rédaction des adresses, des noms faciles à retenir au lieu de la suite
de chiffres du protocole IP. Exemple : le nom du serveur sur la toile mondiale du
ministère de la culture et de la communication est " www.culture.gouv.fr ".
Voir aussi : adresse universelle, domaine, internaute.
Équivalent étranger : domain name system, DNS.
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Système d'exploitation, n.m.

Abréviation : SE.

Définition : Ensemble de programmes responsables de la liaison entre les ressources
matérielles d'un ordinateur et les applications de l'utilisateur (traitement de texte, jeu
vidéo...). Il assure le démarrage de l'ordinateur et fournit aux programmes applicatifs
des interfaces standardisées pour les périphériques.
Équivalent étranger : operating system, OS.

Table

Endroit organisé en Lignes/Colonnes où sont stockées les informations d'une base de
données relationnelles. L'ensemble des tables constitue la base de données.

Tableur

Logiciel de création et de manipulation interactives de tableaux numériques.
Équivalent étranger : spreadsheet, spreadsheet software.

TCP/IP (Transmission Control
Protocol / Internet Protocol), n. m.

Se prononce «T-C-P-I-P». Définition : Il provient des noms des deux protocoles
majeurs de la suite de protocoles, c'est-à-dire les protocoles TCP et IP. Cette suite de
protocoles représente d'une certaine façon l'ensemble des règles de communication sur
internet et se base sur la notion adressage IP, c'est-à-dire le fait de fournir une adresse
IP à chaque machine du réseau afin de pouvoir acheminer des paquets de données.

Etant donné que la suite de protocoles TCP/IP a été créée à l'origine dans un but
militaire, elle est conçue pour répondre à un certain nombre de critères parmi lesquels :
♦ Le fractionnement des messages en paquets ;

♦ L'utilisation d'un système d'adresses ;

♦ L'acheminement des données sur le réseau (routage) ;

♦ Le contrôle des erreurs de transmission de données.
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Téléchargement n. m.

Définition : Transfert de programmes ou de données d'un ordinateur vers un autre.

Note : Pour un internaute, le téléchargement est le plus souvent un transfert vers son
propre ordinateur à partir d'un serveur, mais il peut avoir lieu dans l'autre sens.
Équivalent étranger : downloading (téléchargement à partir d'un autre ordinateur),
uploading (téléchargement vers un autre ordinateur).

TIFF (Tag(ged) Image File Format),
n. m.

Définition : format de fichier extrêment flexible pour image numérique. Ancien format
graphique, permettant de stocker des images bitmap (raster) de taille importante (plus
de 4 Go compressées), sans perdition de qualité et indépendamment des plates formes
ou des périphériques utilisés (Device-Independant Bitmap, noté DIB). Ce format
permet de stocker des images en noir et blanc, en couleurs réelles (True color, jusqu'à
32 bits par pixels) ainsi que des images indexées, faisant usage d'une palette de
couleurs. Le principe du format TIF consiste à définir des balises (en anglais tags, d'où
le nom Tagged Image File Format) décrivant les caractéristiques de l'image.

Toile d'araignée mondiale ou, ellipt.,
toile mondiale, toile n. f. sg.

Abréviation : T.A.M.

Définition : Dans l'internet, système, réparti géographiquement et structurellement, de
publication et de consultation de documents faisant appel aux techniques de
l'hypertexte.
Voir aussi : hypertexte, internet.
Équivalent étranger : World Wide Web.
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Tutoriel n. m.

Définition : Document de tout type qui permet d'aider l'utilisateur à se former de
manière autonome à un logiciel. Il s'agit d'un outil pédagogique qui peut se présenter
sous la forme d'un autre logiciel, d'une vidéo, d'un document textuel, ou d'instructions
détaillées pas-à-pas. On évite en général l'anglicisme tutorial (déconseillé par les
organismes de néologie français et québéquois) qui poserait des difficultés au pluriel.

Note : Le mot n'est pas synonyme de didacticiel.
Équivalent étranger : tutorial .

Unité centrale n. f.

Abréviation : UC

Définition : Partie de l'ordinateur qui effectue tous les traitements de base et qui est
entourée de périphériques : disque dur, processeur graphique... auquels l'UC accède au
travers de contrôleurs dédiés.

URL (Uniform Resource Locator) n.
f.

Synonymes : Adresse Web, adresse internet.

Définition : Adresse physique d'une page Web. Il s'agit d'une chaîne de caractères
ASCII imprimables qui se décompose en quatre parties : le nom du protocole, le nom
du serveur, le numéro de port et le chemin d'accès à la ressource.
Note : traduction littérale en français "Repère uniforme de ressource".
Equivalent français : adresse réticulaire.

USB (Universal Serial Bus) n. m.

Définition : Interface entrée-sortie. Bus informatique plug-and-play ("branchez et
utilisez") qui permet de connecter des périphériques externes à un ordinateur.
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Vectoriel, adj.

Définition : Qui est composée d'objets géométriques (lignes, points, polygones,
courbes, ...) ayant des attributs de forme, de position, de couleur, etc., permettant de
produire des images. Se différencie de cette manière du bitmap, dans lequel on
travaille sur des pixels.

ver, n.m.

Définition : Logiciel malveillant indépendant qui se transmet d'ordinateur à ordinateur
par l'internet ou tout autre réseau et perturbe le fonctionnement des systèmes
concernés en s'exécutant à l'insu des utilisateurs.

Note :
♦ Contrairement au virus, le ver ne s'implante pas au sein d'un autre programme.

♦ Les vers sont souvent conçus pour saturer les ressources disponibles ou allonger la
durée des traitements. Ils peuvent aussi détruire les données d'un ordinateur,
perturber le fonctionnement du réseau ou transférer frauduleusement des
informations. Un ver peut produire des effets soit immédiatement soit de manière
différée (à une date donnée, lors de la survenue d'un évènement ou par
déclenchement d'une bombe programmée).

♦ Bien qu'ils s'en distinguent, les vers sont parfois appelés « virus ».

Voir aussi : logiciel malveillant, virus.

Équivalent étranger : worm.

VGA (Video Graphics Array) n. m.

Définition : Standard d'affichage pour ordinateurs, appartenant à une famille de
standards d'IBM et reste compatible avec les précédents formats. Le format utilise 256
kilooctets (ko) de mémoire vidéo et fonctionne selon deux modes : 16 couleurs ou 256
couleurs choisies parmi une palette de 262144 couleurs. La définition maximum est de
720 colonnes par 480 lignes (720 x 480) avec un taux de rafraîchissement de 70 Hertz.
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Vidéoconférence n. f.

Synonyme : Visioconférence

Définition : Dispositif reposant sur l'emploi de caméra, (webcaméras, ou système plus
sophistiqué), de microphone, et de micro-ordinateur, permettant à plusieurs
participants d'interagir images et son en temps réel.

Virus, n.m.

Définition : Logiciel malveillant, généralement de petite taille, qui se transmet par les
réseaux ou les supports d'information amovibles, s'implante au sein des programmes
en les parasitant, se duplique à l'insu des utilisateurs et produit ses effets
dommageables quand le programme infecté est exécuté ou quand survient un
évènement donné.

Note : Dans le langage courant, les vers sont souvent désignés par le terme « virus ».
Voir aussi : logiciel malveillant, ver.
Équivalent étranger : virus.

Visionneur n. m.

Définition : Logiciel permettant d'afficher un document sans disposer du logiciel qui a
servi à le produire.

Équivalent étranger : viewer.

Voix sous réseau IP n. f.

Abréviation : VoIP

Synonymes : téléphonie IP, téléphonie sur internet
Définition : Technique qui permet de communiquer par voix à distance via le réseau
Internet, ou tout autre réseau acceptant le protocole TCP/IP.
Équivalent étranger : Voice over IP.
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W3C (World Wide Web Consortium)
n. m.

Définition : Consortium fondé en octobre 1994 pour promouvoir la compatibilité des
technologies du World Wide Web telles que HTML, XHTML, XML, CSS, PNG, ...
Le W3C n'émet pas des normes, mais des recommandations. Le consortium laisse le
soin aux fabricants de suivre ces recommandations et ne possède pas de programme de
certification, beaucoup de standards ne définissent pas formellement un niveau de
conformité. Ils sont ainsi souvent implantés partiellement.

Web n. m.

Synonyme : World Wild Web

Définition : Système hypertexte public fonctionnant sur Internet et qui permet de
consulter, avec un navigateur internet, des pages internet mises en ligne dans des sites
internet. L'image de la toile vient des hyperliens qui lient les pages internet entre elles.
Equivalent français : toile, toile d'araignée mondiale.

Webmastering n. m.

Définition : Ensemble des tâches nécessaires à l'exploitation d'un site web.

Equivalent français : toile, toile d'araignée mondiale.

Webmestre n. m.

Définition :
♦ Responsable d'un site Web.

♦ Personne en charge d'un site web, c'est-à-dire généralement la personne qui conçoit
un site web et le met à jour.

Equivalent anglais : webmaster.
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Webring n. m.

Définition : Ensemble de sites sur la toile, consacrés à des sujets apparentés et ayant
entre eux des liens privilégiés.

Wiki n. m.

Définition : Site Web dynamique permettant à tout individu d'en modifier les pages à
volonté. Il permet non seulement de communiquer et diffuser des informations
rapidement, mais de structurer cette information pour permettre d'y naviguer
commodément.

Note : Le nom wiki vient du terme hawaiien wiki wiki, qui signifie « rapide » ou «
informel ».

Windows n. m.

Définition : Gamme de systèmes d'exploitation produite par Microsoft, principalement
destinées aux compatibles PC. Cette gamme est composée de plusieurs branches :
♦ La première (de Windows 1 à 3.11) est née en 1985. C'était une interface graphique

pour compatibles PC basée sur un noyau MS-DOS.

♦ La seconde branche (Windows NT, 2000) est apparue en 1993. C'est un système
d'exploitation complet, de conception robuste et portable, destiné aux ordinateurs
personnels comme aux serveurs. Windows XP est la fusion de cette seconde branche
avec la troisième, composée de Windows 95, 98 et Me.

♦ La troisième branche, la plus connue du grand public, est apparue en 1995 afin de
remplacer la première. Il existe enfin une quatrième branche (Windows Mobile)
prévue pour être utilisée sur du matériel léger et portable (assistant personnel,
téléphone portable).
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WYSIWYG (What You See Is What
You Get) n. m.

Définition : Acronyme de la locution anglaise « What you see is what you get »
signifiant littéralement « ce que vous voyez est ce que vous obtenez » ou plus
élégamment « tel écran, tel écrit », couramment utilisée en informatique pour désigner
les interfaces utilisateur graphiques permettant de composer visuellement le résultat
voulu, typiquement pour un logiciel de mise en page, un traitement de texte ou
d'image. Il désigne, de fait, une interface « intuitive » : l'utilisateur voit directement à
l'écran à quoi ressemblera le résultat final (imprimé).

Note : acronyme parfois opposé au « What you see is what you want » .
Equivalent français : Tel-tel.

WYSIWYM (What You See Is What
You Mean) n. m.

Définition : Acronyme utilisée en informatique qui vient de l'anglais « What you see is
what you mean », signifiant « ce que vous voyez est ce que vous voulez dire ».

XHTML (Extensible HyperText
Markup Language) n. m.

Définition : Langage balisé servant à l'écriture de pages du World Wide Web.
XHTML est le successeur de HTML (de l'anglais HyperText Markup Language),
XHTML respectant la syntaxe définie par XML, plus récente et plus simple que la
syntaxe définie par SGML respectée par HTML.
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XML (eXtensible Markup Language)
n. m.

Définition : Langage HTML amélioré permettant de définir de nouvelles balises. Il
s'agit effectivement d'un langage permettant de mettre en forme des documents grâce à
des balises (markup). Ce standard du World Wide Web Consortium (W3C) sert de
base pour créer des langages de balisage : c'est un « méta-langage ». En ce sens, il
permet de définir un vocabulaire et une grammaire associée sur base de règles
formalisées. Il est suffisamment général pour que les langages basés sur XML, appelés
aussi dialectes XML, puissent être utilisés pour décrire toutes sortes de données et de
textes. Il s'agit donc partiellement d'un format de données. L'extensibilité de XML est
principalement assurée par la notion d'espace de nommage.

Equivalent français : « langage de balisage extensible ».

XSL (eXtensible Stylesheet
Language) n. m.

Définition : Langage recommandé par le W3C pour effectuer la représentation des
données de documents XML. Ce langage de description e feuilles de style est
lui-même défini avec le formalisme XML, cela signifie qu'une feuille de style XSL est
un document XML bien formé.

ZIP n. m.

Définition :
♦ Format de compression Format de fichier permettant la compression de données.

♦ Stockage de données Disquettes épaisses crées par la société Iomega, lisibles par un
lecteur spécial (lecteur Zip). D'une capacité de stockage de 100 Mo puis de 250 Mo,
puis de 750 Mo, elles ont constitué un intermédiaire intéressant entre les disquette
de 90 mm (3 pouces et demi) de 1,44 Mo, et les CD-ROM réinscriptibles.
Cependant, le prix du support, la lenteur et le manque de fiabilité de ces lecteurs,
associé à l'apparition des clés USB ne lui ont pas permis de s'imposer comme l'avait
fait le lecteur de disquette 3 pouces et demi à son époque.
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Pour aller plus loin ...
"Spécifique Excel"

"Spécifique Excel"

Exemple : intégration d'un diagramme en bâtons.

Cliquez sur le lien suivant afin de visualiser l'animation.
Animation "Création d'histogramme sous Microsoft
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap1/animation_creation_histogramme_MS.htm]

"Spécifique Excel"

Exemple : formatage d'un tableau.

Cliquez sur le lien suivant afin de visualiser l'animation.
Animation "Présentation sous Microsoft
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap1/presentation_MS.htm]

"Spécifique Excel"

Exemple : Intégration tableau Excel dans un document composite Word.

Cliquez sur le lien suivant afin de visualiser l'animation.
Animation "Intégration tableau Excel dans un document composite
Word" [http://projet.c2imes.org/V2/tutorielsB5/Chap1/capture_1-7.swf.html]

"Spécifique Excel"

Exemple : réalisation d'un filtre pour ne montrer que les articles dont la quantité
dépasse 50.

Cliquez sur le lien suivant afin de visualiser l'animation.
Animation "Réalisation d'un filtre pour ne montrer que les articles dont la quantité
dépasse
50" [http://projet.c2imes.org/V2/tutorielsB5/Chap1/capture_1-8_MS.swf.html]



"Spécifique Excel"

Exemple : programmation d'une fonction f(x) = x2 en Visual Basic.

Cliquez sur le lien suivant afin de visualiser l'animation.
Animation "Programmation d'une fonction f(x) = x2 en Visual
Basic" [http://projet.c2imes.org/V2/tutorielsB5/Chap1/capture_1-9_MS.swf.html]

"Spécifique Excel"

Exemple : automatiser le remplissage de 10 cellules par des nombres qui se suivent.

Cliquez sur le lien suivant afin de visualiser l'animation.
Animation "Automatiser le remplissage de 10 cellules par des nombres qui se
suivent" [http://projet.c2imes.org/V2/tutorielsB5/Chap1/capture_1-10_MS.swf.html]

"Spécifique Excel"

Exemple : lancer une macro par un bouton de commande incorporé à une feuille de
calcul.

Cliquez sur le lien suivant afin de visualiser l'animation.
Animation "Lancer une macro par un bouton de commande incorporé à une feuille de
calcul sous
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap1/capture_1-11_MS.swf.html]
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IMG. 221
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"Spécifique Excel"

Tous les documents s'ouvrent à l'intérieur de la fenêtre d'application. Il est possible de
les mettre en évidence en utilisant leur bouton « niveau inférieur » qui se trouve
dessous ceux de la fenêtre d'application.

IMG. 222 : BOUTON « NIVEAU INFÉRIEUR » DE LA FENÊTRE DU DOCUMENT - SPÉCIFIQUE EXCEL

Vous pouvez également réduire la fenêtre du document :

IMG. 223 : RÉDUCTION DE LA FENÊTRE DU DOCUMENT - SPÉCIFIQUE EXCEL

Le classeur se trouve alors réduit dans l'espace de travail mais à l'intérieur de la zone
d'affichage de la fenêtre d'application :

IMG. 224 : CLASSEUR APRÈS SA RÉDUCTION DANS LA FENÊTRE DE L’APPLICATION - SPÉCIFIQUE EXCEL

"Spécifique Excel"

remarque

Si vous avez plusieurs classeurs ouverts, vous pouvez les réorganiser dans la fenêtre de
l'application avec le menu Fenêtre > Réorganiser (Mosaïque, Horizontal, Vertical,
Cascade).

IMG. 225 : RÉORGANISATION DE 2 CLASSEURS EN HORIZONTAL - SPÉCIFIQUE EXCEL
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Il est possible de passer d'un document à l'autre en utilisant le menu Fenêtre de
l'application.

"Spécifique Excel"

IMG. 226 : BARRE D’OUTILS FLOTTANTE - SPÉCIFIQUE EXCEL

"Spécifique Excel"

IMG. 227 : DISPOSITION PRATIQUE DES BARRES D’OUTILS « STANDARD » ET « FORMAT » - SPÉCIFIQUE EXCEL

"Spécifique Excel"

Exemple

Voir l'animation pour ancrer la barre d'outils « Dessin » sous la barre de défilement :
cliquez sur le lien suivant afin de visualiser l'animation.

Animation "Ancrer la barre d'outils Dessin sous la barre de défilement dans
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap1/capture_1-12_MS.swf.html]

"Spécifique Excel"

IMG. 228 : OPTION POUR DÉPLACER LA SÉLECTION APRÈS VALIDATION - SPÉCIFIQUE EXCEL
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"Spécifique Excel"

Pour accéder rapidement à une cellule, vous pouvez ... :
♦ taper sa référence dans la zone de nom,

♦ ou utiliser le menu Edition > Atteindre.

IMG. 229 : ATTEINDRE UNE ZONE DE LA FEUILLE DE CALCUL - SPÉCIFIQUE EXCEL

"Spécifique Excel"

remarque

Vous pouvez également double-cliquer sur l'onglet et modifier directement le nom de
la feuille.

"Spécifique Excel"

IMG. 230 : INSÉRER UNE FEUILLE AVEC LE MENU CONTEXTUEL - SPÉCIFIQUE EXCEL

"Spécifique Excel"

Les fichiers ayant l'extension « .xls » sont au format natif (par défaut) de l'application
Microsoft Office Excel.

"Spécifique Excel"

IMG. 231 : ENREGISTRER UN FICHIER - SPÉCIFIQUE EXCEL

"Spécifique Excel"

Options régionales et linguistiques
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Vérifiez les options régionales et linguistiques de l'environnement (Windows)
accessibles dans le panneau de configuration.

Choisissez le format « Français (France) ».

"Spécifique Excel"

« Entrer » dans la barre d'état

"Spécifique Excel"

conseil

Outils > Options > Modification > Déplacer la sélection après validation - Sens : Bas

IMG. 232 : RÉSULTAT DE LA SAISIE - SPÉCIFIQUE EXCEL

"Spécifique Excel"

Pour supprimer la modification directe, utilisez le menu : Outils > Options >
Modification : décochez « Modification directe ».

"Spécifique Excel"

♦ Pour effacer le contenu : touche SUPPR.

♦ Pour effacer le format : menu Edition > Effacer > Formats.

♦ Pour effacer le contenu et le format : menu Edition > Effacer > Tout.

"Spécifique Excel"

IMG. 233 : FORMATAGE DES DONNÉES - SPÉCIFIQUE EXCEL

Le résultat du formatage est indiqué dans la zone intitulée « Exemple ». Vous pouvez
ainsi vérifier le format avant de le valider.
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"Spécifique Excel"

♦ Menu Format > Cellule > Nombre - Catégorie : Standard.

♦ Menu contextuel (clic-droit) puis Format de cellule.

♦ Menu Edition > Effacer > Formats.

"Spécifique Excel"

♦ Cliquez sur l'icône de la fonction « Reproduire la mise en forme ».

IMG. 234 : ICÔNE « REPRODUIRE LA MISE EN FORME » - SPÉCIFIQUE EXCEL

"Spécifique Excel"

Edition > Copier, puis Edition > Coller.

"Spécifique Excel"

Copier-coller avec la souris dans Excel

Le glisser-déposer + CTRL.

♦ Cliquez sur le lien suivant afin de visualiser l'animation.

Animation "Copier-Coller avec la souris dans
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap2/capture_002_MS.htm]

"Spécifique Excel"

Edition > Couper, puis Edition > Coller.

"Spécifique Excel"

Déplacer avec la souris dans Excel

Cliquez sur le lien suivant afin de visualiser l'animation.

Animation "Déplacer avec la souris dans
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap2/capture_003_MS.htm]
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"Spécifique Excel"

IMG. 235 : POIGNÉE DE RECOPIE - SPÉCIFIQUE EXCEL

"Spécifique Excel"

Recopie avec la poignée dans Excel

♦ Tirez ensuite vers le bas ou vers la droite pour recopier la valeur.

- Cliquez sur le lien suivant afin de visualiser l'animation.
Animation "Recopie avec la poignée de recopie dans
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap2/capture_004_MS.htm]

"Spécifique Excel"

Recopie incrémentée dans Excel

Cliquez sur le lien suivant afin de visualiser l'animation.

♦ Animation "Recopie incrémentée dans
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap2/capture_005_MS.htm]

"Spécifique Excel"

Outils > Options > Listes personnalisées.

"Spécifique Excel"

Edition > Collage spécial > Valeurs.

"Spécifique Excel"

Insertion de cellules dans MS Excel

Menu Insertion > Cellules.

"Spécifique Excel"

complement
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Avec Excel 2007, le nombre de ligne est porté à 1 048576 (220) et le nombre de
colonnes atteint 16384 (2^14).

"Spécifique Excel"

Pour modifier le style de référence, utilisez le menu Outils > Options. Dans l'onglet
Général, cochez ou décochez Style de référence L1C1.

"Spécifique Excel"

Menu Insertion > Nom > Définir.

"Spécifique Excel"

Un message vous avertit d'une erreur dans la formule et vous propose une correction
(fausse). Refusez-la et corrigez-la vous-même.

"Spécifique Excel"

Une petite icône avec un point d'exclamation vous donne une indication sur le type
d'erreur. Une bulle d'information précise : « Le type de données d'une valeur utilisée
dans la formule est incorrect ».

Cette icône n'est visible que si l'option de vérification des erreurs en arrière-plan est
activée : Menu Outils > Options > Vérification des erreurs.
La cellule affiche « #VALEUR! ».

"Spécifique Excel"

Un message d'erreur attire votre attention. En général la référence circulaire n'est pas
voulue et vous pouvez corriger votre formule.

Si vous validez, une double flèche B1↔ B3 indique que B1 dépend de B3 et
inversement. Dans la barre d'état, l'indicateur « Circulaire : B1 » affiche l'origine du
problème.

"Spécifique Excel"

IMG. 236
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"Spécifique Excel"

IMG. 237 : FONCTION SOMME - SPÉCIFIQUE EXCEL

La bulle d'information indique « nombre1 » pour la correspondance avec la plage
B1:B5. Il ne s'agit pas d'UN nombre, mais du premier argument de la fonction : le
deuxième argument « nombre2 » correspondrait à une deuxième plage de cellules que
vous voudriez ajouter à B1:B5.

"Spécifique Excel"
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♦ Créez une série incrémentée de 1 à 5 à partir de la cellule C1 ou recopiez la série
B1:B5 créée précédemment. Sélectionnez la cellule C6.

♦ Activez l'assistant de fonction :

- Avec le menu Insertion > Fonction.
- Avec l'icône à gauche de la barre de formule (Voir ci-dessous).

IMG. 238

A ce stade, vous pouvez rechercher la fonction moyenne dans la liste des fonctions
proposées. Un petit texte décrit la fonction sélectionnée. Vous pouvez aussi accéder à
une aide plus complète par le lien proposé.

Pour trouver plus rapidement une fonction, vous pouvez taper une brève description
de ce que vous voulez faire, ou sélectionner une catégorie (ici « Statistiques ») pour
limiter votre recherche.

♦ Une fois la fonction moyenne() trouvée, cliquez sur OK pour passer à l'étape
suivante où vous entrerez les arguments de la fonctions. Par défaut, la plage de
cellules au-dessus de la cellule active est sélectionnée. Vous pouvez changer cette
sélection avec le bouton

IMG. 239

Nombre1 n'est pas UN nombre, mais le premier argument de la fonction moyenne,
soit la plage C1:C5 dont vous voulez calculer la moyenne.

Le résultat de la fonction est affiché aux deux endroits indiqués sur la figure
suivante :

IMG. 240 : ASSISTANT DE FONCTION - SPÉCIFIQUE EXCEL
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♦ Validez.

Vous obtenez le résultat dans la feuille de calcul.

IMG. 241

IMG. 242 : ASSISTANT DE FONCTION - SPÉCIFIQUE EXCEL

"Spécifique Excel"

Recopie dans Excel

Cliquez sur le lien suivant afin de visualiser l'animation : Animation "Recopie dans
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap5/recopie_formule.htm]

"Spécifique Excel"

conseil

La touche de fonction F4 est très utilisée : chaque appui sur cette touche transforme
successivement une référence relative en référence absolue puis mixte puis de nouveau
relative.

"Spécifique Excel"

Exemple de référence externe dans Excel

« Feuil2 !B2 »

Elle fait apparaître le nom de la feuille suivi du symbole « ! » et de la référence
relative B2.

"Spécifique Excel"

Collage spécial dans Excel
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Edition > Collage spécial

"Spécifique Excel"

Copier le résultat de formules en valeurs dans Excel

Pour copier le résultat de formules en valeurs, sélectionnez la plage de cellules
contenant les formules, copiez-la, puis appelez le menu contextuel Edition > Collage
spécial : Valeurs.

Remarquez l'icône en bas à droite de la plage collée. Cette icône permet de
choisir les options de collage.

IMG. 243 : OPTIONS DE COLLAGE - SPÉCIFIQUE EXCEL

"Spécifique Excel"

Alignement à droite dans Excel

♦ Menu Format > Cellule > Alignement - Horizontal : Droite (Retrait).

♦ Ou cliquez sur l'icône de la barre d'outils :

IMG. 244

"Spécifique Excel"

Insertion d'un commentaire dans Excel
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Menu Insertion > Commentaire, puis entrez le commentaire : « Taux équivalent et non
proportionnel ! ».

IMG. 245 : INSERTION DE COMMENTAIRE - SPÉCIFIQUE EXCEL

Le nom de l'utilisateur insérant le commentaire est automatiquement rajouté.
Remarquez le petit triangle rouge en haut à droite de la cellule, signalant la
présence d'un commentaire.

"Spécifique Excel"

IMG. 246 : ONGLETS DU MENU FORMAT DE CELLULE - SPÉCIFIQUE EXCEL

"Spécifique Excel"

Alignement des données et fusion de cellules dans Excel

♦ Menu Format > Cellule - Alignement.

♦ Alignement du texte - Horizontal : Centré.

L'option « Retrait » permet de laisser un espace entre la bordure et le contenu
dans le cas d'un alignement Gauche ou Droite.

♦ Contrôle du texte : cocher la case « Fusionner les cellules ».

L'icône « Fusionner et centrer » de la barre d'outils « Format » réalise
directement cette opération.

IMG. 247

"Spécifique Excel"

Ajuster le contenu à la cellule dans Excel
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Format > Cellule - Alignement - Contrôle du texte - cocher la case « Ajuster ».

"Spécifique Excel"

Renvoi àla ligne automatique dans Excel

Format > Cellule - Alignement - Contrôle du texte - cocher la case « Renvoyer à la
ligne automatiquement ».

Vous devez ajuster la hauteur de ligne pour afficher la totalité du titre.

"Spécifique Excel"

Onglet "Police" dans Excel

Avec l'onglet « Police », vous pouvez changer la fonte de caractère, le style (normal,
italique, gras, etc.), la taille, la couleur et différents effets comme le soulignement et
les attributs (barré, exposant, indice).

Un aperçu vous permet de vérifier les options que vous définissez.

"Spécifique Excel"

Un petit message vous indique comment procéder :

« Le style de bordure sélectionné peut être appliqué en cliquant sur l'une des
présélections, sur l'aperçu, ou sur l'un des boutons entourant l'aperçu ».

IMG. 248 : DÉFINIR UNE BORDURE DANS EXCEL - SPÉCIFIQUE EXCEL
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"Spécifique Excel"

Par l'onglet « Motifs », vous pouvez définir une couleur et un motif (ou trame) pour
l'intérieur d'une plage de cellules. Si la couleur des caractères est foncée, choisissez
une couleur claire pour l'intérieur, et inversement. N'abusez pas des couleurs : les
impressions se font en général en noir et blanc !

L'application de couleur et de motif est très simple. Choisissez, pour l'intérieur, la
couleur dans la palette de couleurs, puis le motif et sa couleur.

IMG. 249 : APPLICATION DE MOTIFS - SPÉCIFIQUE EXCEL

Sélectionnez une zone vierge d'une feuille de calcul et expérimentez !

Pour modifier rapidement la couleur de l'intérieur d'une plage de cellules, passez par
la barre d'outils « Format » sur l'icône « Couleur de remplissage ».

IMG. 250 : ICÔNE « COULEUR DE REMPLISSAGE » - SPÉCIFIQUE EXCEL

"Spécifique Excel"
Tableau final dans Excel

Cliquez sur le lien suivant afin de visualiser l'animation : Animation "Tableau final
dans
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap6/animation_tableau_final_MS.htm]
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"Spécifique Excel"

♦ Sélectionnez la cellule B10 affichant le résultat des mensualités.

♦ Menu Format > Mise en forme conditionnelle.

♦ Définissez la condition : « La valeur de la cellule est » - « supérieure ou égale à »
900.

♦ Choisissez le format à utiliser lorsque la condition est vraie.

♦ Validez.

IMG. 251 : MISE EN FORME CONDITIONNELLE - SPÉCIFIQUE EXCEL

♦ Testez, par exemple en diminuant la durée de l'emprunt à 10 ans.

"Spécifique Excel"

IMG. 252 : TRI AVEC EXCEL - SPÉCIFIQUE EXCEL

Si vous choisissez « Non » pour la case « Ma plage de données a une ligne de titres »,
la clé de tri sera remplacée par le numéro de colonnes et le titre sera trié en même
temps que la liste.

Les options vous permettent de changer le type de clé de tri (normal ou jour ou mois),
ainsi que la prise en compte de la casse Majuscule ou minuscule. (majuscule ou
minuscule différents). Pour le tri de lignes, laissez cochée la case « Du haut vers le
bas ».
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"Spécifique Excel"

Pour trier rapidement une liste :
♦ Sélectionnez n'importe quelle cellule dans la colonne servant de clé de tri.

♦ Cliquez sur l'une des icônes de tri (croissant ou décroissant) dans la barre d'outils «
Standard » :

IMG. 253

"Spécifique Excel"

Données > Filtrer > Filtre automatique.

"Spécifique Excel"

Tri direct des données filtrées dans Excel

Il est également possible de trier directement les données filtrées.

IMG. 254 : FILTRE « BADMINTON » - SPÉCIFIQUE EXCEL

"Spécifique Excel"

Données > Filtrer > Filtre automatique.

"Spécifique Excel"

Le fichier est à télécharger ici :
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"Spécifique Excel"

♦ Appeler l'assistant graphique par le menu Insertion > Graphique ou directement par
l'icône « Assistant Graphique » de la barre d'outils Standard.

IMG. 255

Les quatre étapes de l'élaboration d'un graphique avec Excel sont :
♦ Le choix du type de graphique,

♦ La définition des données sources du graphique (abscisse, ordonnées, en ligne, en
colonne),

♦ Les options du graphique : titres, légendes, quadrillage, etc.,

♦ Le choix de l'emplacement du graphique sur la feuille de calcul ou sur une feuille
graphique séparée.

IMG. 256

"Spécifique Excel"
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♦ Sélectionnez A5:H8 en utilisant les touches MAJ+CTRL + → et ↓ .

Vous sélectionnez 4 séries de données (une par secteur d'activité) ainsi que le nom des
séries (Agriculture, Industrie, ...).

♦ Appelez l'assistant graphique, puis suivez-en les 4 étapes :

♦ Etape 1 :

IMG. 257 : ASSISTANT GRAPHIQUE, ÉTAPE 1 - SPÉCIFIQUE EXCEL

L'étape 1 vous permet de choisir le type de graphique, ainsi que le sous-type (ou
variante). Nous reviendrons plus tard sur ces sous-types.

Choisissez l'histogramme groupé.

Le choix du type de graphique est l'étape la plus importante : choisissez bien !

Vous pourrez changer ultérieurement ce type si vous vous apercevez qu'il ne
correspond pas à vos attentes.

Passez à l'étape 2.

♦ Etape 2 :

L'étape 2 vous donne déjà un aperçu du résultat. La plage de cellules sélectionnées
apparaît dans la zone « Plage de données » et chacune des 4 séries se trouve sur une
ligne de la sélection.
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IMG. 258 : ASSISTANT GRAPHIQUE, ÉTAPE 2, « PLAGE DE DONNÉES - SPÉCIFIQUE EXCEL

Choisissez l'onglet « Série ». Vous pouvez vérifier le nom de chacune des 4 séries
sélectionnées et la plage où se trouvent les valeurs correspondantes.

Sélectionnez la plage de cellules B4:H4 contenant les étiquettes de l'axe des abscisses.
Les années figurent maintenant sur le graphique.

IMG. 259 : ASSISTANT GRAPHIQUE, ÉTAPE 2, « SÉRIE » - SPÉCIFIQUE EXCEL

Utilisez l'icône pour opérer la sélection directement dans la feuille de calcul.

IMG. 260

Passez à l'étape 3.

♦ Etape 3 :

Elle consiste à définir les options du graphique.

N'hésitez pas à cocher ou décocher les cases pour voir la signification de ces
options !

♦ Titres
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Le titre du graphique et les titres des 2 axes sont indispensables à la bonne
compréhension du graphe. Sans eux, le graphe serait inutile.

IMG. 261 : ASSISTANT GRAPHIQUE, ÉTAPE 3, « TITRES » - SPÉCIFIQUE EXCEL

♦ Axes : laissez les options par défaut.

♦ Quadrillage : gardez les options par défaut.

♦ Légende : affichez la légende.

Vous devez afficher une légende dès que votre graphe présente plusieurs séries de
données, de façon à les identifier.

♦ Etiquette de données : aucune, pour ne pas surcharger le graphique.

♦ Table de données : aucune, pour ne pas surcharger le graphique.

Passez à l'étape suivante.

♦ Etape 4 :

Vous pouvez choisir l'emplacement du graphique :

- soit sur une nouvelle feuille graphique appelée « Graph1 » par défaut,
- soit « en tant qu'objet » dans la feuille sélectionnée.

Choisissez cette deuxième option puis cliquez sur Terminer.

Voilà ! Vous avez un graphique flottant, c'est-à-dire dont la position peut changer,
tout comme la palette flottante intitulée « Graphique » qui permet de revenir sur les
paramètres du graphe.

Note : le graphique étant lié au tableau, toute modification apportée aux chiffres de
ce tableau sera automatiquement répercutée dans le graphique.
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IMG. 262 : GRAPHIQUE FLOTTANT - SPÉCIFIQUE EXCEL

Cliquez sur le lien suivant afin de découvrir l'animation qui vous résume la démarche
: Animation "Création d'histogrammes dans
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap8/animation_creation_histogramme_MS.htm]

La présentation reste à améliorer : la zone de traçage grisée est illisible et les titres et
légendes ont une police de taille disproportionnée. Arrangeons cela.

"Spécifique Excel"

Le graphique a été incorporé comme graphique flottant dans la feuille. Vous pouvez
le redimensionner et le repositionner par rapport à la feuille de calcul.

Utilisez les poignées de redimensionnement de la zone graphique pour en augmenter
la taille jusqu'à masquer la zone de la feuille de calcul s'étendant de A1 à H18.
Eventuellement, repositionnez-la en glissant la souris sur le graphique. Vous devriez
arriver à ce résultat :

IMG. 263 : RÉSULTAT DU REPOSITIONNEMENT DE LA ZONE GRAPHIQUE - SPÉCIFIQUE EXCEL

"Spécifique Excel"

Le graphe doit être sélectionné en cliquant simplement dessus.

En cliquant sur l'objet, il sera sélectionné et son nom apparaîtra dans la zone de nom
de la feuille et de la palette graphique.
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"Spécifique Excel"

Vous devez sélectionner l'objet sur lequel portera la modification.

Vous pouvez sélectionner les objets successivement en appuyant sur les touches
fléchées.

Après sélection, l'objet est encadré, pourvu de poignées de redimensionnement, et son
nom apparaît dans la zone de nom. A ce stade, vous pouvez :
♦ le supprimer, le copier, le déplacer, l'agrandir, etc.

♦ modifier ses propriétés (formats) :

- en cliquant-droit par l'intermédiaire du menu contextuel,
- ou en double-cliquant sur l'objet,
- ou en cliquant sur l'icône « Propriétés » de la palette graphique,
- ou en utilisant le menu Format de la barre de menus.

"Spécifique Excel"

IMG. 264 : HISTOGRAMME 3D - SPÉCIFIQUE EXCEL

"Spécifique Excel"

L'aperçu d'impression dans Excel

♦ Menu Fichier > Aperçu avant impression,

♦ ou l'icône correspondante de la barre d'outils standard :

IMG. 265

♦ Par défaut, si aucune zone d'impression n'a été définie, l'impression porte sur tous
les objets de la feuille sélectionnée : plages de cellules et graphiques.

♦ Vous pouvez définir/annuler une zone d'impression en sélectionnant une ou
plusieurs plages de cellules puis le menu Fichier > Zone d'impression > Définir /
Annuler.
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♦ Si plusieurs pages sont nécessaires pour les afficher, leur nombre et la page courante
sont indiqués dans la barre d'état (figure ci-dessous).

IMG. 266 : APERÇU AVANT IMPRESSION - SPÉCIFIQUE EXCEL

Cliquez sur le lien suivant afin de découvrir l'animation : Animation "Aperçu
dans
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap9/animation_apercu_MS.htm]

"Spécifique Excel"

IMG. 267 : MODIFICATION DE LA FEUILLE DE CALCUL INCORPORÉE - SPÉCIFIQUE EXCEL

L'objet est entouré de lignes hachurées et apparaît comme une feuille de calcul Excel.

Les menus et barres d'outils d'Excel ont remplacé ceux de Word. Et pourtant, vous
êtes toujours dans la fenêtre de Word (barre de titre de l'application) !

IMG. 268 : OPTIONS DE COLLAGE D’UNE FEUILLE DE CALCUL COMME OBJET OLE - SPÉCIFIQUE EXCEL
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IMG. 269 : DOCUMENT TEXTE APRÈS INCORPORATION DU TABLEAU EN TANT QU’OBJET OLE - SPÉCIFIQUE EXCEL

"Spécifique Excel"

Sélectionnez maintenant le graphique en bâtons dans la feuille de calcul, et copiez-le
dans le traitement de texte en tant que Graphique MS Excel Objet.

IMG. 270 : OPTIONS DE COLLAGE D’UN GRAPHIQUE COMME OBJET OLE - SPÉCIFIQUE EXCEL

Double-cliquez sur l'objet incorporé, vérifiez la présence des menus graphiques
d'Excel : vous pouvez modifier le graphique comme vous le feriez dans Excel.

IMG. 271 : MODIFICATION DU GRAPHIQUE INCORPORÉ - SPÉCIFIQUE EXCEL

L'objet est entouré d'une ligne grisée et apparaît comme une feuille graphique Excel.
Comme pour l'incorporation d'une feuille de calcul, les menus et barres d'outils
d'Excel ont remplacé ceux de Word. Et pourtant, vous êtes toujours dans la fenêtre de
Word (barre de titre de l'application) !

Le collage étant sans liaison, la modification du graphique n'affectera pas le
graphique d'origine.
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"Spécifique Excel"

IMG. 272 : DOCUMENT TEXTE APRÈS COLLAGE DU TABLEAU EN TANT QU’IMAGES - SPÉCIFIQUE EXCEL

La sélection de l'objet fait apparaître la palette « Image » permettant sa modification.

Le menu contextuel est associé au type « Image ».

"Spécifique Excel"

IMG. 273 : DOCUMENT TEXTE APRÈS COLLAGE DU TABLEAU AU FORMAT HTML - SPÉCIFIQUE EXCEL

"Spécifique Excel"

Cliquez sur le lien suivant afin de découvrir l'animation : Animation "Réalisation de
tableau dans
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap11/actionsociale_tableaux_MS.htm]

"Spécifique Excel"

Cliquez sur le lien suivant afin de découvrir l'animation : Animation "Mettre en forme
un tableau dans
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap11/actionsociale_presentation_MS.htm]

"Spécifique Excel"

Cliquez sur le lien suivant afin de découvrir l'animation : Animation "Mettre en page
et imprimer la feuille de calcul dans
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap11/actionsociale_impression_MS.htm]

"Spécifique Excel"
Voir annexe F en fin de fascicule - Spécifique Excel

Cliquez sur le lien suivant afin de découvrir l'animation : Animation "Solution à
l'exercice numéro 1 dans
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap11/actionsociale_graphique_aires_MS.htm]
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"Spécifique Excel"
Voir annexe H en fin de fascicule - Spécifique Excel

Cliquez sur le lien suivant afin de découvrir l'animation : Animation "Solution à
l'exercice numéro 2 dans
Excel" [http://projet.c2imes.org/V2/tutorielsB5/Chap11/actionsociale_graphique_secteurs_MS.htm]

"Spécifique Excel"

"Spécifique Excel"

Cliquez sur le lien suivant afin de découvrir l'animation : Animation "Solution à
l'exercice dans Microsoft
Office" [http://projet.c2imes.org/V2/tutorielsB5/Chap11/document_composite_MS.htm]
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ANNEXE A

Emploi_corrige.xls



 



emploi_corrige.xls

Source : Insee, estimations d'emploi.

Année 1997 1998 1999 2000 2001 2002 2003
Agriculture 88 102 86 224 85 344 83 128 81 583 79 627 75 372
Industrie 195 753 199 775 202 991 212 323 212 799 208 454 204 734
Construction 69 601 71 545 74 852 77 629 79 337 80 690 82 451
Tertiaire 730 421 752 316 776 821 798 034 812 126 830 615 834 181

Ensemble 1 083 877 1 109 860 1 140 008 1 171 114 1 185 845 1 199 386 1 196 738

Emploi total (salarié et non salarié) : nouvelle série recalée sur le recensement 
de 1999 (au 31 décembre de chaque année)
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ANNEXE B

Recettes_bilan.pdf



 



Recettes

Semaine du: 08/01/2007

au: 13/01/2007

2,70 �                  
4,60 �                  

700
Recette %

Etudiants Employés Invités Total totale occupation
lundi 446 54 12 512 1 452,60 �     73%

mardi 523 45 8 576 1 619,10 �     82%
mercredi 528 22 15 565 1 526,80 �     81%

jeudi 628 48 5 681 1 916,40 �     97%
vendredi 409 45 22 476 1 311,30 �     68%

samedi 84 2 0 86 236,00 �        12%
Total: 2618 216 62 2896 8 062,20 �     

Soit en % 90,4% 7,5% 2,1% 100,0%
Moyenne/jour: 436 36 10 483

Restaurant Universitaire
100, rue Tabaga
12345 CEDEUZY

Récapitulatif des entrées Prix du repas Etudiant:
Prix du repas Employé université:

Capacité d'accueil du restaurant:
Nombre de repas

Exercice_2_corrige.xls Feuil1



 



ANNEXE C

Cliquez ici si vous souhaitez voir
le document au format PDF
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Emploi salarié et non salarié, années 1997-2003 
�

�

�

�
Source : Insee, estimations d'emploi.

Année 1997 1998 1999 2000 2001 2002 2003
Agriculture 88 102 86 224 85 344 83 128 81 583 79 627 75 372
Industrie 195 753 199 775 202 991 212 323 212 799 208 454 300 000
Construction 69 601 71 545 74 852 77 629 79 337 80 690 82 451
Tertiaire 730 421 752 316 776 821 798 034 812 126 830 615 834 181

Ensemble 1 083 877 1 109 860 1 140 008 1 171 114 1 185 845 1 199 386 1 196 738

Emploi total (salarié et non salarié) : nouvelle série recalée sur le recensement 
de 1999 (au 31 décembre de chaque année)

Statistique d'emplois 1997-2003
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ANNEXE D

Pour avoir une idée de
présentation finale, cliquez ici

pour excel



 



Université de Cédeuzy

Budget total des aides financières attribuées par année

Tableau 1
Année 2002 2003 2004 2005 Quadriennal
Stage Arts Plastiques 20 � 80 � 90 � 100 � 290 �
Aides pour séjour d’enfant handicapé 0 � 0 � 150 � 150 � 300 �
Stage Arts du Cirque 0 � 140 � 180 � 200 � 520 �
Aides urgentes 1 450 � 2 250 � 1 800 � 1 600 � 7 100 �
Aides pour séjour d’enfant 1 350 � 1 850 � 2 350 � 2 500 � 8 050 �
Aides à la rentrée 2 700 � 3 250 � 3 500 � 4 000 � 13 450 �
Total 5 520 � 7 570 � 8 070 � 8 550 � 29 710 �

Tableau 2
Année 2002 2003 2004 2005
Stage Arts Plastiques 0,4% 1,1% 1,1% 1,2%
Aides pour séjour d’enfant handicapé 0,0% 0,0% 1,9% 1,8%
Stage Arts du Cirque 0,0% 1,8% 2,2% 2,3%
Aides urgentes 26,3% 29,7% 22,3% 18,7%
Aides pour séjour d’enfant 24,5% 24,4% 29,1% 29,2%
Aides à la rentrée 48,9% 42,9% 43,4% 46,8%
Total 100,0% 100,0% 100,0% 100,0%

Tableau 3
Année 2002 2003 2004 2005
% par rapport à 2005 64,6% 88,5% 94,4% 100,0%

ActionSociale_1.xls Page 1 30/08/2006



 



ANNEXE E

Pour avoir une idée de
présentation finale, cliquez ici

pour Calc



 



Université de Cédeuzy

ActionSociale.ods Page 1 30/08/2006

Budget total des aides financières attribuées par année

Tableau 1
Année 2002 2003 2004 2005 Quadriennal
Aides à la rentrée
Aides pour séjour d’enfant
Aides pour séjour d’enfant handicapé 0 € 0 € 150 € 150 € 300 €
Aides urgentes
Stage Arts du Cirque 0 € 140 € 180 € 200 € 520 €
Stage Arts Plastiques 20 € 80 € 90 € 100 € 290 €
Total

Tableau 2
Année 2002 2003 2004 2005
Aides à la rentrée 48,9% 42,9% 43,4% 46,8%
Aides pour séjour d’enfant 24,5% 24,4% 29,1% 29,2%
Aides pour séjour d’enfant handicapé 0,0% 0,0% 1,9% 1,8%
Aides urgentes 26,3% 29,7% 22,3% 18,7%
Stage Arts du Cirque 0,0% 1,8% 2,2% 2,3%
Stage Arts Plastiques 0,4% 1,1% 1,1% 1,2%
Total 100,0% 100,0% 100,0% 100,0%

Tableau 3
Année 2002 2003 2004 2005
% par rapport à 2005 64,6% 88,5% 94,4% 100,0%

2 700 € 3 250 € 3 500 € 4 000 € 13 450 €
1 350 € 1 850 € 2 350 € 2 500 € 8 050 €

1 450 € 2 250 € 1 800 € 1 600 € 7 100 €

5 520 € 7 570 € 8 070 € 8 550 € 29 710 €



 



ANNEXE F

Pour avoir une idée de
présentation du graphique,

cliquez ici



 



Evolution de l'aide sociale à l'université de Cédeuzy

0 €

1 000 €

2 000 €

3 000 €

4 000 €

5 000 €

6 000 €

7 000 €

8 000 €

9 000 €

2002 2003 2004 2005

Année

M
on

ta
nt

Stage Arts Plastiques
Stage Arts du Cirque
Aides pour séjour d’enfant handicapé
Aides urgentes
Aides pour séjour d’enfant
Aides à la rentrée



 



ANNEXE G

Pour avoir une idée de
présentation du graphique,

cliquez ici
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ANNEXE H

Pour avoir une idée de
présentation du graphique,

cliquez ici



 



Aide sociale en 2005
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ANNEXE I

Pour avoir une idée de
présentation du graphique,

cliquez ici
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ANNEXE J

Pour avoir une idée du document,
cliquez ici



 



Aide sociale de l'Université de Cédeuzy sur le quadriennal 
2002-2005

Les chiffres

Evolution sur le quadriennal

Répartition des aides sur 2005

Année 2002 2003 2004 2005 Quadriennal
Stage Arts Plastiques 20 € 80 € 90 € 100 € 290 €
Aides pour séjour d’enfant handicapé 0 € 0 € 150 € 150 € 300 €
Stage Arts du Cirque 0 € 140 € 180 € 200 € 520 €
Aides urgentes
Aides pour séjour d’enfant
Aides à la rentrée
Total

1 450 € 2 250 € 1 800 € 1 600 € 7 100 €
1 350 € 1 850 € 2 350 € 2 500 € 8 050 €
2 700 € 3 250 € 3 500 € 4 000 € 13 450 €
5 520 € 7 570 € 8 070 € 8 550 € 29 710 €
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